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Basics

Discontinuation of Windows 7 ®
Microsoft will cease the support for Windows by January 2020. Due to compatibility matters HiCAD 2020
SP2 and HELiOS 2020 SP2 will thus be the final versions of our CAD and PDM systems which support
Windows ® 7. The corresponding server operating systems (Windows Server 2008 R2 or older) will then
no longer be supported either.

Discontinuation of “old“ HiCAD itemisation
As of HiCAD 2019 the “old” itemisation, i.e. the itemisation that was used up to HiCAD 2017, will only be
available for model drawings that were already itemized with these functions. From HiCAD 2021
onwards, only the “new” itemization will be supported.

Discontinuation of "old" OpenGL versions
From HiCAD 2021 on, only OpenGL version 4.3 is used in all HiCAD modules. Until now this was only
the case with the module HiCAD Point Cloud. This means that HiCAD 2021 can only be run on com-
puters whose graphics card supports OpenGL Version 4.3 or higher. Please also read the corresponding
notes shown below.

Discontinuation of the old figure format (FIG)
Since HiCAD 2017 we have been supporting FGA as figure format (before FIG). Starting with HiCAD
2021 (Version 2600.0), we assume that the figures stored in HELiOS have been converted to the new
format, or convert the still existing figures automatically as part of the database sub-version update to Ver-
sion 2600.0.

Service Pack 2 2020 (V 2502)

The new Renderer - Update to OpenGL Version 4.3
HiCAD uses OpenGL for graphics output - so far in Version 2.0. As already announced, starting with HiCAD 2021
only OpenGL version 4.3 will be used in all modules. Up to now this was only valid for the HiCAD Point cloud mod-
ule. This means that HiCAD 2021 will only run on computers whose graphics card supports OpenGL Version 4.3 or
higher. The use of onboard cards is also still possible - provided they meet the corresponding requirements.
However, we recommend not to use them from HiCAD 2021 on, since the performance of these chips is insuf-
ficient for large and complex model drawings.

Decisive factors in the development of the new Renderer were the extended range of functions for the graphics out-
put through the use of newer OpenGL functions, and the possibility to realize noticeable performance improve-
ments in the graphics output in the future. With HiCAD 2021, the graphics output will be generally accelerated,
which is reflected in a higher frame rate (frames/second). Viewing functions such as zooming, rotating or panning
are thus significantly faster and appear even more fluid.

In order to give you the opportunity to get to know the new Renderer in advance, it is already delivered with Service
Pack 2 for HiCAD 2020 and can be activated on a computer-related basis if required. It already offers significant
performance optimizations in particular situations.
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Our request:

If you are updating to HiCAD 2020 SP2, you should also - at least on some workstations - activate the new Ren-
derer (if the graphics card supports OpenGL 4.3).

With HiCAD 2020 SP2 you still have the possibility to switch between both Renderers. This way you can help to
detect possible problems with the new Renderer at an early stage. Of course, this renderer has already under-
gone extensive testing as part of our quality assurance process, but its use in daily practice can provide us with
further important information. This will ensure that future updates to HiCAD 2021 or newer versions can be car-
ried out smoothly.

We thank you in advance for your kind support!

Proceed as follows to activate/deactivate the new Renderer:

To switch between the old and new Renderer you first have to adjust the Windows Registry as follows:

In the Registry, switch to Computer\HKEY_CURRENT_USER\SOFTWARE\ISD Software und Systeme\HiCAD
2020.

Right-click on the Feedback entry there and create a new entry of type DWORD value (32Bit) called BetaRen-
dererActivation.

Supported are the following values:

0 The setting from the Configuration Editor will be used - System settings > Graphic > Use OpenGL Beta
Renderer

1 The new Renderer will be activated - regardless of the setting in the Configuration Editor

2 The new Renderer will be activated - regardless of the setting in the Configuration Editor
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GUI and operation

New Autopilot Settings toolbar

The Autopilot Settings toolbar at the bottom of the HiCAD user interface can now be used to control which points
the Autopilot offers as snap points. Switching is possible at any time - even during the execution of a function. In the
toolbar the possible snap points are highlighted in colour.

Using this bar you can control which point options should be visible on the Autopilot by activating / deactivating the

symbols. For example, if you click on , the snapping of isolated points is deactivated.

The currently selected Autopilot settings apply to the active HiCAD session. Which settings should be active when
restarting HiCAD can be defined in Configuration Editor at System settings > Identification with the parameter List
of point snap options.

The ISD default setting is JISMTZFQOS2, i.e. snap points are isolated points, end points, genuine intersection
points, centre points, tangential points, centroids, perpendicular base points, quad points, on-line points and the-
oretical intersection points.

If you click on the symbol in the Autopilot Settings toolbar, the settings from the Configuration Editor are
restored to defaults.

Please note:

n The Autopilot Settings apply to 2-D and 3-D point options.

n Point options that are deactivated from the active function cannot be activated in the Autopilot Settings either.

n The Autopilot Settings toolbar can be activated/deactivated via Settings > Toolbars.
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New Visualisation toolbar

The previous toolbar "CS display" has been extended with additional functions for fast fading in and out of objects
and renamed Visualisation. With the functions of this toolbar you can switch on or off the visibility of coordinate sys-
tems, isolated points, dimensions, HCM constraints etc. with one click. In certain situations - especially with large
model drawings - this can make editing easier. For example, you can hide all dimensions of a model drawing
without having to call a function in the context menu or ribbon first.

The following functions are new here:

Toggle visibility of isolated points (Drawing)

All isolated points of the model drawing can be shown or hidden with one mouse click.

Toggle visibility of dimensions (Drawing)

All 2-D and 3-D dimensions of the model drawing can be shown or hidden with one mouse click.
This applies both to drawing dimensions and parametric dimensions.

Toggle visibility of dimensions (3-D Part HCM)

Toggle visibility of constraints (3-D Part HCM)

Toggle visibility of degrees of freedom (3-D C-Edge HCM)

Toggle visibility of dimensions (3-D C-Edge HCM)

Toggle visibility of constraints (3-D C-Edge HCM)
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CS display - Fitting CS

The spatial representation of the Fitting CS (2) has been revised to make it easier to distinguish it from the Part CS
(1).

New symbol for part with free edges

In the part structure display of the ICN the symbol for Part with free edges has been changed. The new symbol

looks like this:
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New pocket calculator

The HiCAD Pocket calculator has had a redesign.

In many cases, HiCAD suggests a default value, which you can apply directly or correct.

You complete your input by

n pressing the left mouse button or

n pressing the ENTER key of the keyboard or

n clicking on the OK button.

Special keys:

Is used to take distances and angles from existing construction objects. Alternatively, you can also
call these functions in the context menu, which you activate by pressing the right mouse button in
the input field of the calculator. The functions of the distance and angle menu displayed here are the
same as the identically named functions in the Information menu. The 3-D Distances menu also
provides the Tracing lines function, which enables you to transfer the spacing of the tracing lines of
a steel engineering beam.

Hides the keyboard area of the pocket calculator.
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Docking windows - Zooming of contents

The contents of various docking windows can be enlarged or downsized dynamically by zooming. This is possible
for the following docking windows:

n Views,

n 2-D/3-D Part structure,

n Feature,

n HCM (2-D) und HCM (3-D),

n Part variables,

n Exploded view.

Zoom contents of one docking window

To enlarge or downsize the contents of a single docking window, point the
mouse cursor inside the window and turn the mouse wheel while holding down
the CTRL key.

Zoom contents of all docking windows

To enlarge or downsize the contents of all docking windows, turn the mouse
wheel while holding down the CTRL and the SHIFT key.

Reset zoom

The zoom of the active window can be reset by pressing the CTRL and middle
mouse button simultaneously. To reset the zoom of all windows, press CTRL,
SHIFT and the middle mouse button accordingly.

Easier element snap

As long as no function is active, pressing and holding the SHIFT key from SP2 on automatically activates the ele-
ment snap function - independent of the selected identification mode. This provides faster access to the context
menus of individual geometry elements and is also a practical way to find a Feature in the ICN from within the geo-
metry - especially in large and complex model drawings.
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North American scale
Scales are used in HiCAD as

n Main scale of a model drawing,

n Scale of a view,

n Scale of a 2-D part and

n Scale of steel construction part drawings.

The scale can be selected from a selection box in the corresponding HiCAD function dialogues. In addition, in
many cases it is also possible to enter a scale directly. The scales available in the selection boxes of the HiCAD
functions are defined in the file SZENE-MASSSTAB.TXT in the HiCAD subdirectory MAKRO2D or for steel con-
struction component drawings in the file StbEtZng_MASSSTAB.DAT in the HiCAD subdirectory sys. Please note
that HiCAD supports the European scale logic by default, i.e. scale specifications in the form n:m, e.g. 1:1, 1:10,
5:1 etc.

Default scales
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However, the US scale logic differs from that in Europe. Therefore HiCAD offers the possibility to extend the above
mentioned files by defining additional scale specifications. For examples of typical scale specifications in North
America, refer to the following table:

1/128"=1'-0"

1/64"=1'-0"

1/32"=1'-0"

1/16"=1'-0"

3/32"=1'-0"

1/8"=1'-0"

1/4"=1'-0"

3/8"=1'-0"

1/2"=1'-0"

3/4"=1'-0"

1"=1'-0"

-1/2"=1'-0"

3"=1'-0"

6"=1'-0"

1'-0"=1'-0"

' foot, " Inch, 1 foot = 12 inches, 1 inch = 2,54 cm

Conversion table

Scale Factor Decimal

1'=1'-0" 1:1 1.0

6"=1'-0" 1:6 0.5

1-1/2"=1'-0" 1:8 0.125

1"=1'-0" 1:12 0.08333

3/4"=1'-0" 1:16 0.06250

1/2"=1'-0" 1:24 0.41667

3/8"=1'-0" 1:32 0.031250

1/4"=1'-0" 1:48 0.020833

3/16"=1'-0" 1:64 0.015625

1/8"=1'-0" 1:96 0.010417

3/32"=1'-0" 1:128 0.007813

1/16"=1'-0" 1:192 0.005208

1/32"=1'-0" 1:384 0.002604

1/64"=1'-0" 1:768 0.001302

1/128"=1'-0" 1:1536 0.000651
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Changing the file SZENE-MASSSTAB.TXT

To structure the file, any number of empty lines and comments can be inserted, whereby comment lines must
begin with the character #. Each scale specification must be in a separate line. The following notations are sup-
ported for the scale specification:

Notations Examples

1. Specification in scale format n:m 1:10

1:1

2:1

5:1

2. Specification as factor 0.1

1

2

5

3. As factor with display text

The factor is at the beginning of the line, the display text in brackets behind it.

The display text is used by HiCAD in dialogues and information outputs.

2.5 (2‘-6“ = 1‘-0“)

1 (1`-0“ = 1‘-0“)

4. In scale format with display text

The scale is at the beginning of the line, the display text in brackets behind it.

The display text is used by HiCAD in dialogues and information outputs.

1:12 (1“=1‘-0“)

1:48 (1/4“ = 1‘-0“)

The notations 3 and 4 can be used to define US scale specifications, for example.
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Example of an expanded SZENE-MASSSTAB.TXT file

Further information can be found in the Definition of Scales topic.
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Enhanced HiCAD VI / AV module
With the HiCAD VI / AV Viewer solution, HiCAD drawings and also and drawings imported via interfaces can be visu-
alised. Furthermore, the module supports the plot generation/output and data export. In order to support the cre-
ation and editing of sketches for sectional and detailed views, the corresponding functions are now available on the
Sketch Ribbon tab.

Functions Effect

Create new sketch

and sub-menu functions

Allows you to draw a new sketch

Sketch polyline

and sub-menu functions

Inserts polylines, tangents and straight lines

Sketch rectangle

and sub-menu functions

Inserts rectangles and polygons

Sketch circle

and sub-menu functions

Inserts full circles

Trim to point

and sub-menu functions

Trims/edits sketch elements

Delete lines and isolated
points

and sub-menu functions

Deletes line elements and points

Sort GE

and sub-menu functions

Sorts graphical elements of the active sketch and provides further
tools
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Novice configuration - - Settings for sketches
The settings for sketches in the Novice configuration previously only affected the creation of new sketches with
the New sketch in plane and New 3-D sketch functions, and the functions at 3-D Standard > Process with sketch.
However, they did not apply to other functions that use sketches to create or process parts, and also allow you to
create new sketches. Here, the sketch plane was always the XY-plane of the world coordinate system.

As of SP2, the behavior when creating a new sketch has been standardized, that is, the settings of the Novice con-
figuration dialogue window affect not only the creation of new sketches with the New sketch in plane and New 3-D
sketch functions, but also all functions that use sketches to create or process parts, as well as all functions that
allow you to create new sketches. This applies to such functions as Add and Subtract, deriving sheet metal parts
from sketches, element installation, and much more. This also allows these functions to query the determination of
the sketch plane before creating a new sketch
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Track catalogue changes
Up to now, the Configuration Editor at System settings > Catalogues could be used to define how catalogue
changes should be handled in HiCAD. From HiCAD 2020 SP2 onwards these settings are no longer available in the
Configuration Editor . Instead, the switch Track catalogue changes is now available at Settings in the Cata-
logue menu.

If the switch is active, the catalogues are regularly checked during a HiCAD session to ensure that they are up-to-
date. This actuality check can, however, significantly impair performance in some situations. If the switch is active,
then this is indicated when HiCAD is started. By default, the switch is inactive by default, that is, the catalogues are
loaded in HiCAD only once, when starting HiCAD. After that, the system does not check whether more recent data
is available. To update the catalogues after changes, the function Reload is available. This offers the possibility to
update catalogues after changes without having to leave HiCAD and without having to accept performance losses
due to the constant check for up-to-dateness.

The current status of the switch (active/inactive) is entered into the Windows Registry. If the switch is active, the fol-
lowing message is displayed when starting HiCAD.
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Drawing derivation

Update derived drawings - active sheet

When updating derived drawings, it is now easier to update the active sheet. The selection box has been extended
accordingly.
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Change settings - Rearrange views

If the settings were changed in an existing workshop drawing and then the drawing was updated, HiCAD always
rearranged all views. From HiCAD 2020 SP2 onwards this can be set individually. For this purpose the Rearrange
views checkbox has been added to the dialogue windows of the following functions:

Change settings, Active drawing sheet

Change settings, active view group

Change settings, active view

Please note:

If the changed settings add further views, these may have to be arranged manually.
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Sectional views of sheet metal parts

From HiCAD 2020 SP2 onwards, the viewing direction of the sectional views of sheet metal parts in the workshop
drawing is to the right or downwards. Aligned cuts are accordingly to the right or below.

(1) 3-D model in axonometry, (2) sectional view in workshop drawing before HiCAD 2020 SP1, (3) sectional view in
workshop drawing from HiCAD 2020 SP1 onwards

Please note that updating your existing drawings can change the position of the sections.
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Dimensioning of sheet metal parts

In the configuration for the usage "Sheets" DEFAULT(KANTBLECHE) , Dimensioning rule 157: Processings in
sheets is now additionally preset for the front view and the top view as follows:

(1) 3-D model, (2) front view and (3) top view in workshop drawing
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Optimisation of base points

Since SP1, for automatically dimensioned developments of sheet metal parts, the (unshortened) projection lines
are only drawn to the nearest point on the object to be dimensioned, i.e. to the next point on the contour. As of SP2
this also applies to sheet metal parts, steel engineering plates and glass panes.

Tangential transitions when dimensioning contours

The selection of base points has changed for the automatic dimensioning of contours. This change applies to
applies to sheet metal parts, steel engineering plates and glass panes.

Until now, when dimensioning contours, the end points of the individual edges were dimensioned. However, this is
usually not desired in practice. From SP2 onwards, the following base points are therefore taken into account when
dimensioning contours:

Outer contours

n Lines running perpendicular to the dimension line

n Extreme points of outer contours that lie in the dimensional direction (also points lying on an arc or freeform
line)

n All points with a bend

Except for inverse curves, where the centre lies on both adjacent lines.

n Theoretical intersection points of curves in the outer contour

For each arc that is tangentially adjacent to a straight line on both sides, the theoretical intersection point of the
two lines is dimensioned if the angle of the two lines is greater than 50 degrees (i.e. not for very acute angles
only). When merging with other dimensions, theoretical intersections are removed first, which affects the length
of the projection lines.

Bores/Subtractions

n Centres of circles, bores and slots

Depending on the setting specified at Drawing > Itemisation/Detailing > Dim... > Dimensioning Settings

n Lines, points and theoretical intersection points as for outer contours
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This change concerns the dimensioning rules for outer contours and bores/subtractions of sheet metal parts (and
their developments), steel engineering plates and glass panes.

Dimensioning of outer contour, before HiCAD 2020 SP2

Dimensioning of outer contour with HiCAD 2020 SP2
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Bills of materials - All visible parts on active sheet
When creating BOMs, it is now possible to consider only the visible parts of the active sheet area. Therefore the set-
tings for BOMs have been extended accordingly.

Insert part, via standard part catalogue

The function Drawing > Insert Part > Cat has been enhanced. When HiCAD asks yout to determine tfitting
poiint in the drawing, you can right-click to activate the displayed context menu:

Here you have the possibility to select another catalogue part, to take over the origin of the coordinate system as
target point or to cancel the function.

The function remains active after the insertion of a catalogue part. You can install the selected catalogue part sev-
eral times or reactivate the context menu shown above by pressing the right mouse button.

You end the function with the middle mouse button or with the Cancel function in the context menu.
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Design Checker - New check for sheet metal parts
The Design Checker offers a new check for sheet metal parts called Sheet must contain exactly 1 direction sym-
bol. This check finds all sheet metal parts with no or more than one direction symbol.

Nested variables and formulas
It is now possible to specify a formula that contains additional variables when defining the value of a variable. Espe-
cially with complex parts, the variable structure can become much clearer.

Thereby variables may be nested arbitrarily deeply into each other:
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However no cyclic structures may occur (variable a refers to variable b, which refers to variable a), since these can-
not be computed. In this case the automatic calculation of the formula values is no longer possible. The last values
are retained and an error mark is displayed at the affected variables, which shows an explanatory tooltip when the
cursor is moved over them:

In this case, remove the cyclic dependency by editing the formulas to remove the error markings and reactivate the
automatic calculation of the formula values.
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Service Pack 1 2020 (V 2501)

Restore HiCAD GUI to default
If you want to reset the HiCAD user interface, for example because ICN windows are no longer displayed although
they have been activated with Settings > Docking windows or because incorrect icons or texts are displayed in
the HiCAD toolbars or ribbons, use the contains the tool

HiCADGUIReset.exe

tool in the HiCAD EXE directory. This tool resets the entire HiCAD user interface, i.e. all corresponding settings in
the Windows Registry and in the %APPDATA% directory, to the state after a new HiCAD installation.

After starting the tool, the following dialogue window is displayed.

38 / 362 What's new?

Basics



HiCAD should be closed before calling the tool. If this is not the case, a corresponding message is displayed:

Then close HiCAD. HiCADGUIReset does not have to be closed before!

You start the reset by clicking the Restore GUI delivery state button. With the functions Save GUI settings

and Load GUI settings the current settings can be saved and reloaded at any time. The file format is
hicadgui. This is also useful if you use HiCAD at different workstations, e.g. on a laptop and on a computer with two
monitors. You can simply save the settings of both workstations and then load the respective settings file you need.

Before you start the reset you should always create a backup of your current settings.

Please remember that after a restoring of the GUI to default, user-defined toolbars will be no longer avail-
able!

Itemisation

Switch to new standard itemisation

As of HiCAD 2020 SP1, you can use the Configuration Editor to define the procedure for starting the itemization in a
model drawing that still uses the itemization up to HiCAD 2017. To do this, open the Configuration Editor and
choose System settings > Itemisation > Switch to 'Standard itemisation used since HiCAD 2018'.
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The following options are available here:

n Never
No message or query will be displayed. This means that the itemisation up to HiCAD 2017 will still be used.

n Optional
A message will be displayed, informing you that the itemisation up to HiCAD 2017 will still be used.

You then have the option of determining whether or not the itemization should be converted to the standard
itemization. To Cancel the itemization function, use the same named option.

n Mandatory
Here, too, the message will be displayed, informing you that the itemisation up to HiCAD 2017 will still be used.

Here, however, you only have the possibility to switch to the standard itemisation with OK or to Cancel the item-
ization function.

The default setting is Optional.

Sheet Metal parts with visible side
Sheet Metal parts that have an visible side identifier assigned to them are included in the identical part search. For
example, if the model drawing contains two Sheet Metal parts of the same size, one of which has an ID for the vis-
ible side identifier, then the sheets are not considered identical and will receive different item numbers.
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Enhanced ICN

New ICN window for views

The ICN window for views has been completely revised and makes working with many views much easier. Model
and sheet areas are now marked by new symbols. Like the parts structure, the view structure is now also displayed -
optionally - in multiple columns. For each view an icon for the respective view type, the view name, an icon for the
view mode and the scale of the view are displayed. Also new is the extended toolbar, which allows you to create
and update sheet areas without having to activate a context menu first. The automatic sorting mode is also worth
mentioning, which ensures that sheet views are sorted correctly according to their name. This mode can be
switched on and off.

Also new is that certain views are marked with appropriate symbols. This applies to views that are hidden in the
model drawing, views that have been "frozen", so-called "QuickViews", and sheet developments for which the syn-
chronization was locked with the function Suppress sheet update in the context menu of sheet development.

The view is hidden in the model drawing.

The view is "frozen", i.e. it is visible but cannot be edited.

This symbol indicates sheet metal developments for which the adjustment was locked with the Sup-
press sheet update function in the context menu of the sheet metal development.

This symbol indicates that the view is a QuickView .

If, for example, a view is a list view, a sectional view and also an exploded view at the same time, then sev-
eral symbols will be displayed
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Marking of sheet developments

Sheet developments for which updates were prevented with the Suppress update function in the context

menu of sheet development are now indicated in the ICN by the symbol.
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Marking of imported parts in the ICN

All parts that you insert into the model drawing using the 3-D Import function are marked with the symbol in the
ICN. If you place the cursor over the symbol, you will obtain further information on the relevant part, such as the
imported file format and the HiCAD version with which the part was imported.
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Part filters - Imported parts

With the 3-D Import function, parts inserted into the model drawing can also be searched with the Find func-
tion in the transparent toolbar. The part filter dialogue has been extended accordingly.
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Repeated paste from clipboard
Previously, pasting from the HiCAD clipboard was performed "in a loop", i.e. after pasting from the clipboard, the
function remained active, so that you could paste the clipboard contents several times at different positions in the
construction.

From HiCAD 2020 SP1 onwards, this behaviour can be defined in the Configuration Editor at System settings > Mis-
cellaneous by activating / deactivating the Repeated paste from clipboard checkbox .

n If the checkbox is active, the Paste from HiCAD Clipboard function remains active after the first paste, so that
you can insert the clipboard content several times at different positions in the model drawing. You end the func-
tion with the middle mouse button.

n If the checkbox is inactive, the Paste from HiCAD Clipboard function will be automatically ended after the first
paste. This is the default setting for new installations as of SP1.

During an update installation, the previous behaviour remains unchanged, i.e. repeated pasting remains the default
setting.

Derived drawings

Readability of running dimension chains

The creation of running chain dimensions has been improved by preventing dimension figure collisions.
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AutoSave - Time interval per model drawing
As of HiCAD 2020 SP1, the time interval of the AutoSave mechanismper opened model drawing applies, i.e.
HiCAD remembers the elapsed time of the current model drawing in the case of a drawing switch. For the model
drawing that you switch to, the time interval runs from the first change to the model drawing or from a remaining
time previously noted for this model drawing.

An example:

The time interval is set to 10 minutes and you are working with three model drawing times K1, K2 and K3.

Timer Time remain-
ing

[00:00] You have loaded K1 and for for 9 minutes in K1. K1 = 1 min.

[09:00] You switch to an empty drawing thumbnail, load K2 and work on K2 for 11
minutes.

[19:00] After 10 minutes the time interval for K2 has expired and an interim backup of
K2 is created.

K2 = 9 min.

[20:00] You switch back to K1 and work on K1 for 4 minutes.

[21:00] After 1 minute, an interim backup of K1 is created.

[24:00] You switch to an empty drawing thumbnail, load K3 and work on K3 for 12
minutes.

K1 = 7 min.

[34:00] After 10 min. the interim backup of K3 takes place.

[36:00] You switch to K2 and work on K2 for 13 minutes. K3 = 8 min.

[45:00] After 9 min. K2 is backed up.

[49:00] You switch to K1. K2 = 6 min.

etc.

Others

Delete parts

If parts of the model drawing are deleted via the context menu in the ICN or in the model drawing, the part that was
active before the part was deleted is then active. If you delete the active part, the first part of the part structure is
active.

The same applies to multiple selection. This means that when you delete a multiple selection, the part that was act-
ive before the multiple selection was deleted is then active. If the active part belongs to the deleted parts list, the
first part of the parts structure is then active.

Coordinate System display

In the CS display toolbar, the symbol for part orientation has been changed:
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Major Release 2020 (V 2500)

New Mask Editor in HELiOS 2020

Due to a complete revision of the Mask Editor for HELiOS 2020 the previous mask format has been changed
from .MSK to .XML. In addition, mask files are now managed outside the installation directory, resulting in
some changes in the system architecture that administrators should urgently consider:

n The masks of older versions that were previously stored in the \sys\ directory of the installation are auto-
matically converted to the new XML format by an update installation of an older HELiOS version to HELiOS
2020 (V 2500.0) or higher and stored at%Programdata%.

n At %Programdata%, the masks are stored in a version-specific path, i.e. for HELiOS 2020 this path could
look like this: "C:\ProgramData\ISD Software und Systeme\HELiOS 2020\GUI\Masks". In a later version,
the version identifier in the path will be correspondingly higher.

Please read the installation instructions before updating to HiCAD / HELiOS 2020.
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Licensing
n The new Extension Module HiCAD Point Cloud provides an associative solution for the integrated rep-

resentation of point clouds in HiCAD. Besides the import of common point cloud formats, the imported point
cloud can be placed and clipped in HiCAD. When drawing CAD geometries, you can also refer specifically to
point information from the point cloud. A prerequisite for using the new module is either one of the Basic Mod-
ules HiCAD Creator or HiCAD Solution.

Example of a Point Cloud imported in HiCAD (Image: VHV Anlagenbau GmbH, Hörstel)

Highly enlarged section of the point cloud shown above

An example of a point cloud can be found here.
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n The civil engineering functions (in the docking window under Civil Engineering General ) are now also available
in the following extension modules:

l Sheet Metal Professional

l Beams

l Metal Engineering

l Steel Engineering

l Steel Engineering, Stairs + Railings

l Profile Installation

l Element Installation

n The basic module HiCAD Spooler now contains the same range of functions as HiCAD Solution, e.g. the func-
tions for itemisation and drawing derivation. Furthermore, the module can be linked with the same extension
modules as HiCAD Solution, for instance with the HiCAD Beams module.

Performance
n The HiCAD dimensioning functions are now much faster thanks to an internal change to saving by bodies.

n In large model drawings and assemblies, UNDO actions after cloning of assemblies can now be carried out
much faster.

n With the release of HiCAD 2020, both the changing of item numbers and the updating of item number tags have
been speeded up significantly.

AutoSave
The AutoSave function has been upgraded particularly in regard to the backup time:

n The automatic backup timer is enabled only after a drawing has been fully loaded and all updates have been
completed.

n When saving a drawing, the timer will be reset.

n The symbols are enlarged.
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ISOCPEUR font
HiCAD 2020 supports the ISOCPEUR font, which is, for example, recommended by the Austrian Steel Engineering
Association. If this font has been installed on your computer or network, it can be (like the Arial font) selected in the
Parameter configuration dialogue window (ParKonfigComp.exe / ParKonfigUser.exe) as the default font. Otherwise,
this font is greyed out in the dialogue window.

Please note:
The ISOCPEUR font is not part of HiCAD's scope of delivery and will therefore not be installed together
with HiCAD.

Important:

By running the parameter configuration, customer-specific settings, flags, drawing frames etc. are changed to set-
tings predefined by ISD.
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Enhanced ICN features
The Settings for the 3-D part structure allow to indicate parts with feature error or HCM constraints with error in the
part structure.
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Switch on/off representation of Coordinate Systems
For a better use of coordinate systems, HiCAD 2020 and higher allows you to switch on and off the part and fitting
coordinate system of the currently active part directly via the corresponding symbols at the bottom of the user inter-
face. As an alternative, you can either use the F8 key for the part coordinate system or SHIFT + F8 for the fitting
coordinate system.

When switched on, a plastic representation of the respective coordinate system is displayed.

The following graphic shows an example with the part and installation coordinate system switched on.

Furthermore, the orientation of a part, which you have defined with the Part orientation function in the context
menu for parts or the profile orientation can be shown/hidden. To do so, click on the symbol

Profile orientation or Alignment of active 3-D part, alternatively use the F6 key. This is only possible if the
setting Switch on/off with F6 keyunder System settings > Visualisation > Show alignment of active 3-D part in
drawing or System settings > Visualisation > Indicate orientation of active Steel Engineering beam in the Con-
figuration Management has been activated.
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Point options

Absolute Z-position (AZ)

Analogous to the point options AX und AY the point option (AZ) Absolute Z-position is now available. This
option determines a point by specifying its Z-coordinate and accepting the X- and Y-coordinates of the last point.

Point from Point Cloud (PW)

The option (PW) Point from Point Cloud is required for working with HiCAD Point Cloud module.
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Directories

Quick Access for directory selection

As with the dialogue window for loading and saving of files, selected directories can now also be added to the Quick
Access folder, e.g., for DXF export of Sheet Metal parts.
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Improved designations of directories in HiCAD Settings

The designations of the HiCAD directories in the dialogue window of the function > Settings > Directories have
been improved.
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Update catalogues
In the Configuration Editor at System settings > Catalogue > Track catalogue changes you can now determine
how to proceed in case of catalogue changes in HiCAD. The default setting is Do not track, that is, the catalogue
data will be loaded only once when you start HiCAD. After this, HiCAD will no longer check whether newer data
exist. The reason for this is that a check for up-to-dateness of catalogues in HiCAD can significantly deteriorate the
performance in some situations.

As of HiCAD 2020, the new Reload function offers the option to update catalogues after applying changes to them
without having to close HiCAD, and without having to put up with drops in performance due to repeated checks for
up-to-dateness.

You find the new function at Settings > Catalogue.
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Drawing derivation

Dimensioning rules

n In the basic settings for the Usage "Sheet Metal" in the Configuration Editor (Configuration DEFAULT
(KANTBLECHE) the dimensions with the ID

l 135: Parametric linear dimensions of sheets (SHEETMETAL_PARA_DISTANCE) and

l 136: Parametric angular dimensions of sheets (SHEETMETAL_PARA_ANGLE)

have been removed from all views. As a result, die dimensioning rules of this configuration has changed (only
applicable to new installation).

n In the settings for the Usages Assembly column and Assembly girder in the Configuration Editor (Configuration
ASSEMBLY_COLUMN and ASSEMBLY_BEAM) the following dimensions have been removed from the Top view
(only applicable to new installation):

n In the settings for the Usages Assembly column and Assembly girder in the Configuration Editor (Configuration
ASSEMBLY_COLUMN and ASSEMBLY_BEAM) the following dimensions have been removed from the Front
view(only applicable to new installation):
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n For the dimensioning rules

l 64: Length of cut at beam/profile start (SECTIONAL_ LENGTH_BEGIN) and

l 65: Length of cut at beam/profile end (SECTIONAL_ LENGTH_END)

the dimension type Individual dimension is now also permissible, in addition to the dimension type Chain
dimension. If you choose Chain dimension as the dimension type, the chain of dimension will be lengthened
according to the selected reference, and becomes a chain dimension. If you choose Individual dimension,
only the length of the cut will be dimensioned. When updating model drawings from versions older than 2020,
only the cut will be dimensioned, and no chain dimension will be created.
An example:
The image below shows a model drawing with cut beams.

From this model drawing, a drawing was derived, considering only the beams and generating the top views:
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Import of foreign formats

Insert 3-D foreign formats as parts in current model drawing

Data in the 3-D formats:

n STEP (*.stp, *.step)

n STL (*.stl) (the STL file must exist in the ASCII format!)

n IGES (*.igs, *.iges)

n VDAFS (*.vda)

n CATIAV4 and CATIAV5 (*.MDL, *.Model, *.EXp, *.ISO, *.DLV3, *.CATPart, *.CATProduct)

n ACIS (*.SAT)

n Parasolid (*.x_t, *.xmt_txt, *.x_b)

n ProE (*.prt)

n Unigraphics (*.prt)

n SOLIDWORKS (*.sldasm, *.sldprt)

n Inventor (*.ipt, *.iam)

n AutoCAD (*.dxf, *.dwg)

n JT (*.jt)

n PLMXML (*.plmxml)

n IFC (*.ifc, *.ifczip)

could previously only be imported to a new HiCAD drawing with the Drawing > New/Open > Open > 3-D
Import function. If you want to insert data in these formats to the current drawing, now choose the renamed func-
tion Drawing > Insert Parts > Exp. > 3-D Import.

The parts will then be inserted in the current drawing as an assembly with the name of the selected file.
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Import model drawings

When importing 2-D/3-D model drawings via interfaces, HiCAD 2020 distinguishes between 2-D and 3-D imports.
For this purpose the old function Drawing > New/Open > Open > STEP, IGES, ... has been split into the 2 new
functions called 2-D Import and 3-D Import.
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HCM models in the Design Checker
The Design Checker now offers the following additional tests for HCM models.

n Sketches with HCM errors
lists all sketches containing incorrect HCM references.

n Sketches with external references
lists all sketches containing HCM constraints with external references.

n Not fully defined sketches
lists all sketches that are not fully defined.

n Assemblies with HCM errors
lists all assemblies containing incorrect references.

n Not fully defined assemblies
lists all assemblies containing a HCM model that is not fully defined.
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2-D

Service Pack 2 2020 (V 2502)

New Visualisation toolbar
The previous "CS display" toolbar has been extended with additional functions for fast hiding and showing of objects
and renamed to Visualisation. With the new functions you can, among others, enable/disable the visibility of isol-
ated points and 2D dimensions with one click. This allows for example to hide all dimensions of a drawing without
having to call a function from the context menu or ribbon first..

Toggle visibility of isolated points

AAll isolated points and the point identification of the construction can be switched on/off with one
click.

Toggle visibility of dimensions

All 2-D and 3-D dimensions of a drawing can be switched on/off with one click. This applies to both
drawing dimensions and parameter dimensions.

New Autopilot settings toolbar
The Autopilot settings toolbar below the drawing area can now be used to control which points the autopilot offers
as snap points. In the toolbar the possible snap points are highlighted.

With this bar you can control which point options should be visible on the Autopilot by activating / deactivating the

icons. For example, if you click on , the snapping of isolated points is disabled.

The currently selected Autopilot settings apply to the active HiCAD session. You can define which settings should
be active when restarting HiCAD in the Configuration Editor at System settings > Identification > List of point snap
options.

If you click on the icon in the Autopilot settings toolbar, the settings from the Configuration Editor are restored.

What's new? 63 / 362

News Overview



North American scale
Scales in HiCAD are used as

n main scale of a model drawing,

n Scale of a view,

n Scale of a 2-D part, and

n Scale of Steel Engineering detail drawings.

The scale can be selected from a selection box in the corresponding HiCAD function dialogues. In addition, in
many cases it is also possible to enter a scale directly. The scales available in the selection boxes of the HiCAD
functions are defined in the file SZENE- MASSSTAB.TXT in the HiCAD subdirectory MAKRO2D for 2D parts.
Please note that HiCAD supports the European scale logic by default, i.e. scale specifications in the form n:m, e.g.
1:1, 1:10, 5:1 etc

However, the US scale logic differs from that in Europe. Therefore HiCAD offers the possibility to extend the file
SZENE-MASSSTAB.TXT accordingly by defining further scale specifications.
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Example of an expanded SZENE-MASSSTAB.TXT file

' foot, " inch, 1 foot = 12 inches, 1 inch = 2,54 cm
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Changing the file SZENE-MASSSTAB.TXT

To structure the file, any empty lines and comments can be inserted, whereby comment lines must begin with the #
character. Each scale specification must be in a separate line. The following notations are supported for the scale
specification.

Notation Examples

1. Specification in the scale format n:m 1:10

1:1

2:1

5:1

2. Specification as factor 0.1

1

2

5

3. As factor with display text

The factor is at the beginning of the line, the display text in brackets behind it.

The display text is used by HiCAD in dialogues and info messages.

2.5 (2‘-6“ = 1‘-0“)

1 (1`-0“ = 1‘-0“)

4. In the scale format with display text

The scale is at the beginning of the line, the display text in brackets behind it.

The display text is used by HiCAD in dialogues and info messages.

1:12 (1“=1‘-0“)

1:48 (1/4“ = 1‘-0“)

Notations 3 and 4 are suitable for US scale specifications.

Please note:

Further information on Definition of Scales can be found in the same named topic in the Basics Help.
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New pocket calculator
The HiCAD pocket calculator has been redesigned.

In many cases HiCAD offers a default value which you can either apply or modify. You end the value input

n by clicking the left mouse button, or

n by pressing the ENTER key on your keyboard, or

n by clicking on the OK button.

Special keys:

The two buttons for Distances and Angles are used to transfer from existing construction objects.

Alternatively, you can call these functions in the context menu, which you activate in the calculator input field with
the right mouse button. The functions of the Distance and Angle menu displayed here correspond to the functions
with the same name in the Information menu.
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Service Pack 1 2020 (V 2501)

Point from point cloud

The point option (PW) Point from point cloud is now also available in the 2-D point options menu. The
point option can also be called via the keyboard by pressing the C key.

Mark attributes in annotations as Favourites
When selecting attributes for annotations, you can mark frequently used attributes as favourites for faster access.

To do this, simply click on the symbol next to the attribute name. The symbol then turns yellow . Attrib-
utes marked in this way are listed in the selection window under Favourites.

To remove an attribute from the favorites list, simply click on the corresponding symbol - either directly in the
Favourites list or in the attributes list.
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Further point options of the Autopilot during sketching
When drawing with the 2-D geometry functions, the Autopilot - depending on the cursor position - now also displays
the point options

(O) Online on edge through point and

(F) Perpendicular base point

is displayed when the cursor is near a straight line.

If the cursor is near a circle, the (F) Perpendicular base point and (T) Tangential point options are now also dis-
played. For arcs and ellipses the behaviour is the same.

Standard-compliant information on surface finish
From SP1 onwards, all information on the surface finish is displayed in the same font size and line width. After a
new installation of HiCAD, the default setting for the text height of the surface symbols in the file SURFSYM.INI 3.5
mm.

(1) before HiCAD 2020 SP1

(2) from HiCAD 2020 SP1 onwards

Insert pixel graphics
Pixel graphics - such as company logos - in the formats BMP, GIF, PCX, TIF and JPG as well as EMF files
(Enhanced Meta Files) can be inserted either with the function Drawing > Insert Part > Exp... > Bitmap or with
CTRL+V from the clipboard into the current HiCAD model drawing. They are assigned to the 2-D part structure and
have the name _B_M_P__.

The internal behaviour of these two procedures was different until now. From HiCAD 2020 SP1 onwards the two pro-
cedures have been unified and stabilized. This means, in particular, that checking the 2-D part structure via Inform-
ation > Check > 2-D Geometry no longer indicates errors if the model drawing contains pixel graphics.
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Major Release 2020 (V 2500)

Import drawings
When importing 2-D/3-D drawings via interfaces, HiCAD 2020 will distinguish between 2-D and 3-D imports. For this
purpose the previous function Drawing > New/Open > STEP, IGES, ... has been split into two new functions:

Changed dialogue for attribute selection
The Attributes button is now available for selecting attributes in the label editor. After clicking on this button the
selection list for attributes is displayed, which is divided into different attribute groups.
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2-D text settings
The default settings for fonts can now be set separately for 2-D and 3-D text in the Configuration Editor. The cor-
responding parameters can be found there at Drawing > Annotations Text.
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3-D

Service Pack 2 2020 (V 2502)

Model and process parts

Internal/external thread with runout

In the Internal/external thread function, thread runouts are now also possible.

The following options are available for runout length determination :

n Value, as part of thread length
The runout has the length specified in the Value field. The specified thread length is shortened accordingly.

n Value, in addition to thread length
This is only possible with the length options Fixed length and To point. The specified value determines the
length of the runout, the thread length does not change. If the sum of thread length and runout length is greater
than the possible full thread length, the runout is automatically shortened.

n Pitch factor, as part of thread length
The specified factor is multiplied by the thread pitch. The result is the runout length. The specified thread
length is shortened accordingly.

n Pitch factor, in addition to thread length
This is only possible with the length options Fixed length and To point. The specified factor is multiplied by the
thread pitch. The result is the runout length, the thread length does not change. If the sum of thread length and
runout length is greater than the possible full thread length, the runout is automatically shortened.

(1) Thread DIN 13 -M50x1.5, (2) Runout length 20, (3) Runout factor 8, (4) Internal thread DIN 40x1.5 with runout
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Changed dialogue for Clone parts (parametric) function

For the Clone > Param. function, the sketch selection dialogue for linear patterns has changed slightly.

The Process sketch , New sketch in plane and New 3-D sketch functions can now be activated dir-
ectly in the top level of the dialogue.

Similarly, the dialogue for the Hole pattern function has been modified for the area definition and the unpro-
cessed area.
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Divide along direction

The new Divide along direction function at 3-D Standard > Process > Trim > ... allows you to divide
parts of the type Solid into several sections along one direction. Different division options are available, for
example, the individual parts can have different lengths. In addition, a corresponding feature is created with this
function so that the division can also be edited later.

The direction, each division point and each gap are visualized in the drawing.
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Each part is a separate part in the part structure - on the same hierarchy level as the initial part and with the same
name. The initial part is assigned a feature with the name Subdivision, all other parts are assigned a feature with
the name from division. The division can be edited by double-clicking on one of the features. All parts are adjusted
accordingly.
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Example: Dividing a beam
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Example: Divided 3-D part
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The function can also be found at Steel Engineering > Lengthen > Divide.

If you make changes to the initial part on features coming before the Subdivision feature, only the initial
part will be recalculated. The division is performed at the same position relative to the part coordinate sys-
tem. This means that neither the division points nor the parts are recalculated. If you want to adapt all sec-
tions to the changes, use the Update function in the feature context menu of the division.
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Views

Detail view Cuboid/Sphere - New dialogue window and change options

The previous functions "Detail view Cuboid" and "Detail view Sphere" have been combined to form the new function

Detail view Cuboid/Sphere . You can switch between both modes in the Detail view dialogue window..

The new dialogue is much more user-friendly. For example, the cuboid and sphere are now visualized in the preview
and can be drawn dynamically with the cursor.

From SP2 on it is also possible to change a Detail view Cuboid / Sphere subsequently. To do this, select

the Change detail view function in the Views Ribbon or in the context menu for views. Afterwards
the corresponding dialogue window is displayed.
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New dialogue window for hatching selection

The selection of hatch patterns in view functions has been revised. This affects the following functions:

n New sectional view

n Change sectional view

n Create detail view

n Change detail view

n New cut-out

n Change cut-out

n Hatching in sectional view and cut-out

The Hatch selection dialogue is now displayed for selecting the hatch pattern. If you point the cursor on one of the
patterns, more information about the hatch pattern is displayed. By clicking on the magnifying glass symbol in the
lower left corner you can also zoom the display of the patterns.

If the Cut surface hatching parameter is set to According to material, the hatching selection in the dialogues has
no effect.
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New dialogue window when creating views

The dialogue for selecting the projection when creating a new view has been replaced in SP2.

This concerns the following functions:

Views > New > Standard

Views > New > List

Views > New > List > List from ref. view

Views > New > List > Active part list
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View properties of assemblies in context menu

As for other 3-D parts, the Properties in view area is now also available for assemblies in the context menu for
assemblies beneath Properties.

These functions allow you to define how the assembly is displayed in the active view.
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Change representation in multiple views

If several views are selected in the ICN, the representation of all selected views can be changed in one step.

Note the following:

1. The progress bar is view-comprehensive. This also applies to aborting hidden line calculations with the ESC key.
Views that have not yet been calculated are then displayed in QuickView.

2. If the display function is called with the CTRL key pressed, the views are always switched to exact rep-
resentation. This also applies when the automatic QuickView is active.

3. If several views are selected, all of which already have the desired display, but are in QuickView, HiCAD asks
whether the views should be switched to exact representation.

Hide parts in multiple views

Parts can now be hidden in all currently selected views in one step. To do this, you first select all required views in
the ICN. Then select the parts to be hidden in the ICN or in model drawing and choose Part list, Hide in active view
from the context menu (right-click). The parts are then hidden in all views that are selected in the ICN.
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Standard parts / Standard processings

Grip lengths for rivet insertion

When inserting rivets, the grip length range of a sub-type is now also displayed. For this purpose, the tables for rivets
in the catalogue at Fasteners > Rivets and at Factory standards > User-defined fasteners > User-defined rivets
have been extended by the minimum (SMIN) and maximum (SMAX) grip length.

When rivets are installed, these values are displayed in the selection window. If a sub-type is selected, the dialogue
window Grip length is preset with the value SMAX of the selected sub-type. This value can be changed, but must
not be less than SMIN and not greater than SMAX.

For update installations the grip length will not be displayed.

Change standard processings

Standard processings, which you create with the functions at 3-D Standard > Standard Processings, can also be
edited from SP2 onwards by double-clicking on the corresponding entry in the feature log. This applies to all stand-
ard processings for which a catalogue selection is possible as well as through holes and letterings.
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Sketches

Enhanced HiCAD VI / AV module

With the HiCAD VI / AV viewer solution, HiCAD constructions and drawings from third-party systems can be visu-
alised. Furthermore, the module supports the plot generation/output and data export. In order to support the cre-
ation and editing of sketches for sectional and detailed views, the corresponding functions are now available on the
Sketch Ribbon tab of the module.

Highlighting isolated points

If the Enter constraints checkbox is active in the HCM settings for sketches or if a sketch is parameterized manu-
ally, the sketch points are highlighted in colour. As of SP2, this also applies to isolated points in a sketch. Start and
end points of sketch lines are marked by a filled circle (1), isolated points of the sketch by a filled circle with a ring
(2). This applies to planar sketches and 3-D sketches.

You define the size and colour of the highlighting in Configuration Editor at System settings > Sketch HCM.

If sketch points are not to be highlighted, set the parameter Size of highlighted sketch points to 0.
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Parameterized sketches in sectional views

If a parameterized sketch with the purpose Create/Edit is active in a sectional view, the line end points of the
sketch and the degrees of freedom are also visualized there.

Size of sketch plane

HiCAD places a green frame around the geometry of a sketch, representing the plane of the sketch and completely
enclosing the geometry of the sketch. From HiCAD 2020 SP2 onwards, HCM positional and dimensional con-
straints of the sketch are also taken into account.

(1) before HiCAD 2020 SP2, (2) as of HiCAD 2020 SP2
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3-D sketching tool - Changed arc creation

When inserting arcs, the arc radius and the opening angle are displayed at the cursor from SP2 onwards. If you want
to use a specific radius, press the space bar or select the Value input function and enter the arc radius. You can
determine the end point of the arc either by moving the cursor or with a point option.

First select the radius of the arc. To do this, drag the arc so that the desired radius is displayed and drop the cursor.
The direction in which the arc is drawn (tangential or non-tangential) depends on the click point when the function
is selected.

If you want to use a specific radius, press the space bar or select the function Value input and enter the arc radius.

You determine the end point of the arc either by placing the cursor (the opening angle is displayed) or with a point
option.

If the last determined point is selected again, the drawing of an arc is automatically started.

If you specify a direction, the arc is drawn in the plane that is spanned by the specified direction and the tan-
gent of the last edge at the connecting point.

Extended point options of the Autopilot

The point options

n Tangential point (T)

n Online through point (O)

n Theoretical intersection point (S2)

n Perpendicular base point (F)

offered by the Autopilot are also available for plane sketches and 3-D sketches. The option F is only displayed if sev-
eral points have to be selected within a function, for example when selecting a direction. In addition, the following
restrictions must be observed depending on the situation:

Planar sketches

T F O S2

Sketch > Draw > Rectangle > Free -

Sketch > Draw > Ellipse

Sketch > Draw > Ellipse > Partial ellipse

3-D sketches

T F O S2

Sketch > New > Point

Sketch > Draw > Freehand

Sketch > Draw > Text
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Direction/Axis

When choosing a direction/axis over two points, T, F, O and S2 are offered at the second point, but not at the first
point. This affects the following Sketch functions:

nn Sketch > Draw > Freehand > Transition curve

n Sketch > Derive > Take O... > Directed

n Sketch > Transform > Move

n Sketch > Transform > Rotate

n Sketch > Transform > Rotate > Move+Rotate

n Sketch > Transform > Mirror

n Sketch > Transform > Scale

n Sketch > Clone > Move

n Sketch > Clone > Rotate

n Sketch > Clone > Rotate > Move+Rotate

n Sketch > Clone > Mirror

n Sketch > Clone > Scale

C-edge HCM

Here S and S2 are offered for all functions, except for dragging.
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Service Pack 1 2020 (V 2501)

Sketches

Enhanced 3-D sketching tool

With SP1 the 3-D sketching tool has been significantly enhanced. The dialogue window and the context menu have
changed as well:

n The "Direction+ Distance" sketching mode is no longer available. Instead, you now use the Select direction
function in the context menu to change the direction.

n If you want to enter a distance, length or radius using the keyboard, you can now also use the Value input func-
tion of the context menu instead of the space bar.

n If you activate the checkbox next to the Distance grid field in the dialogue window, the value for the distance
grid is automatically adjusted when you zoom the drawing. This is the ISD default setting.
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n The display of distances and angles during sketching has been improved.
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n By activating the Grid checkbox, grid lines and points can be displayed as tools for determining angles and dis-
tances, e.g.

n If a polyline is continued, it is also possible to draw an arc directly.

n When selecting the starting point, the autopilot also offers the point option O Online on edge and when determ-
ining the following points, both O and F Perpendicular base point. This depends on the cursor position.

n Connecting points of Plant Engineering parts are given special consideration during sketching. If the first point
is a connecting point, then this point is used to define a grid direction. This means that the following lines are
drawn in this direction.
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More point options of the Autopilot during sketching

For both planar sketches and 3-D sketches, point options

(O) Online to edge through point as well as

(F) Perpendicular base point

are now also displayed by the Autopilot - depending on the cursor position - when the cursor is close to a straight
line.

Others

n The function 3-D Sketch is now also available in the context menu for drawings.

n If the automatic assignment of constraints is activated in the Sketch HCM settings (Sketch > HCM > Tools
> Settings), the start and end points of the sketch lines and arcs are represented by small blue points from SP1
onwards. The size of the points can be set in the Configuration Editor at System settings > Sketch HCM with
the parameter Size of highlighted sketch points.
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Dimensionings and Annotations

Automatic dimensioning - Base point optimisation

For automatically generated dimensions, from HiCAD 2020 SP1 onwards, the projection line (for unshortened pro-
jection lines) is only drawn to the nearest point on the object to be dimensioned, i.e. to the next point on the con-
tour. This applies to automatically dimensioned developed sheets.

The following figure shows an folded sheet with material subtractions and the automatically dimensioned devel-
opment of the sheet.

(1) before HiCAD 2020 SP1, (2) from HiCAD 2020 SP1 onwards
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Please note:

If an automatically generated dimension is changed manually, the optimization described above may not be pos-
sible in some cases. This is the case, for example, if you drag the right dimension completely to the other side in the
example shown.

Standard compliant information on surface finish

From SP1 onwards, all information on the surface finish is displayed in the same font size and line width. After a
new installation of HELiOS, the default setting for the text height of the surface symbols in the surfsym.ini file is 3.5
mm.

(1) from HiCAD 2020 SP1 onwards, (2) before from HiCAD 2020 SP1
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Mark attributes in annotations as favourites

When selecting attributes for annotations, you now have the option to mark frequently used attributes as favourites

for a faster access. Simply click on the symbol next to the attribute name. The symbol then changes its colour

to yellow . Attributes marked in this way are listed in the selection window under Favourites.

To remove an attribute from the Favourites list, simply click on the corresponding symbol - either directly in
the Favourites list or in the attributes list.
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Views

Automatic QuickView

For complex model drawings, especially when updating views in HiddenLine mode, waiting times may occur. In
order to reduce these waiting times, HiCAD offers the possibility to temporarily use the corresponding Quick Hid-
denLine representation - the so-called QuickView - instead of the exact HiddenLine calculation for views with long
calculation times. This considerably increases performance when editing and updating views. Situations in which
this mode is very useful include

n the opening of model drawings with updating of referenced parts or

n switching from the Model view to a sheet area with many views.

The table below shows which QuickView belongs to which exact representation:

Exact representation Associated QuickView

HiddenLine Quick HiddenLine

HiddenLine dashed Quick HiddenGrey

Shaded with HiddenLine Shaded with edges

Glass model Wireframe (not separately selectable)

Left: Exact representation - HiddenLine dashed; Right: QuickView - Quick HiddenGrey (Image: Metallbau Wil-
helmer Projekt GmbH, Kolbnitz, Austria)

The QuickView can be activated model drawing-dependent, i.e. you can switch the mode on or off depending on
the requirements or size of the model drawing. This can be done either automatically or manually. In addition, you
can define how the system should proceed when saving if the model drawing contains QuickViews.
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The following parameters are available in the Configuration Editor at System settings > Visualization > Views:

n Automatic QuickView in new model drawings
This setting determines whether the automatic QuickView should become active for newly created model draw-
ings and for model drawings created with HiCAD 2019 or earlier. If the setting Activate is selected, HiCAD auto-
matically decides when the QuickView is required. The I default setting is Deactivate, that is, the QuickView
must be activated manually if required.

n QuickView when saving
Use this parameter to specify how to proceed when saving if the model drawing contains views in QuickView.
The default setting is Save views only in exact representation.

Representation of shaded views with shortening

Since HiCAD 2020, it has also been possible to shorten views for shaded views (Representation type Shaded
with/without edges or Quick Hidden Line / Quick Hidden-Grey). However, the shortening marks in shaded views
have not been displayed clearly enough until now. As of SP1, these are now highlighted in the colour selected in the
shortening parameters for the break lines.

Please note in this context that only the colour is taken into account for shortening shaded views.
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Determine the section direction for views containing shortenings

From HiCAD 2020 SP1 onwards, you have the option of individually defining the section direction, i.e. the direction
in which the break lines run. The Shortened view dialogue window has been extended accordingly:

After adding a shortening area, click on Determine, and then define the direction by specifying two points, select-
ing an edge or selecting a surface. When selecting a surface, the surface normal is used. If you have defined a sec-
tion direction, the break lines run parallel to the projection of the section direction into the screen plane. Otherwise,
the section is always orthogonal to the direction of shortening, i.e. the direction in which the partial areas are
pushed together.

Click on Reset to cancel the section direction.

(1) Shortening without section line; (2) Shortening with perpendicular edge as section line

Part properties

Alignment of flanges and bend zones

Since no workshop drawing can be created for sheet metal flanges and bend zones, the alignment selected in the
context menu for 3-D parts via Properties > Part orientation always refers to the main sheet metal part from HiCAD
SP1 onwards.

Alignments of sheet metal flanges and bend zones that were set in older HiCAD versions (before 2020 SP1) can be

deleted using the Reset function. The main sheet metal part must be active. The view alignment of the sheet
metal main part is displayed for these sheet metal straps and bend zones.
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Non-dimension relevant assemblies and parts

Not all parts are relevant for the dimensions of assemblies. For this reason, HiCAD offers the option of marking
such parts as not relevant for dimensioning. These parts are then ignored in all superordinate parts and assemblies
when calculating their dimensions.

To mark a part as "non-dimension relevant", the part attribute Ignore for dimensions (attribute name: #NDR, attrib-
ute type: Integer) must be assigned to it. If this attribute has the value 1, it is considered "non-dimension relevant".

To use this attribute, you must manually expand the attribute masks and/or properties windows of the ICN. This
attribute is not preset in the masks and windows included in HiCAD's scope of delivery.

You can find an example here.

Standard processings

Selectable border mode for hole patterns

For the Hole pattern function you can now specify how to handle holes that cut the border of the processed
area and are therefore only partially inside the processed area. The Border mode option is available for this pur-
pose. The possible options are:

n No hole on border: Only holes are created that lie completely within the processed area (corresponds to the
behaviour of older versions).

n Complete hole on border: Every hole that lies partly or completely within the processed area is created com-
pletely.

n Intersect hole with border: Holes that lie only partially within the processed area are only partially created.

(1) Template: Hole with area to be processed; (2) No hole on border; (3) Complete hole on border; (4) Intersect hole with bor-

der
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Extended Thread dialogue window

The Internal/external threads function has been extended:

n Instead of a cylinder surface you can now also choose an edge on one side of the cylinder.

n The thread texture will be displayed in a preview.

n You can now define the start and the end of the thread.

The following options are available:

External thread Internal thread

Without Without

Chamfer
Enter the length of the chamfer or choose Symmetric, if you want the cham-
fer to be created with an angle of 45 degrees. In this case the chamfer
length will be calculated automatically. The chamfer will only be created if
the Exact detailing checkbox has been activated.

Countersink

The countersink will
only be created if the
Exact detailing check-
box has been activ-
ated.

Cone point
Enter the length of the cone to its point.

Tapering
Enter the length and the diameter of the tapering.
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(1) Without, (2) Chamfer, (3) Cone point, (4) Tapering

Internal thread with and without countersink
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Major Release 2020 (V 2500)

Create parts

Dependent parts

The Dependent part function has been moved into the New function group of the 3-D Standard Ribbon tab.

Part CS of assemblies

Like any other part, assemblies, too, have a part coordinate system. This coordinate system can either (as pre-
viously) be automatically determined by HiCAD, or (from HiCAD 2020 onwards) determined by you during creation
of a dummy assembly or during forming of an assembly from existing parts. For this purpose, a new parameter is
available in the ISD Configuration Editor at Modelling > Part creation > Assembly.

The following settings are possible:

n Standard CS (default)
The Part CS will be determined automatically by HiCAD and corresponds to the World CS. There will be no fur-
ther queries. This behaviour is identical to that of previous versions.

n Query
If this setting is active, HiCAD will ask you to choose a plane, as you would do for a processing plane. This
plane is the top view plane of the Part CS. You have the following options to determine this plane:

l You determine the plane by identifying, in any order, points, edges, surfaces and also processing planes in
the model drawing. The standard CS will then be rotated in such a way that the XY-plane lies in the selected
plane.

l Press the middle mouse button to choose the World CS.

l Right-click to activate a context menu with further functions.
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The functions of the menu work in the same way as the same-named functions for processing planes.

The settings in the Configuration Editor do not apply to main assemblies. For created new main
assemblies the Part CS always corresponds to the World CS.
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Views

Exploded view with AutoDirection

HiCAD 2020 features a new movement type called AutoDirection on the Exploded view Ribbon tab.

This function allows you to define displacements with automatic direction in the Exploded view mode. As with the
displacement, several parts are linearly displaced simultaneously. In contrast, these parts are not moved with the
same distance, but are distributed along the selected direction relative to a certain part (the so-called fixed part).
This makes it possible to move several parts simultaneously in positive and negative direction in one step - depend-
ing on the position of the parts in relation to the selected fixed part.

In the image below, take a look at the initial drawing shown on the left. We want to achieve that the selected parts
(1) - highlighted blue in the figure - are moved on both sides of the fixed part (2) in one step, depending on their pos-
ition relative to part (2). The desired result is shown in the figure below. This can be achieved with the AutoDirection
function.
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New icons for Show/Hide parts

The icons for the Show/Hide parts functions in 3-D views have been replaced with new and more descriptive icons.
This concerns both the functions on the Views Ribbon and the functions in the context menu for views. This con-
cerns the following functions:

Hide parts in active view, Individual (Views > Parts > Hide)

Hide all parts in active view and show individually (Views > Parts > Off/On)

Show parts in active view, Individual (Views > Parts > Show)

Show all parts in active view (Views > Parts > ShowAll)

Visibility of textures in the HiCAD Viewer

The settings for the representation of textures (at Views > Representation > Shaded > Shaded rep-
resentation) will now be considered for the representation of textures. This means that whether and in which view
the textures will be shown in the Viewer will depend on the above settings.

Settings for shaded representation

The functions Shaded representation, active view and Shaded representation, all views have been renamed and
now have new icons:

Settings for shaded representation, Active view

Settings for shaded representation, All views
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Shortened views

In HiCAD 2020 a shortening of views is also possible for shaded views.

Up to now, views were created with the representation type

n Shaded with/without edges or

n Quick HiddenLine / Quick HiddenGrey

is always shown unshortened, even if the view was actually shortened. For drawings created with versions before
HiCAD 2020 and containing such views, the Configuration Editor at Compatibility > Views allows you to define how
to open these drawings.

The default setting is Show shortenings.

Simulation

Discontinuation of "old" assembling simulation

The old functions Assembling simulation and Simulation (Compatibility) that could be reached via the toolbars
(Settings > Toolbars have been discontinued and will be no longer available as of HiCAD 2020. For the creation of
simulations, please use the functions of the Simulation docking window.
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Dimensioning

Dimension assignment

In previous versions, dimensions were always assigned to the active part during their creation. From HiCAD 2020
onwards, you can assign the dimensions either to the active part or to the part to which the 1st dimension base
point belongs. This behaviour can be determined via the Set parameters for new general dimensions function, on
the System tab of the dialogue window.

The parameters of this tab can be preset via the Configuration Editor, at System settings > Annotations > Dimen-
sioning, 3-D > Interactive dimensions > Dimension assignment. The default setting is Active part.

Texts+ Annotations

Part annotation settings

The Part annotation Settings function can now be found at 3-D Dimensioning+Text > Text > Annot. >
... .
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Delete part annotations

The Delete functions for part annotations can now be found in the pull-down menu of the Delete text func-
tion:

New in this menu is the function Delete 3-D part annotation, drawing sheet function. Use this function to
delete all annotations on the active drawing sheet.
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Changed attribute selection dialogue

HiCAD and HELiOS attributes can now be selected directly in the Annotation Editor. To do this, click on the Attrib-
utes button and select the desired attribute from the selection list.

The list is divided into the different attribute groups

The selection list can be expanded, collapsed and searched for specific entries.
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Revised 3-D text

n The handling of 3-D texts has been revised. From HiCAD 2020 onwards, texts that are newly inserted into the
model drawing can not only be selected via their reference point, but also via any point on the text. This facil-
itates selection and increases performance. In addition, the text is automatically generated with an exclusion.

n The functions

l Copy active text and move via 2 points (3-D) and

l Move text, via 2 points (3-D)

are no longer available.

n The default settings for fonts can be set in the Configuration Editor, separately for 2-D and 3-D texts, at Drawing
> Annotations > Text.
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Standard parts/processings

Revised Threads function

The function 3-D Standard > Standard Processings > Thread for the creation of internal and external
threads has been revised completely. and outer
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Processing direction

New symbol sizes are available in the table Direction arrows (in the catalogue Factory standards > Symbols >

Arrows). These are available to you when you choose the Processing direction function.
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Standard processings / Slots

n In the Settings for Standard Processings the Through dialogue text has been replaced with Unlimited.

n In the dialogue window of the Slot function the Through checkbox has been replaced with the options Unlim-
ited and Bore depth.
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Sketches

Spirals

In the dialogue window of the Spirals function you can now also specify a winding angle instead of a number

of windings. Use the and symbols to switch between the options.

If this symbol is visible, the Number of windings mode is active. Enter the number of the required
windings. The winding angle will be calculated automatically.

If this symbol is visible, the Winding angle mode is active. Enter the required winding angle. The num-
ber of windings will be calculated automatically.
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Element selection in Sketch functions

In some drawings in can happen that sketches or sketch lines are hidden by other sketches or sketch lines in front
of them.To prevent accidental deleting or trimming of the wrong sketches or sketch lines, HiCAD offers you the
option to determine whether you can only select lines of the active sketch, or the lines of all sketches when you use
these functions. This behaviour can be determined in the Configuration Editor at System settings > Sketches > Ele-
ment selection in Sketch functions. The default setting is In all sketches.

If the setting Only in active sketch is active, the following message will be displayed when you select a line of a
non-active sketch with the corresponding functions:

Preview of processing planes when creating sketches

If the World CS planes for new sketch (also 3-D sketch) checkbox is active in the Novice configuration, a preview
of the planes of the world coordinate system will be displayed when creating new sketches. You can then simply
use the cursor to select one of the default planes displayed as a preview.

This preview is now considerably larger.
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New Sketching Tool for 3-D sketches

Similar as for planar sketches, the new 3-D Sketching Tool is now available for 3-D sketches as a convenient tool
for creating three-dimensional polylines.

If a 3-D sketch is active, the 3-D Sketching Tool will be automatically started when you choose the Line
(Sketch > Draw > Line) function.

The Sketching Tool simplifies the design process by automatically displaying auxiliary lines along a predefined grid
starting from the last point of a line and displaying the corresponding angles, distances or radii at the cursor depend-
ing on the selected mode. On this grid you can, for example, determine the direction and length of a line with a
mouse click by appropriate cursor movements. Since 3-D sketches - like other 3-D parts - have a part coordinate
system, you can change the plane in which you are drawing as you wish while drawing. This drawing plane is always
parallel to the selected plane and runs through the last point determined.
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Model and process parts

Hide points/crosshairs

The functions

Hide point and

Hide crosshairs

will now remain active after selecting a point/crosshairs edge, i.e. you can select further points/crosshairs edges to
be hidden. Press the MMB to exit the function.

Wrap function moved

The Wrap function can now be found in the pull-down menu of the Deform function.

Automatic calculation of assembly dimensions
For assemblies, the dimensions of the parts belonging to the assembly can be used to automatically generate the
attributes Length, Height and Width of the assembly and enter it in the assembly attributes. All solid parts belonging
to the assembly are included in the calculation, with the exception of standard and purchased parts with the inser-
tion type Site assembly.

Excluded from the automatic calculation are structure assemblies.

Whether and when the assembly dimensions are calculated when parts are changed can be set in the Configuration
Editor, namely at Modelling > Part properties > Calculate assembly dimensions.
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The following settings are possible there:

n Do not calculate automatically
The attributes of the assembly are not updated. This is the default setting.

n Only during itemisation
The attributes are only updated during itemisation.

n Always
The attributes of the assembly are updated immediately, i.e. after each change to the components or after
adding further components.

To calculate the dimensions, a bounding box for the assembly is determined internally, i.e. the smallest cuboid that
completely encloses the parts of the assembly to be considered.

1. The orientation of the bounding box also plays a role in the calculation of the dimensions. This is determined
according to the following priority:

2. Alignment of the changed or newly added part, i.e. the view selected in the context menu for Parts at Properties
> Part orientation.

3. Alignment of the assembly main part

4. Coordinate system of the assembly main part

5. Coordinate system of the assembly itself

The first option that is available is used. Since each assembly has a part coordinate system, there is always a
usable orientation and the dimensions can be calculated.

The assignment of coordinate system axes to the values is

n x: Length

n y: Width

n z: Height

If the part orientation (point 1 or 2) is used, length/height is derived from the front view and the width is per-
pendicular to it. This assignment is not configurable.
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Catalogue Editor

Service Pack 2 2020 (V 2502)

Derive new standard parts from existing standard parts
As of SP2 you have the possibility to derive new standard parts from existing standard parts. Currently, tables of the
following catalogues can be copied:

n Processings, general,

n Semi-finished products,

n Fasteners, and

n Factory standards.

This means in particular that you can use all the geometries and tables for fasteners and semi-finished products cre-
ated by the ISD to derive your own tables for standard parts with similar geometry. For example, you can quickly
derive tables for bolts/nuts of a similar DIN from an already existing table of bolts/nuts of a specific DIN. To do this,
you use the new Copy table function to copy an existing table and then modify the copy.

Standard parts created in this way behave in the same way as the standard parts in the original table and can be
inserted in exactly the same way. For example, they can be inserted with the same function, their display can be
switched analogously and - in the case of Fasteners - they can also be used in boltings.

The IPT file of the copy is always stored in the Factory standards catalogue and can only be assigned to mean-
ingful catalogues in the Catalogue Editor. This depends on the standard part type of the output table.

For example, if you have selected the DIN 557 table in the Fasteners > Nuts > Square nuts catalogue, the copy
can only be assigned to the User-defined fasteners > User-defined nuts catalogue and its sub-folders.

If you have copied a table from the Semi-finished products > Beams + Profiles > I-Beams catalogue, the copy
can only be assigned to the Factory standards > Factory beams folder and its sub-folders.
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The dialogue window of the Copy table function.

Track catalogue changes
Up to now, you could define in the Configuration Editor at System settings > Catalogues

n how catalogue changes should be handled in HiCAD and

n how catalogue tables should be handled.

With HiCAD 2020 SP2, these settings have been removed from the configuration management. The parameter
"Handling of catalogue tables" has been omitted without replacement. Instead of the parameter Track catalogue
changes, HiCAD provides a corresponding switch at Settings > Catalogue.
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Change order of catalogues
The order of the catalogues can now be changed if necessary. This affects both the display in the Catalogue Editor
and the catalogue selection in HiCAD. For example, you can put the catalogues that are important to you and most
frequently used by you in the front positions.

The following options are available for changing the sequence:

n You click with the cursor on the name of the catalogue to be moved and move the selected catalogue up or
down with the key combinations CTRL + Move Up or CTRL + Move Down.

n You activate the context menu for catalogues by clicking with the right mouse button on the name of the cata-
logue to be moved and use the functions at Move catalogue.

Please note:

n The order you have set will be retained during a catalogue update.

n Moving is only possible within the same level, i.e. a catalogue cannot leave its level.

HILTI HSA-Segment anchor
Segment anchors are single parts when inserted in HiCAD, whereas the real anchor consists of several parts. As of
HiCAD 2020 SP2, the corresponding catalogue table contains the material of the expanding part in the TYPE
column.

The table HSA Segment Anchors under Factory standards > User-defined fasteners > User-defined anchors >
Hilti has been extended by anchors of the type

n HSA-R2 and

n HSA-BW.
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ALUCOBOND® semi-finished products

The ALUCOBOND® semi-finished products of 3A Composites GmbH available in the catalogue have been exten-
ded by semi-finished products for North America. As of SP2 the following tables are available:

Catalogue Table

Textures and Colours > Colours ALUCOBOND_US_FARBEN

Factory standards > Sheets > ALUCOBOND US n ALUCOBOND ANODIZED

n ALUCOBOND BRUSHED

n ALUCOBOND COLOR-
SHIFTING

n ALUCOBOND METALLIC

n ALUCOBOND MICA,

n ALUCOBOND MIRROR

n ALUCOBOND SOLID

n ALUCOBOND TEXTURED

n ALUCOBOND PATTERN

n ALUCOBOND WOODGRAIN

Factory standards > Surface treatment > Profile and element Installation
> ALUCOBOND US

n Coating ALUCOBOND
ANODIZED

n Coating ALUCOBOND
BRUSHED

n Coating ALUCOBOND
COLOR-SHIFTING

n Coating ALUCOBOND
METALLIC

n Coating ALUCOBOND
MICA,

n Coating ALUCOBOND
MIRROR

n Coating ALUCOBOND
SOLID

n Coating ALUCOBOND
TEXTURED

n Coating ALUCOBOND
PATTERN

n Coating ALUCOBOND
WOODGRAIN
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Fasteners USA
Multiple fasteners for the American market have been added to the catalogue Factory standards > User-defined
fasteners:

Catalogue Table

User-defined rivets / Fastenal n Rivet 120° Countersunk Head

n Rivet Dome Head

User-defined rivets /Rivet King / Multigrip / MultigripRT "Aesthetic" n Dome Head MGRT

n Large Flange MGRT

n Countersunk MGRT

User-defined bolts+screws / Fastenal / Self-Drilling Screws n Phillips Drive Pan Head

User-defined bolts+screws / Fastenal / Self-Drilling Screws n Hex-Unslotted Hex Washer
Head

User-defined bolts+screws / Fastenal / Sheet Metal Screws n Indented Hex Washer head
Slotted

User-defined bolts+screws / SENCO n Rex Drive Flat Pan Head
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SYSTEA and BWM profiles
The Factory standards catalogue has been extended by special profiles for Roof Wall Facade and Purchased/Fact-
ory standard parts from Systea and BWM:

Catalogues Table

Special profiles by Systea and BWM

Factory standards / Series / Roof Wall Facade / Special profiles / BWM n ATK 103

n Hat profiles

n ATK 106 SZ
20

n Support pro-
files

Factory standards / Series / Roof Wall Facade / Special profiles / Systea n Hat profiles

n Mounting pro-
files

n Holding
tracks

n UBE NG2

Agraffes

Factory standards / Purchased/Factory standard parts / Agraffes / BWM n ATK 103

Factory standards / Purchased/Factory standard parts / Agraffes / Systea n UBE NG2

Clamps

Factory standards / Purchased/Factory standard parts / Clamps/ Systea n NBK Terrat

Thermostop

Factory standards / Purchased/Factory standard parts / Thermostop n BWM

Wall consoles

Factory standards /Purchased/Factory standard parts / Wall consoles / BWM n L-Wall
bracket

n U-Holder
Type S

n U-Holder
Type N

Factory standards / Purchased/Factory standard parts / Wall consoles / Systea n L-Wall con-
soles

n U-Wall con-
soles

What's new? 125 / 362

News Overview



The special profiles can be inserted via Steel Engineering > New > Cat., the other parts via 3-D Standard > Stand-
ard Parts > BoltScrew > Purchased/Factory standard parts.
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Service Pack 1 2020 (V 2501)

Thread-cutting screws
New in the catalogue Fasteners > Bolts+Screws > Thread-cutting screws are the screws of the type

n DIN 7504 P Cross-recessed thread-cutting screw PH),

n DIN 7504 N (Oval head thread-cutting screw),

n DIN 7504 K (Hexagon head thread-cutting screw) and

n DIN 7504 (Thread-cutting screw OTX).

HILTI anchors
n New in the Catalogue Editor at Factory standards > User-defined fasteners > User-defined anchors > Hilti >

HSA Segment anchor are the HILTI expansion anchors.

n New at Factory standards > User-defined fasteners > User-defined anchors > Hilti are the tables:

l HUS HILTI Screw anchors and

l HSC-I Undercut anchors.

n Also new are the HILTI shear connector cartridges HVU2 and HVU-TZ. You can find the corresponding tables
at Factory standards > Purchased/Factory standard parts > Shear connector cartridge > HILTI. \HVU2 (ID
335701298) and HVU-TZ (ID 335701299). The corresponding 3-D parts are BOM-relevant dummy parts.
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HILTI plastic dowels
New in the Catalogue Editor at Factory standards > User-defined dowels > Hilti are the following tables with
HILTI plastic dowels:

n HUD-1 and

n HPS-1.

Also, wood screws according to DIN 96 are now available especially for these dowels. You can find them at Fasten-
ers > Bolts+Screws > Wood screws.
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WELKO fasteners
New in the Catalogue Editor are WELKO studs, pins and sleeves. You can find them at Factory standards > User-
defined fasteners > User-defined studs > KVT-fastening > FASTEKS WELKO:
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Fabco and HFT fasteners
New in the catalogue Factory standards > User-defined fasteners > User-defined bolts+screws > HFT are the
following tables:

Fabco special screws for roof and wall:

n E-VS A

n E-VS FC

n E-X A

n E-X BZ

HFT facade screws:

n E-X BR RS SEC 12

n E-X BR 2 SEC 12

n E-VS 8 A
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HILTI anchors
New in the catalogue Factory standards > User-defined fasteners > Usere-defined anchors > Hilti are the
anchors of the types HST2 and HST3.
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BRUCHA folded profiles
In the catalogue Factory standards > Series > Roof wall facade > Lightweight profiles you will find new profiles of
the company BRUCHA for profile installation.
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JIS Beams - Standard G 3192
The JIS standard G 3192 contains in some cases, besides the standard description, an annex where further cross-
section geometries are stored. In those cases where HiCAD obtains the geometry from the annex, an additional
table with the standard geometries exists. The names of these tables have a supplement called (Standard), the
tables with the geometries from the annex have the supplement (Annex n), with n being the number of the annex.
This applies to the following tables:

n Semi-finished products > Beams+Profiles > I-Beams

l JIS G 3192 H (Standard)

l JIS G 3192 I (Standard)

l JIS G 3192 ISB (Annex 5)

l JIS G 3192 ISC (Annex 6)

n Semi-finished products > Beams+Profiles > L-Beams

l JIS G 3192 L (Annex 7)

l JIS G 3192 LE (Annex 1)

l JIS G 3192 LE (Standard)

l JIS G 3192 LU (Annex 2)

l JIS G 3192 LU (Standard)

l JIS G 3192 L (Standard)

n Semi-finished products > Beams+Profiles > U-Beams

l JIS 3192 CH (Annex 4)

l JIS 3192 U (Standard)

n Semi-finished products > Beams+Profiles > T-Beams

l JIS 3192 T (Annex 9)

l JIS 3192 T (Standard)

By activating/deactivating the tables in the CatalogueMaker you can determine whether JIS beams are to be inser-
ted according to standard description or according to annex.
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Additional direction arrows
New symbol sizes are available in the table Direction arrows (in the catalogue Factory standards > Symbols >

Arrows). These are available to you when you choose the Processing direction function.

Multi-language entries in BZ column
The designations in the column BZ now exist in different languages.
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Point clouds

Service Pack 2 2020 (V 2502)

Create / edit clipping boxes
Both when creating and editing clipping boxes, the autopilot now displays snap points. This allows you to set the
edges of clipping boxes to exactly one point. You can also use the options of the Point Options menu to set the clip-
ping box edges, especially the (PW) Point from point cloud point option.
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Part attributes of point clouds
The Part attributes dialogue window for point clouds has been optimized.
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Align point clouds

New in the Point cloud Ribbon tab is the function Align point cloud . This function allows you to change the
alignment selected when inserting a point cloud into the model drawing.

The alignment is changed by defining two points.

1. The first point defines the new origin of the part coordinate system.

2. The second point determines the X-direction of the part coordinate system.

The determination of the two points and the installation direction are graphically visualized in the drawing. To
determine the points, you can also use the point option Point cloud point (PW) (not automatically active). Point
cloud points always lie on the visible part of the point cloud and are represented by a red point on the cursor.
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Result:

Tip:
The Point cloud point (PW) point option is not automatically active when determining the points required
to perform this function. In certain situations, it may therefore be useful to determine isolated points before
alignment in order to better select the origin and X-direction of the point cloud. Isolated points can also be
point cloud points.
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Service Pack 1 2020 (V 2501)

Update point cloud references
New on the Point Cloud Ribbon tab is the Update point cloud references function.

This function allows point cloud references to be updated, for example to replace point clouds imported into a
model drawing with other point clouds or to change the path where the point cloud was stored.

Select the new point cloud or point cloud path in the dialogue window and click Open.

The point cloud will be replaced or the point cloud reference will be updated.
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Improved updating of point clouds
HiCAD model drawings or parts with point clouds do not contain the point cloud data but only a reference to the cor-
responding project point cloud, i.e. to the path in which the point cloud is located during import. If you transfer files
with point clouds to a third party, i.e. to another HiCAD workstation, then you must also pass on the folder with the
project point cloud in addition to the SZA or KRA file. At the same time, it had to be ensured that this folder also exis-
ted on the "new workstation". From HiCAD 2020 SP1 on, the updating of point cloud references when opening a cor-
responding SZA or KRA file has been improved.

n If the directory set as drive N in the filegrup.dat is part of the point cloud path, the point cloud will be found.

n If the directory set for drive N is moved, the point cloud is still found within this folder. However, this applies
only if the point cloud has been added in a version from HiCAD 2020 SP1 onwards. This does not apply to
already existing model drawings created with HiCAD 2020.

An example:

The directory C:\HiCAD\Point clouds is set as drive N. The point cloud file VHV Technikum.lsproj is located in the
folder C:\HiCAD\Punktwolken\Examples\User\VHVTechnikum The model drawing with the point cloud is saved.

The model drawing is then opened on a computer on which the same directory is set for drive N. The point cloud file
VHV Technikum.lsproj is located there in the folder C:\HiCAD\Punktwolken\VHVTechnikum.
-> The point cloud is found.

If HiCAD does not find a point cloud contained in a model drawing when loading it, the Update point cloud ref-

erences dialogue window is automatically displayed. If you move the cursor over the symbol, further inform-
ation will be displayed.

After clicking on the magnifying glass symbol and selecting the desired path / file, close the dialogue window with
OK.

The point cloud reference will be updated and the point cloud will be exchanged if necessary.

Point from point cloud
n The point option (PW) Point from point cloud is also available in the 2-D Point options menu.

n The point option can also be accessed from the keyboard by pressing the C key.
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Point Cloud Converter
When calling the Point Cloud Converter (PointCloudConverterConsole.exe) from the command line, the parameter
for colour/intensity of point clouds is no longer available

The import of E57 files uses the colour by default.

Improved clipping
When creating and editing clipping boxes, if you point the cursor at a directional arrow, the corresponding area will
now be marked and you can reduce or enlarge the box by dynamically dragging the area in the selected direction.
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Fitting direction determination for import
To align the point cloud in the construction, HiCAD now requests the determination of two point cloud points after
importing a point cloud. These are always located on the visible part of the scanned object. These points, together
with the Z-direction of the point cloud, define the part coordinate system. To determine the point cloud points,
HiCAD automatically activates the point option (PW) Point from point cloud.

1. Specify the first point cloud point. This defines the origin of the Part CS.

2. The second point cloud point determines the X direction of the Part CS.

The determination of the two points and the installation direction are graphically visualized in the model drawing.
Point cloud points are represented by a red point.

Determining of first point (Image: VHV Anlagenbau GmbH, Hörstel)
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Determining of second point and visualisation of fitting direction (Image: VHV Anlagenbau GmbH, Hörstel)
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After determining the points, the point cloud is rotated so that the Part CS coincides with the World CS.

Example of a point cloud imported to HiCAD with Part CS (Image: VHV Anlagenbau GmbH, Hörstel)
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Plane from point cloud

The new Select plane from point cloud function allows you to place a processing plane directly in a point
cloud. This simplifies design and machining in the spatial view, for example, if a new building is to be fitted into an
environment or a plant is to be installed in a room.

To define a processing plane, move the cursor to the desired position in the point cloud. HiCAD symbolizes the area
around the current cursor position by a circle. By clicking with the mouse, the marked area is used to define the pro-
cessing plane. Proceed as follows:

n If the plane is more vertical, then the X-axis is chosen so that it is perpendicular to the Z-axis of the world
coordinate system. The Y-axis is chosen so that it forms a positive scalar product with the Z-axis of the world
coordinate system, i.e. the angle is between 0° and 90°.

n If the plane is more horizontal, then the X- and Y-direction of the world coordinate system are taken over.

Please note:
When determining the processing plane you should make sure that the circle around the click point con-
tains only points of the desired processing plane. To avoid unwanted results, it may be useful to zoom in
before determining the click point. You can also use the mouse wheel while the circle is displayed.

Click to open a pull-down menu with the function Plane from point cloud, with X-axis . Here you
define the plane by two additional points - the origin and a point on the X-axis.
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Feature Technology

Service Pack 2 2020 (V 2501)

Updating dependent parts in locked assemblies upon loading
If a dependent part is contained in a locked assembly, it is now possible to have this part updated when loading the
drawing. This was not possible before.

Any other update of the part is still not possible.

Nested variables and formulas
It is now possible to specify a formula that contains additional variables when defining the value of a variable. Espe-
cially with complex parts, the variable structure can become much clearer.

Thereby variables may be nested arbitrarily deeply into each other:

However no cyclic structures may occur (variable a refers to variable b, which refers to variable a), since these can-
not be computed. In this case the automatic calculation of the formula values is no longer possible. The last values
are retained and an error mark is displayed at the affected variables, which shows an explanatory tooltip when the
mouse pointer is moved over them:

In this case, remove the cyclic dependency by editing the formulas to remove the error markings and reactivate the
automatic calculation of the formula values.
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Delete feature log of part with sub-parts
For instance, if the feature log of an assembly is deleted through the Delete feature log function, then the feature
log of all subordinate parts is always deleted as well.

Service Pack 2 and higher now displays the following information dialogue:

This dialogue allows you to cancel the deletion process by negating the query. In addition, you can choose the Also
delete feature log of sub-partsoption to have the feature logs of all sub-parts deleted at the same time (which was
previously the default) - or you can leave them as they are by deactivating the option.

Redesigned display of feature log
The window for displaying the feature log in the ICN has been revised and now presents itself in the form of a table
analogous to the newly designed 3D part structure since HiCAD 2020.
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This change was accompanied by many additional convenient functions. For example, the toolbar now not only
provides direct access to the functions Recalculate, Calculate next feature and Calculate to end, but the options
Automatic recalculation and Use external references can also be directly activated and deactivated here.

Also the context menus have been reworked and now have a new design.
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Service Pack 1 2020 (V 2501)

Improvements for dependent assemblies
n The Dependent part function in the 3-D Standard tab is now greyed out as long as no part is selected to which

this function can be applied.

n In addition, an information window appears after the function has been executed. This window disappears auto-
matically even without clicking OK in order not to interrupt the workflow.

n The functions for temporary or even permanent switching off the update of dependent parts can now not only
be found in the context menu of the feature entry but can also be activated after double-clicking the feature
entry in the Dependent part dialogue window.

Weld seam tags for automatically derived drawings without feature log
When the feature log is not activated, weld seam tags are now also created for automatically derived drawings. Pre-
viously, when automatically deriving a drawing via an API variant such as the Staircase Configurator or the Cross-
bracings, it was possible that weld seam tags could not be created for all welds seams.

This behaviour has now been corrected so that corresponding weld seam tags are generated for all weld seams as
expected. For older model drawings, it may be necessary to call the Recalculate feature function once before deriv-
ing the drawing.

What's new? 149 / 362

News Overview



Major Release 2020 (V 2500)

Further improved Use of variables dialogue window
The Use of variables window has been revised, now offering even more comfort in its use. The modifications are as
follows:

n A button is now available in the toolbar of the Part variables docking window, which directly opens the Use of
variables dialogue window.

n Icons are now displayed in the Use of variables window: The icon preceding a variable indicates the type of the
variable; in the same way, the respective icons are displayed preceding the parts, features and feature para-
meters.

n Unused variables are displayed in red.

n Formulas containing the respective variable are displayed in blue.

Access to variables of other parts
It is now possible to access variables of any other parts within formulas. This allows part variables to be used inde-
pendently of the part structure. In particular, the variables of a part can be accessed within views.
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Example:

The diameter of the ring should depend on the diameter (part variable diameter) of the shaft.

For this purpose, the ring contains a part variable of type part with the name shaft that refers to the shaft.

The value of the variable diameter of the part shaft can then be accessed in a formula by using shaft.-
diameter.
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If the ring is now to be mounted on another shaft, only the shaft variable must be adjusted so that it refers to the
new shaft (this must, of course, contain a diameter variable, otherwise the formula cannot be evaluated).

Display of sketches with external references
For entries in the feature log that refer to sketches, the sketch icon now directly indicates whether the sketch con-
tains external references.

n symbolizes a sketch with external references that were actually used.

n symbolizes a sketch that contains external references that were not used, for example, because the use
of external references was deactivated.

With existing drawings it can happen that the symbol is only displayed correctly after a feature recalculation.
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Merging of "Dependent part" and "Dependent assembly" function
The functions Dependent part and Dependent assembly have been merged into one, new function. This new func-
tion is called Dependent partwhich, however, behaves like the former Dependent assembly function, while offer-
ing the following, additional options:

n You can now also choose single parts as base parts, as long as they are referenced.

n You can choose whether the selected parts are to be exchanged with the dependent parts, or if the latter are to
be additionally created.

n The function can now be found in the New function group of the 3-D Standard tab of the Ribbon.

n In the part selection list, the icons for the respective part types are now also displayed.

New API functions
Two new functions are available for working with API variants:

n Sketch.CreateAutoConstraints() corresponds to the calling of the function Sketch > HCM > Coinc...
> Automatic positional constraint.

n Sketch.CreateAutoDimensions() corresponds to the calling of the function Sketch > HCM > Smart
dimensioning > Automatic dimensional constraint.

In both cases the selected function will be carried out with the default settings, i.e. without any further queries or
offering any configuration options.

Weld seam tags without Feature log
It is now possible to create and edit weld seam tags even without an activated Feature log. Up to now, when auto-
matically deriving a drawing to an API variant such as the Staircase Configurator or the Cross-bracing, it was pos-
sible that weld seam tags could not be created for all weld seams

For older constructions, it may be necessary to call the Recalculate feature function once before deriving the draw-
ing.
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Parametrics (HCM)

Service Pack 2 2020 (V 2502)

More meaningful error messages for inconsistent HCM models
When you performed an action that makes an existing HCM model inconsistent, a rather general error message
used to appear:

In HiCAD 2020 SP1 some errors have already been provided with new error messages. In Service Pack 2, further
cases are added:

n If a constraint is generally not possible (e.g. Coincidence between two cylinders with different radii).

n When a part is moved to another assembly that is not included in the current assembly. In this case, the HCM
constraint is now moved to a suitable assembly so that it can continue to be active. If this should not be pos-
sible, a message window appears.

n When deleting a part to which HCM-constraints refer.

n When transforming parts.

n When fixing a part that has constraints to another fixed part.

n When adding constraints that would redefine the model.

n When updating referenced parts.

n When a part is changed by a feature recalculation so that a constraint can no longer be resolved.

n When deleting an isolated point to which a constraint refers.

New Visualisation toolbar
The functions Toggle visibility of dimensions (3-D Part HCM), Toggle visibility of degrees of freedom (3-D Part
HCM), Toggle visibility of constraints (C-Edge-HCM) and Toggle visibility of degrees of freedom (C-Edge-HCM)
have been removed from the Ribbons 3-D Standardand Sketch , and can now be found on the new Visualisation
toolbar.

Visualization of the sketch plane
For sketches in the model drawing, the sketch plane belonging to the sketch is always displayed as a green rect-
angle in the drawing. Until now, this rectangle was always dimensioned so that all line elements of the sketch fit
into it. However, HCM dimensions and symbols were not taken into account, so they were displayed partly on and
partly off the sketch plane.

This behavior has now been corrected so that these entities are also completely enclosed by the rectangle in the
sketch plane.
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Coordinate system elements in the ICN
HCM constraints that refer to a coordinate system element such as a plane or an axis are now displayed in the ICN
in a shortened form as "XY-plane" instead of e.g. "XY coordinate system plane". Similarly, axes are now displayed as
"Z-axis" instead of "Z coordinate system axis". This makes the listing of conditions in the ICN more compact and
clearer.
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In addition, the affected coordinate system elements are now also highlighted in the construction when a cor-
responding entry in the ICN is selected.
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Stable area distance
For distance constraints with area definition, the distance may be changed by the HCM within this definition. Up to
now, the HCM has often used this option. However, as of SP2, the distance is only changed if there is no other way
to calculate the HCM model.

Show/hide parts in the ICN
If the HCM-ICN is set to display By geometries, the Show in active view and Hide in active view functions can now
be found in the context menus of the parts. This allows for quick and convenient part display and hiding without hav-
ing to search through the part structure first.
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Service Pack 1 2020 (V 2501)

Part HCM

Improved placing of HCM dimensions

The algorithms for offsetting HCM dimensions have been improved to improve the offsetting of HCM dimensions.
The improvements include:

n Dimensions in 3-D sketches now align with the sketch coordinate system, not the world coordinate system.

n For surfaces, if possible, the base points of dimensions are now selected so that no bend in the dimension line
will be necessary any more.

n The plane direction for dimensions is now selected as for drawing dimensions.

n The same context menu as for drawing dimensions is available when placing dimensions.

Creation of Equal distance and Equal angle constraints via dialogue window

The Part HCM constraints Equal angle and Equal distance are now also created via the dialogue. The pin in the
upper right corner of the dialogue ( / ) can be used to keep the 1st distance and/or the 1st angle even after clicking
Apply. This allows for the convenient creation of several equal constraints one after the other.

Changing constraints

To change a constraint in the 3-D Part HCM, the corresponding dialogue window can now be opened by double-
clicking on the constraint in the ICN. In this way, changes can now be made directly in the dialogue window.
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Part HCM: Display and change of orientation of a constraint via dialogue window

The HCM constraints Coincidence, Distance, Parallelism and Concentricity dialogue windows now contain an
additional Orientation section. Here, after selecting suitable geometries, the current orientation is displayed. By
clicking on the respective button, the orientation can be adjusted. A real-time preview is displayed in the model
drawing.

This section in the dialogue window replaces the old Orientation function.
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Error messages for problematic constraints

When an action such as creating or modifying an HCM constraint creates inconsistencies or other problems, a mes-
sage box is now displayed to explain the error. If possible, suggestions for action to solve the problem are also
offered directly:

n If an action on an HCM constraint causes a superordinate assembly to become inconsistent:

n If a model is overdefined by a new constraint:

n If a part is fixed that is already bound to another fixed part via constraint, a list of constraints is displayed. You
can choose between the following actions: Delete removes these constraints and fixes the part.Do not delete
leaves the constraints and fixes the part anyway. Cancel leaves the old constraints unchanged, but does not
create a new fixing either.

HCM entries in the ICN

ICN: Expanded and collapsed entries are kept

If you open or close positional and dimensional constraints of a part in the ICN, this state is now also maintained
when the active part is changed. This means that when you later switch back to a part, the same entries will be
expanded and collapsed as before the switch.
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References to deleted parts

HCM references that refer to a deleted part now show the name of the deleted part in the ICN. This can be helpful
to identify such constraints later.

Change order of constraints in ICN

The order of the HCM constraints in the ICN can now be changed by Drag & Drop.

HCM constraints can only be moved within their group. Accordingly, positional constraints cannot be moved to the
Dimensional constraints group and vice versa; likewise, in the Sort by geometry view, constraints can be moved
only within their part.

Newly created constraints are always inserted at the end of the list.

Tooltips for error and warning icons

If an HCM model contains problematic constraints (for example, constraints on parts that no longer exist or over-
defined parts), error or warning icons are displayed in the ICN to draw attention to these. These icons have now
been added to the tooltips. This makes it easier to find out the reason for the error or warning.

3-D sketching tool: Automatically generated HCM constraints
When using the new Direction+Length mode of the 3-D sketching tool the following HCM constraints are auto-
matically created:

n If an existing edge or cylinder is selected as direction, a Parallelism constraint is set.

n If no parallelism to a coordinate system axis is set, a Perpendicular constraint to the plane is set.

n If the line is tangential to the last line and this was an arc, a Tangent constraint is created.
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Display of points in sketches and 3-D sketches
If a sketch or 3-D sketch is selected as the active part, the end points of lines contained in the sketch are now high-
lighted in the model drawing, according to the logic of the HCM: Fully defined points are highlighted in green, fixed
points in yellow. Overdefined points are highlighted in red. All other (underdefined) points are highlighted in blue.
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The size of the point can be changed in the Configuration Editor at System settings > Sketch HCM > Size of high-
lighted sketch points. If you set the size to 0, the points will no longer be highlighted.
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Sketch HCM 

Point option M

When setting HCM constraints in sketches and 3-D sketches, the point option M (Mid-point of line/edge) is now
offered again by the Autopilot.

Error messages for problematic constraints

When an action such as creating or changing an HCM constraint creates inconsistencies or other problems, a mes-
sage box is now displayed to explain the error. If possible, suggestions for action to solve the problem are also
offered directly:

n If a condition overdefines the HCM model, a dialog indicates this problem. You have the following options for
dealing with it: Add anyway nevertheless creates the constraint, which means that the HCM model is now over-
defined. Cancel will not create the constraint.

n If a sketch element is fixed that is already linked to another fixed element by constraints, a list of conditions
appears. You can choose from the following actions: Delete removes these constraints and creates the fixing.
Do not delete leaves the constraints and creates the new fixing. Cancel leaves the old constraints unchanged,
but does not create a new fixing either.
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Lock rotation for Concentricity constraints in Assembly HCM
When creating a Concentricity constraint in the assembly HCM, the rotation can now be optionally locked. This
makes it easier, for example, to achieve full definition when screws are present.

The Concentricity dialogue window now features a Lock rotation checkbox.

The rotation lock can only be set between geometries such as two edges, but not between an edge and a point. In
this case a corresponding message is displayed.

In the ICN a Concentricity constraint with rotation lock is indicated by a changed icon:

In the context menu of Concentricity constraints in the ICN the new functions Lock rotation for concentricity

and Unlock rotation for concentricity are now available.
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Influence of positive/negative sign on dimensional constraints in Assembly HCM
The influence of the positive/negative sign on the direction of dimensional constraints was standardized.

n For distance constraints, at least one of the geometries must be a surface. If the distance constraint refers to
several surfaces, the first selected surface is used as reference surface. A positive distance then points away
from the body to which this surface belongs. Accordingly, a negative distance causes it to be measured "into
the body".

n For angle constraints the current value is always positive.

When creating a new constraint or editing an existing one, the current value is now always given with the correct
sign. A change of the sign then causes the alignment of the measurement to be changed accordingly. If the sign is
not changed, the alignment remains unchanged.

For distance constraints that do not relate to surfaces (for example, the distance between two points), changing the
sign has no effect on the model. If you enter a negative value here, a warning is displayed.
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Major Release 2020 (V 2500)

Automatic assignment of HCM constraints in the new 3-D sketching tool
The new sketching tool, which is available for the quick creation of 3-D sketches, can automatically assign HCM
constraints. As an example, a short tutorial is available on how to create a 3-D sketch with HCM constraints as a
basis for a handrail support in just a few steps.
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Error messages in the Part HCM

Up to now, references to missing components in the HCM were displayed as Errors. Now a special handling
for parts that are disabled by a feature constraint has been introduced. Such parts are also listed with the message

Geometry does not exist, but instead of as errors only as a Warning. The reason for this is that HCM constraints
that refer to deactivated parts can also be considered as deactivated and therefore do not represent an error.

In addition, a more meaningful error message is now issued if you assign a Coincidence constraint between two cyl-
inders with different radii.
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Revised assigning of positional and dimensional constraints for assemblies
The assignment of positional and dimensional constraints between parts of an assembly has been revised. The
changes include:

n When creating constraints, a dialogue window is now displayed which queries the relevant geometries and
allows for further settings such as the direct assignment of a comment for this constraint.

n The Distance with min/max. value and Angle with min/max. value functions have been integrated to the
Distance and Angle functions.

n After selecting the first part for a constraint, the constraint is now automatically displayed transparently to sim-
plify the selection of an underlying part.

n It is now also possible to temporarily hide the area currently under the cursor by pressing the ALT key when
selecting a geometry. By pressing the Ctrl+ALT key combination it is possible show such a hidden area again.

n The Change dimension, Move dimension line, Equal parameter and Equal direction functions have been
removed from the Ribbon.

n By pressing the F4 key and the entry Show/Hide coordinate system in the context menu the part coordinate
system can be shown and hidden.
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HCM tests in the Design Checker
The following new tests that allow you to examine the model drawing for specific situations are now available in the
Design Checker:

n Sketches with HCM errors lists all sketches that contain incorrect references.

n Sketches with external references lists all sketches that contain HCM constraints with external references.

n Not fully defined sketches lists all sketches that are not fully defined.

n Assemblies with HCM errors lists assemblies that contain errors, such as incorrect references or over-defined
HCM models.

n Not fully defined assemblies lists all assemblies containing a HCM model that is not fully defined.
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Performance
Thanks to internal optimizations the performance during working with large model drawings with very many HCM
constraints could be further improved.

Further improved HCM constraint display in the ICN
The display of HCM constraints in the ICN has been further improved:

n The Comment column is now also displayed in the Sort by geometries view.

n The icons for incorrect constraints are now displayed next to the icons for the affected constraints/geometries.

n The filter function for constraints in the ICN now also affects the display of constraints in the model drawing. For
example, if you activate a filter Constraints with external references in the ICN, then only these constraints will
be displayed in the drawing.

Left: Display of all constraints; Right: Filter "Constraints with external references"
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Equal distance constraint applied to surfaces
In the Assembly HCM, the Equal distance constraint could not yet be applied to surfaces. This constraint has been
changed to allow for the use of surfaces.

However, it must be considered that the parts must already have a suitable position relative to each other when
assigning the constraint. Otherwise, an error message will be displayed:

Example:

The ring should be positioned centrally on the shaft. For this purpose, the Equal distance constraint is to be applied
between the outer surfaces of the ring and the outer surfaces of the shaft. The position of the ring is correct in this
example because it is already located between the outer surfaces of the shaft.

Result:

If, however, the ring is not located between the outer surfaces of the shaft, the constraint cannot be resolved and
the above error message will be displayed.
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Show constraints with errors in structure
If a HCM model contains constraints which cannot be evaluated because of errors, you can now click on the red
error mark to expand the structure in such a way that all errors are shown.
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Delete and deactivate the HCM constraints of a part
In the Assembly HCM you have now the option to activate, deactivate or delete all constraints of one part at once.

To do this, switch the display of the HCM window in the ICN to Sort by geometries and right-click the desired part
to open the following context menu:

Here you will find the new functions Activate constraints of part, Deactivate constraints of part and
Delete constraints of part.

Tooltips for HCM constraints
The tooltips that appear when you move the cursor over the icons of the HCM functions on the Ribbons now contain
a short description of the respective function.

Function Tooltip

Coincidence Coincidences of C-edge elements

Align to CS axis Align lines to coordinate system axes

Tangent Tangential transition of distance, circle/circular arc, sphere

Concentricity Symmetry around a common centre

Mid-point Fix point in the middle between 2 geometry elements of a sketch

Symmetric Symmetry between distances, circles/circular arcs, points

Equal radius Equal radius between circles/circular arcs

Equal distance Equal distance between sketch segments

Equal angle Equal value between angles

Parallel Parallel alignment of edges, surfaces

Perpendicular Perpendicular position of distances and planes to each other

Fix Fix/Unfix geometry

Forced fixing Forced fixing, no transformation possible

174 / 362 What's new?

Parametrics (HCM)



Configuration Management

Service Pack 2 2020 (V 2502)

Track catalogue changes
Up to now, the Configuration Editor at System settings > Catalogues could be used to define how catalogue
changes should be handled in HiCAD. From HiCAD 2020 SP2 onwards these settings are no longer available in the
Configuration Editor . Instead, the switch Track catalogue changes is now available at Settings in the Cata-
logue menu.

If the switch is active, the catalogues are regularly checked during a HiCAD session to ensure that they are up-to-
date. This actuality check can, however, significantly impair performance in some situations. If the switch is active,
then this is indicated when HiCAD is started. By default, the switch is inactive by default, that is, the catalogues are
loaded in HiCAD only once, when starting HiCAD. After that, the system does not check whether more recent data
is available. To update the catalogues after changes, the function Reload is available. This offers the possibility to
update catalogues after changes without having to leave HiCAD and without having to accept performance losses
due to the constant check for up-to-dateness.

The current status of the switch (active/inactive) is entered into the Windows Registry. If the switch is active, the fol-
lowing message is displayed when starting HiCAD.
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Service Pack 1 2020 (V 2501)

Switch to new standard itemisation
As of HiCAD 2020 SP1, you can use the Configuration Editor to define the procedure for starting the itemization in a
model drawing that still uses the itemization up to HiCAD 2017. To do this, open the Configuration Editor and
choose System settings > Itemisation > Switch to 'Standard itemisation used since HiCAD 2018'.
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Major Release 2020 (V 2500)

ABWPOL.DAT settings moved to Configuration Editor
The settings of the ABWPOL.DAT file have been moved to the Configuration Editor (ISDConfigEditor.exe).

You now find the settings for the neutral axis for approximative sheet development at Sheet Metal > Default
setting.

Assigning of views for model drawings without Sheet and Model area
The settings

n Assigning of views in drawings without Sheet and Model area

n Handling of shortenings displayed as unshortened in shaded views

have now their own node in the Configuration Editor, at Compatibility > Views.

The detail drawings created with the Management+BIM module are always stored on Sheet 2 of the drawing. When
printing via the HELiOS/HiCAD Spooler, all sheets will be printed - depending on the setting - i.e. also Sheet areas
without production drawings such as Sheet 1.

By setting the parameter Delete unused Sheet areas to Yes, it is now possible to specify in the Configuration Editor
at PDM > Management+BIM > Production drawings that Sheet areas with no production drawings are deleted.
The default setting is No.

When creating/updating external CAM data in the formats DSTV-NC, DXF, DWG, NCW/NCX and STEP, and drawing
data in the formats DXF, DWG and PDF, the corresponding files can also be automatically exported to the Windows
file system if required. The appropriate parameters are available in the Configuration Editor at PDM > Man-
agement+BIM > External production documents.

By default, the Management+BIM module works project-related, i.e. the managed parts are usually clearly
assigned to one project. When installing parts with reuse in other projects, such as purchased parts, you must
assign the article master manually, as these parts are ignored by the BIM automatisms.
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Bill of Materials / Report Manager

Service Pack 2 2020 (V. 2502)

BOMs - All visible parts on active sheet
When creating Bills of Materials it is now possible to consider only the visible parts of the active sheet area. For this
purpose the Settings for BOMs in HiCAD have been extended accordingly.
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Service Pack 1 2020 (V 2501)

Steel Engineering BOMs - handling of structure assemblies
Steel Engineering BOMs now allow you to define in the Excel template (HiCAD_Stahlbau.2501.0.xlsx) how BOM-rel-
evant structure assemblies should be handled in the shipping list. For this purpose the row Ignore structure assem-
blies is available on the sheet Settings.

If this setting is set to true, then all structure assemblies on the first level of the part structure are ignored in the ship-
ping list and only the sub-parts of these assemblies are taken into account.

The default setting is false.
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Steel Engineering BOMs - Selectable length attribute for bar optimization
For bar optimization in Steel Engineering BOMs you can now choose in the corresponding Excel template (HiCAD_
Stahlbau.2500.0.xlsx), which attribute is to be used for length determination. For this purpose you can find the
Length attribute option on the Bar settings table sheet.

Previously the attribute H_§03 (Profile length) was used here. The new default value for this option is H_§24
(Trimmed length).

Steel Engineering BOMs - New parameter for Sheet Metal parts with image
To be able to control the automatic page break when printing the sheet Sheet Metal parts with image, you have
now the option to set the maximum height (added up row height) for automatic page break on the Settings sheet of
the Excel template file (e.g. HiCAD_ Stahlbau.2500.0.xlsx). If a height is specified, a manual page break for
grouped lists will be inserted before the group exceeding the height.

The maximum height depends on various parameters such as print settings, print areas, headers/footers.

To calculate the height you can switch, on an Excel sheet with more or less the same row heights (e.g. Structure
list) and a sufficient number of filled in rows, to the Page break preview mode on the View tab. The height results
from
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n from the number of rows up to the first page break,

n minus the rows that are repeated on every printed page,

n multiplied with the row height.

The default value is 480 (32 rows* Row height 15).
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HiCAD GUI Creator

Major Release 2020 (V 2500)

Default values for Toolbox objects
For Toolbox objects of the type EditBox, ComboBox, CheckBox and RadioButtons as well as CatalogEntry, default
values can be set from HiCAD 2020 onwards.

CatalogEntry
Variables for catalogue entries that were assigned to a installation element or railing component and have not been
not defined as list variables are now automatically converted to list variables when the variant is saved. The text
object CatalogEntry will then be automatically used for these variables when they are inserted into a user dialogue
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Interfaces

Service Pack 2 2020 (V 2502)

Favourites for 3-D import

Thze settings for the 3-D Import function can now be saved as favourites. To do this, click on the sym-
bol in the dialogue window. You can find more information on favourites management in the in the Manage Favour-
ites topic of the HiCAD Basics Help. You can specify which favourite is used as the default in the import dialogue in
the Configuration Editor at Interfaces > Import.

To preset a favourite for a file format, just click on the symbol and choose the desired favourite.

When starting the import dialogue, please note that the last selected settings for the respective file format are used
as default. If you have not made any changes to the settings of the favourite defined in the configuration man-
agement, the favourite settings will be used.

Due to the favourites management, the following settings in the Configuration Editor are not applicable:

n Interfaces > General 3-D interfaces > Default options for import

n Interfaces > STL > Default options for import

n Interfaces > IFC > Default options for import except for the Attribute mapping configuration

For import via Drag&Drop from the Explorer, the import dialogue is now also displayed. This dialogue is preset with
the file to be imported and the corresponding options for the file format are displayed. This does not apply to the
import of 3-D DXF/DWG.
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3-D export by views

From SP2 on the context menu for views provides the function 3-D Export (STEP, 3D PDF...) by views .
Analogous to the 3-D export of model drawings, only the active view is exported here.

Export by views is possible for the following formats:

n 3D PDF

n Universal 3D

n Product Representation Compact

n 3DViewStation

n Step

n Autocad (DXF, DWG)

n IGES

n VDAFS

n CATIAV4

n CATIAV5

n ACIS

n Parasolid

n ProE

n JT

n PLMXML

Please note:

n Only parts that are visible in the view are exported.

n The export is also possible for sectional views.

n For exploded views only the export by views to 3D PDF, Universal 3D, Product Representation Compact and
3DViewStation is possible. During normal export, the parts are exported in their original position.

n Views of developed sheets cannot be exported.
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2-D import

AutoCAD DXF/DWG

When importing 2-D files in the DXF/DWG format, the conversion file ACADHCAD can now be selected for import dir-
ectly in the import dialogue.

As a result, the functions formerly available at Drawing > New/Open > Open > Settings have been withdrawn.

2-D import via the HiCAD Start Centre

BabCad (DXB), PC-Draft (V11) and ProCad (DXP) files can no longer be loaded via the Start Centre. The cor-
responding import functions can be found at Drawing > New/Open > Open > Further.

Starting with SP2 the Start Centre supports the import of ME10 files (MI) and files from Technovision (GAF).
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IFC import
When importing IFC files, the IFC objects to be imported can now also be selected by using attribute filters. The fil-
ter mode Attribute Filter is available for this in the IFC import filter dialogue window. Here you can filter the struc-
ture according to the attributes Object name, Object type, Description and GUID. You can also define one or more
rules that must be fulfilled for an object to be selected. These rules can be linked with AND or OR.

Please note:
You can use either direct filters or attribute filters. A combination of direct and attribute filters is not pos-
sible.

IFC export - Part filter for geometry merging
This new parameter allows you to specify during IFC export that main and sub-parts are combined into one part dur-
ing export - without Boolean operations.
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To use part filters, activate the checkbox Part filter for geometry merging and then - after clicking the sym-

bol - the part type. All parts filters defined with the Search via toolbar (Part filter) function are supported. The
following part filters are already predefined:

Industry Part type

General Referenced part

Sketch

Solid

Plant Engineering Straight pipe

Elbow

Pipeline

Sheet Metal Sheet

Mechanical Engineering Standard part

Steel Engineering Facade assembly n Mullion or transom
assembly

n Mullion assembly

n Mullion joint

n Transom assembly

Steel Engineering assembly n Stabilizing pipe

n Console

n Cross-bracing

n Frame

n Column

n Girder

General part n Glass

Facade part n Rubber seal

n Isolator

n Clamping strip or cover
tray

n Mullion or transom

Steel Engineering part n Flat steel

n Shaped pipe

n Grating

n I-beam

n L-Profil

n Round pipe

n Round steel

n Plate

n Steel beam or profile

n T-beam

n U-beam

n Z-profile
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Example:

A Cross-bracing (2602) has been installed between four beams. Cross-bracing was chosen as usage for the beams
in the cross- bracing dialogue.

The two marked assemblies then have the usage Cross-bracing. If the model drawing is exported as an IFC file
using the part filter Steel Engineering > Steel Engineering assembly > Cross-bracing, the parts of the assemblies
will be combined into one part each.
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Service Pack 1 2020 (V 2501)

Marking of imported 3-D parts in the ICN

All parts that you insert into the model drawing with the 3-D Import function will be marked with the symbol in
the ICN. If you move the cursor over the symbol, further information on the corresponding part will be displayed,
e.g. the imported file format and the HiCAD version with which the part was imported.

Save as DXF/DWG
When saving model drawings or image details with the functions

DXF/DWG and

Detail, DXF/DWG

a message will now be displayed if the selected area contains shaded 3-D models.

BOM-relevance for IFC import
When importing IFC files, the BOM-relevance of parts and assemblies is automatically removed.
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Changed menu for 2-D import

n The import of DXF/DWG files is now done by the function 2-D Import .

n The import of PC Draft files (.V11), Babcad files (.DXB) and Procad files (.DXP) is now performed via the cor-
responding functions at Drawing > New/Open >Open > Further > ... :
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Update to CADfix 12 SP1
With the update to CADfix 12 SP1 the following format versions are now available in HiCAD 2020:

n CATIA V5 – V5V62019

n NX 12

n SolidWorks 2019

n Inventor 2019DXF/DWG 2018

Import files via interfaces
When importing 2-D/3-D model drawings via interfaces, HiCAD 2020 distinguishes between 2-D and 3-D imports.
For this purpose the old function Drawing > New/Open > Open > STEP, IGES, ... has been split into the fol-
lowing 2 new functions:

2-D Import and

3-D Import :
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Insert 3-D foreign formats as parts in current drawing
Data in the 3-D formats:

n STEP (*.stp, *.step)

n STL (*.stl) (the STL file must exist in the ASCII format!)

n IGES (*.igs, *.iges)

n VDAFS (*.vda)

n CATIAV4 and CATIAV5 (*.MDL, *.Model, *.EXp, *.ISO, *.DLV3, *.CATPart, *.CATProduct)

n ACIS (*.SAT)

n Parasolid (*.x_t, *.xmt_txt, *.x_b)

n ProE (*.prt)

n Unigraphics (*.prt)

n SOLIDWORKS (*.sldasm, *.sldprt)

n Inventor (*.ipt, *.iam)

n AutoCAD (*.dxf, *.dwg)

n JT (*.jt)

n PLMXML (*.plmxml)

n IFC (*.ifc, *.ifczip)

could previously only be imported to a new HiCAD drawing with the Drawing > New/Open > Open > 3-D
Import function. If you want to insert data in these formats to the current drawing, now choose the renamed func-
tion Drawing > Insert Parts > Exp. > 3-D Import..

IFC import - Filter option and multiple selection with CTRL or SHIFT key
If the Filter option is active during IFC import, another dialogue will be opened after selecting Open, enabling you to
select/deselect IFC classes. From HiCAD 2020 onwards you can also make multiple selections of classes using the
CTRL or SHIFT key.
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3DPDF - Enhancements

SDK Update to 2.18.1

The SDK (Software Development Kit) for 3DPDF export has been updated to Version 2.18.1.

Taking into account of free edges and sketches

For PDF-Export free edges and free sketches are now taken into account. This behaviour can be specified in the
export parameters.

Furthermore, you can now select or sketches whether all sketches are to be taken into account, or only sketches to
which the purpose Part has been assigned.
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Sheet Metal

Service Pack 2 2020 (V 2502)

New bend zone, with shortening

The new user-friendly Insert bend zone function brings together the previous functions in the Bend zone
function group on the Sheet Metal tab. A major advantage is the insertion of milling edge zones for composite
sheets.

The Insert bend zone function allows you to subsequently join the flanges of a sheet metal part to a bend zone.
The sheets are shortened so that the height or length does not change. The amount of the shortening depends on
the bend radius.

The length of the bend zone can be determined by 2 points. To avoid shortening the connecting sheet you can
choose between clearance and a relief groove.

If the width of the connecting sheet is different, a cut is inserted. The depth of the sheet on which the attachment is
made is retained.

All entries are recorded in the feature log and can be altered there later.

(1) Bend zone with relief groove

(2) Bend zone with clearance

(3) Bend zone with shortened flange, without relief groove
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(1) Original situation

(2) Different flange widths with cut and clearance
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Sheet metal development with die and punch

The bend tools Die and Punch defined in the LVD Bend zone tooling can now be displayed in the devel-
opment bend line text.

The selection is made in the development settings when editing the bend line texts.

Then select the Die and Punch attributes in the text editor.

If an assigned tool exists for the bend zone, the names of these tools can now be inserted in the bend line texts.
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The names are the entries in the BZ column in the corresponding bend tool assignment tables "LVD Die - Table" and
"LVD Punch - Table" from the Catalogue Editor.

Changed dialogue for functions with sketch selection
The dialogues of functions requiring the selection of a sketch,

n Sheet from sketch

n Sheet along sketch

n Flange along sketch

have been slightly modified. The functions Process sketch and New sketch in plane can now be
accessed immediately in the dialogue window.

Design Checker - New check for Sheet Metal parts
The Design Checker has been extended by a new check called Sheet must contain exactly 1 direction symbol.
This allows you to find all sheet metal parts that are not assigned exactly one direction symbol.
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Steel Engineering plates can be coated like Sheet Metal parts
From HiCAD 2020 SP2 on, Steel Engineering plates can be coated like Sheet Metal parts. Therefore the functions

n Visible side

n Delete visible side

n Coating

n Extend coating

can now be found in the Further Functions function group of the Steel Engineering tab.

In the Process function group of the Sheet Metal tab, these functions have been combined in the Coating function.

(1) Steel Engineering plate,

(2) Coating settings
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Sheet development

Add and subtract in context menu for sheet development

The new processing functions for 3-D developments can be activated by right-clicking on the development and
selecting the Process development function .

With the following functions:

n Subtract, via translation

n Subtract, via translation and depth

n Subtract, via rotation

n Add, via translation

n Add, via rotation

you can insert holes, create subtractions, attach sweep bodies and cut parts on the basis of a planar sketch.

If you have selected the New sketch option in the dialogue window, HiCAD automatically activates the Sketch tab.
Use the functions on this tab to create the sketch. For sketch-based functions, you can use the Information menu
functions during creation or processing of the sketch.

Only the closed polylines of a sketch are considered.
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Mark sheet developments with suppressed updates in ICN

With the function Suppress sheet update (right click on a development) you "freeze" the development for
changes. This means that changes to the sheet metal part will not be transferred to the development. In the ICN
these developments are marked with a star symbol.

Automatic dimensioning - Optimised base points

For automatically generated dimensions, such as in sheet developments, from HiCAD 2020 SP1 onwards, the
(unshortened) projection line is only drawn to the nearest point on the object to be dimensioned, i.e. to the next
point on the contour.

The image below shows a Sheet Metal construction with subtractions and the automatically dimensioned devel-
opment of the sheet.

(1) Automatically dimensioned development, older versions

(2) Automatically dimensioned development, from HiCAD 2020 SP1 onwards
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Please note:

If an automatically generated dimension is changed manually, the optimization described above may not be pos-
sible in some cases. This is the case, for example, if you drag the dimension on the right completely to the other
side in the example shown below.
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Development considers definition of outer sheet side

When choosing the Sheet alignment:Automatic option for a sheet development, the definition of the visible

sheet side can now be taken into account. This is done with the new Determine visible side function in the
Process function group.
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Lengthening of milling edges in developments

In order to fold Sheet Metal cassettes with milling edge zones better and more easily, the milling edge zones are
often extended a little at the intersection points. You have the possibility for milling edge zones to extend the bend
line on the Milling+Folding tab of the Extended settings dialogue window. There, activate the Lengthen milling
lines checkbox and enter a value.

Lengthening of bend lines in the development
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New visible side of Sheet Metal part

The new Determine visible side function lets you define the upper side of a Sheet Metal part. This side can
then be taken into account during development or coating. Identify the side using a surface or two edges. Then you
can determine the visible side for further Sheet Metal parts or execute the function with the middle mouse button.

For deleting, the Delete visible side function is available in the pull-down menu.

The visible side is marked with these icons . The other side is marked with X icons .

Sheet Metal parts with visible side

Sheet Metal parts that have been assigned an identifier for the visible side are taken into account for identical part
search. For example, if the model drawing contains two Sheet Metal parts of the same size, one of which has an
identifier for the visible side, the sheets will not be considered to be identical and are assigned different item num-
bers.
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Coat Sheet Metal parts with multiple selection

Sheets that were previously marked with the Determine visible side function can now be taken into

account when coating the sheets with multiple selection .

If you have called the coating dialogue, the Via visible side option is now available. You can then add sev-
eral sheets with a visible side to the list and assign the coating colour (RAL, NCS and System colour or Drawing col-
our) and the coating type Visible side, Back side and Front surface) with Apply.

Right-click on a Sheet Metal part to remove it from the list. If you want to select more sheets, select the icon
for identification.

(1) Select Sheet Metal parts via visible side

(2) Visible side

(3) Back side
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Sheet from solid
The Sheet from solid function has been reworked for convenient generation of Sheet Metal parts. In addition to indi-
vidual selections, multiple selections are now also possible. Here you can select the parts in the model drawing
after calling the function. If you have activated an assembly or several main parts in the ICN before you call the
function, these parts also appear in the list of active parts.

The preview of the new sheet is also displayed. Choose Mode to select the evaluation type for sheet thickness.

Sheet thickness from semi-finished
product

In this mode you select the sheet thickness with semi-finished
product.

Automatic sheet thickness from semi-
finished product

The sheet thickness is automatically selected to match the selec-
ted semi-finished product.

Sheet thickness, from solid The sheet thickness is taken from the solid.

Sheet thickness, value input The sheet thickness is entered directly.

If the initial part contains chamfers, these are transferred to the sheet metal part..
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If deviations from the geometric initial body occur during generation, they are listed after the sheet metal parts have
been generated:
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Favourites in dialogue windows for Design Variants
For the Sheet Metal Design Variants the Favourites management is now also available.

The settings of the various dialogue windows can be saved as favourites and reused at any time. To do this, click on

the symbol at the bottom left of the dialogue window.

The Favourites supplied with the software are only examples and may have to be adapted to your company's spe-
cific needs. You can find more information on Favourites Management in the HiCAD Basics Help.
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Optional standard part insertion
When using the design variant Sheet corner with stiffener it is now possible to choose whether standard parts (riv-
ets, screws etc.) should be installed or not. For this purpose, the checkbox Insert standard parts has been added
to the dialog box. The default setting is that standard parts are created, i.e. the checkbox is active

If the checkbox is not active, the standard parts will not be listed in the BOM.
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No view-defining coordinate system on flanges and bend zones
For Sheet Metal parts, you can use the Properties > Part orientation function in the context menu (right-click) to

define which view is to be the Front view or the Top view for the orientation of derived drawings (work-
shop drawings).

Since workshop drawings cannot be created for sheet flanges and bend zones, the orientation from HiCAD 2020
SP1 onwards always refers to the sheet metal main part.

You can delete orientations of sheet flanges and bend zones that were set in older versions using the Assignment

reset function. For resetting, the Sheet Metal main part must be active. The view orientation of the main part
is displayed for these sheet flanges and bend zones.

Hole patterns on sheet developments
Hole patterns can now also be applied to sheet developments.
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Sheet Metal cassette with milling edge zone
You can now use the Sheet Metal cassette Design Variant to create Sheet Metal cassettes with milling edges zones
and inverted milling edge zones. To do this, simply select the desired Mode on the Attach flange tab of the dia-
logue window.

Sheet Metal cassette with milling edge zone
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Sheet developments

Process sheet developments

Sheet developments can now be edited with assigned sketches. To do this, you can select the new Sketch (sub-

part) function by right-clicking on the development in the menu that appears before processing. After placing
a processing plane, draw a sketch, for example, for a subtraction. The ICN now displays the development with the
sub-part called Sketch. This allows you to activate the sketches you have created in advance when you process the

development, for example, with the 3-D function Subtract, with translation . The processing plane is visible if
it is switched on via Show/Hide elements for the view. If the sketch is generated from the dialogue window of the
processing function, it is also located in the ICN under the development.

With the following functions on the 3-D Standard tab you can now also process developments:

n Subtract, with translation

n Subtract, with rotation

n Add, with translation

n Add, with rotation

(1) Sketch for subtraction

(2) Sketch for addition

(3) Subtraction

(4) Addition
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Developments in the ICN

The development now also appears in the ICN below the Sheet Metal part and can contain sketches as sub-parts. If
the development is active the sheet metal part is greyed out. Activate the development in the drawing or by select-
ing the view.

Show milled area

You use the Show milled area option to mark exclusions that you have defined, e.g., with the 3-D function Subtract

part, via translation . For the triangular SZ-20 panel in Element Installation, too, the material in the "acute
corner" will be excluded (milled away). The milled area will be recognized when creating the development. That is,
facets which are no cover facets, which run parallel to the cover surface, and which have no standard processings
form the milled (i.e. subtracted) area.

To prepare this area for machining, for machine control during DXF output, a layer must be defined for this milled
area.

If you activate this option, the edges of the milled area will be entered in the development. The edges are sorted
and oriented as specified for inner cycles. Milled areas are combined across milling edge zones.

The generation is activated in the development Favourite for Cobus NCAD: Color 10, Continuous line, Layer 10 In
HCADACAD_COBUS.DAT the layer assignment MILLING is defined for the DXF export.
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(1) Exclusion in Sheet Metal panel

(2) Exclusion in development (top view)

(3) Exclusion in development (Isometry)

Moveable bend line text

If you move the mouse over a bend line text during 3-D development, the text will be displayed in magenta. If you
now move the cursor over the text, press and hold down the leftmouse button, you can move the text. If you move
the bend line text along the bend line, the position will now be retained after updating the development.

Export of sheet developments

Optional taking into account of processings for ToPs GEO export

If you choose ToPS GEO, you can determine via the Export forming edges option, whether processings (forming
tools, cross-breaks) are to be considered for export.

Determine polyline orientation for DXF export of Sheet Metal parts

When generating the DXF export files for Sheet Metal blanks, the orientation of the polylines in the created DXF file
will now always be always the same (i.e. always clockwise or always anticlockwise), since CAM programs require
these for determining the outer/inner side when generating the milling tool paths.

The orientation of closed lines can be set when exporting sheet metal developments. In the Configuration Editor at
Sheet Metal > Sheet development you can set a clockwise (activate checkbox) or anticlockwise orientation (deac-
tivate checkbox) for the inner and outer contours.
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Sheet from solid
When generating a sheet from a solid with two countersinks with a conical surface (e.g. DIN74) on 2 sides, the geo-
metry is correctly recognized regardless of the start surface.

Sheet from solid, with 2 countersinks (DIN74) on two sides

The old Sheet from solid function has been replaced with the same-named new function at Sheet Metal > New.
The old function could still be accessed by right-clicking on a bend zone and choosing New > From solid.

ALUCOBOND®SZ-20 tray panels: Lateral connection with additional flange
When using ALUCOBOND® SZ-20 tray panels, there is sometimes the wish to create a connection with a flange at
the side of the panel.

This application cannot be realized directly via the Element installation dialogue window!

To create such a connection, proceed as follows instead:

1. Insert the SZ-20 panel via element installation, but select the setting Without flanges for the left and/or right
connection.

2. Attach the new flange on the open side of the panel (optionally with 35mm side flange or side flange with the
selected tray panel depth).

3. Start the Design Variant Flange for for SZ20 under Sheet Metal in the Civil Engineering functions docking win-
dow.

4. Then select the upper or lower longitudinal edge of the previously bent new flange.
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Example:

(1) Element installation without flanges

(2) Attaching of flange with 35mm side flange, calling of the Design Variant and selection of the highlighted edge

(3) Result

Please make sure to observe the following instructions:

The macro only applies to ALUCOBOND®SZ-20 tray panels where the standard connection is selected for the ver-
tical section.

The side connection is installed without stiffeners.

No automatic connection to the sub-structure is possible, therefore the checkbox Create screws for sub-struc-
tures in the Extended settings of the Element installation should be inactive.

Favourites in Design Variant dialogue windows
The settings on the dialogue window of the Sheet corner with stiffener or puzzle piece Design variant can be

saved as favourites and re-used at any time. To do this, click on the symbol at the bottom left corner of the dia-
logue window. More on favourites management can be found in the Manage Favourites topic of the HiCAD Basics
Help chapter.

Improved info bar texts
The user guidance texts in the info bar at the bottom left have been improved for the functions Cut off corner and
Create base sheet for an easier operation.
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Quick Access for directory selection
As with the dialogue for loading and saving of files, selected directories can now also be added to the Quick Access
folder, e.g., for DXF export of Sheet Metal parts.

ABWPOL.DAT settings moved to Configuration Editor
The settings of the ABWPOL.DAT file have been moved to the Configuration Editor (ISDConfigEditor.exe).

You now find the settings for the neutral axis for approximative sheet development at Sheet Metal > Default
setting.

Processing direction
New arrow sizes have been added to the Direction arrows table (in the catalogue Factory standards > Symbols >

Arrows. They are available when you choose the Processing direction function. (3-D Standard > Standard

Processing > Bore > Processing direction).

Discontinuation of old base sheet macro
From HiCAD 2021 onwards, the calling of the old Sheet Metal base sheet macro 'abwgrundblech.mac' will no
longer be supported.
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Steel Engineering

Service Pack 2 2020 (V 2502)

Railings

- Posts from double profiles

When creating railings, double profiles can also be selected from catalogue Factory standards > Railing > Railing
profiles > ISD Examples - Double profiles from SP2 onwards.
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Connections

Cross-bracing between two perpendicular beam (2602)

With the Design Variant 2602 it is also possible from SP2 onwards to connect two perpendicular beams to each
other with a diagonal using a cross-bracing.
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Cross-bracing Besista with cross anchor (2603)

The Design Variant 2603 has been extended by the insertion type With cross anchor. It is now possible to connect
two, three or four beams/plates with a tension rod system consisting of tension rod and rod anchor and a Besista
cross anchor. The cross-bracing can also be attached to plates that already exist on the beams.
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Stabilizing pipe connection (2702)

The new Stabilizing pipe connection (2702) Design Variant creates a stabilizing pipe connection of the type
BESISTA between 2 beams or plates. You can choose between the following options:

n Tension rod system (Besista)

n Pressure rod system, Solid rod
consisting of 1 Besista solid round steel rod with conical ends, 2 Besista rod anchors, 2 Besista studs and
retaining rings. The round steel rod and the rod anchors are welded together.

n Pressure rod system, Steel pipe
consisting of a steel pipe, 2 Besista rod anchors, 2 Besista studs and retaining rings. The steel pipe and the rod
anchors are welded together.

(1) Tension rod system, (2) Pressure rod system: Solid rod(3) Pressure rod system: Steel pipe, with sectional view
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When connecting beams, the stabilizing pipe connection normally already provides the gusset plates. However,
you also have the option of attaching the stabilizing pipe to plates that already exist on the beam.

Please note that when fixing to plates, the plates must lie in one plane.
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Macro-based connections
The macro-based connections for gusset plates and base plates have been removed from the Civil Engineering
functions docking window and are no longer available in SP2. To insert them from the Part type catalogue, use the
Civil Engineering, general entry in the tree structure.
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Steel Engineering plates - Visible side and coating
The functions

Coating

Extend coating

Visible side

Remove visible side

can now also be used for Steel Engineering plates. As of SP2 you can find these functions in the Steel Engineering
Ribbon at Steel Engineering > Further functions.
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Sketch selection in the Laminated glass dialogue window

The Process sketch and New sketch in plane buttons are now available directly in the Laminated glass

dialogue window, and no longer in a pull-down menu.
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Divide along direction

The new function Divide along direction at Steel Engineering > lengthen > Divide allows you to divide any
3-D part of the type Solid into several parts along a freely selectable direction. Various division options are available,
for example the individual parts can have different lengths. In addition, this function creates a corresponding fea-
ture so that the division can be edited later.

This function can also be found at 3-D Standard > Process > Trim.

More convenient creation of sketch-based series beams and profiles
When creating your own sketch-based series beams/profiles, it is now possible to conveniently prepare the beam-
s/profiles using the functions Assign attributes and Series cross-section, Save as catalogue part and save them to
the catalogue.
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Service Pack 1 2020 (V 2501)

Connections

Favourites management

For all connections based on design variants and when creating stairs and railings, the settings of the respective dia-

logue window can be saved as favourites and reused at any time. To do this, click on the symbol at the bot-
tom left of the dialogue window to activate the context menu. For more information on Favourites management,
read the Manage Favorites topic ofm the HiCAD Basics Help.

Strap joint (2310)

In the dialogue window of the Strap joint (2310) a new tab for Weld seams is now available.

Cross-bracing (2603)

This new design variant connects two, three or four beams or plates with a cross-bracing of the type "Besista with
Circular disc". Here the beams/plates are connected to a circular disc by a Besista tension rod system consisting of
rod and anchor. The cross-bracing can also be attached to plates that are already present on the beams.
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BOM templates for Steel Engineering
From HiCAD 2020 SP1 onwards, the BOM templates for Steel Engineering:

n hicad_stahlbau_01

n hicad_stahlbau_02

n hicad_stahlbau_03

n hicad_stahlbau_04

are no longer available. They have been replaced by a new template, hicad_stahlbau, in the HiCAD configuration.
This applies in particular to the usage-dependent setting in the Configuration Editor at Automatic drawing deriv-
ation > Production drawing > Usage-dependent > ... > View group > File name: BOM.

For update installations everything remains unchanged.

Please note:

Derived drawings of earlier HiCAD versions in which these BOM templates are used will not be changed.

Others

Steel Engineering BOMs - handling of structure assemblies

Steel Engineering BOMs now allow you to define in the Excel template (HiCAD_Stahlbau.2501.0.xlsx) how BOM-rel-
evant structure assemblies should be handled in the shipping list. For this purpose the row Ignore structure assem-
blies is available on the sheet Settings.. (see also Report Manager - What's New?)

Changed default settings for Notches

For the settings defined in the Configuration Editor at Steel Engineering > Notch the default value for distance from
the web has been changed to 0. The previous default value was 10.
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Major Release 2020 (V 2500)

Indication of beam orientation
If the parameter Indicate orientation of active Steel Engineering beam is set to Switch on/off with F6 key in the
Configuration Editor at System settings > Visualization , the display can alternatively be switched on/off via the
Coordinate systems toolbar (at the bottom of the dialogue window) by clicking on the

Show beam orientation or drawing alignment of the active 3-D part [on/off] symbol.

Connections

Strap joint (2310)

The previous Strap joint (1310) connection has had a redesign and has been replaced with the new Strap joint
(2310).
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(1) With stiffener; (2) Without stiffener; (3) With notch
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Cross-bracing (2602)

For the Cross-bracing (2602) with turnbuckle, different rounding radii for the front (1) and rear corners (2) of the
connection plates can now be specified on the Connecting point tab.

What's new? 231 / 362

News Overview



Galvanisation

For all connections with a Galvanisation tab in the dialogue window, the graphic for the 1st/2nd beam with the pro-
cessing type Holes has been changed. The distance "X" here is the distance to the web, the distance Y is the dis-
tance to the flange.

This change concerns the following connections:

n Base plate + Anchor plate (2101)

n End plate (2102)

n Purlin joint, 2 plates with mitre cut (2201)

n Beam to web with 2 plates and stiffener (1211)

n Column connection, Frame corner (2203)

n Column connection, Frame corner (2204)

n Front plate connection to web/flange (2320)

n Front plate connection to flange (2330)

232 / 362 What's new?

Steel Engineering



Weld seam insertion

n For all connections that support weld seam insertion, the edges are now visualized according to the settings on
the Weld seams tab. This allows a better assessment of the weld seam positions.

n From HiCAD 2020 onwards, you can specify the weld seam width for HV and HY seams in all connections that
support weld seam insertion. For continuous weld seams, enter the value 0.

Usage of assemblies

Many connections create assemblies, or add further parts to already existing assemblies. For example, for Con-
nection 1211 (Beam to web with 2 plates and stiffeners) the front plate and the corresponding weld seams of the
first connecting plate will be assigned to the assembly of the first beam to be connected. The 2nd plate and the
stiffener including the associated weld seams for the second connecting plate will be assigned to the assembly of
the beam to which the connection is made.

A usage can be assigned to these assemblies in the dialogue window of the connection. If one of these assemblies
was already assigned a usage type, the usage type specified in the dialogue window was ignored in previous ver-
sions. From HiCAD 2020 onwards, the Overwrite usage checkbox can be used to specify whether the existing
usage is to be kept or replaced by the usage type selected on the Bolting tab (or Fixing or Beam tab, depending on
the connection).
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This functional enhancement concerns the following connections:

n Base plate + Anchor plate (2101)

n End plate (2102)

n Purlin joint (2201)

n Stiffener (2401)

n Beam to web with 2 plates + stiffener (1211)

n Front plate connection to web/flange (2320)

n Front plate connection to flange (2330)

n Front plate connection (double-sided) to web (2322)

n Column connection, Frame corner (2204)

n Column connection, Frame corner (2203)

n Angle connection, one-sided (1305)

n Angle connection, double-sided (1306)

n Cross-bracing (2601)

n Cross-bracing (2602)

n Stabilizing pipe connection (2701)
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DAST connections

n If a DAST connection is changed, HiCAD checks whether the connection is still DAST-compliant. If this is not

the case, the DAST selection field will be marked with the symbol from HiCAD 2020 onwards. If you
point to this symbol with the cursor, a corresponding message is displayed, e.g.:

n For DAST connections, in addition to fillet welds, the other weld seam types (double fillet weld, HY and HV weld,
circumferential weld) can also be selected. If one of these weld seam types is selected, the connection is no

longer DAST-compliant. In this case, the DAST selection field will be marked with the symbol, e.g.:

Stairs and Railings

Railing Configurator

The Post - Sub-structure tab has been revised, now featuring an optimised alignment of the fields, improved
explanatory graphics, etc.

Variant Editor for Railings

From HiCAD 2020 onwards, the HiCAD Dialogue Editor (HiCAD GUI Creator) can be used to create user-specific
dialogues for railing variants - analogous to installation elements. The Variant Editor function for railings has there-
fore been adapted accordingly.

If a parameterized part is active, this function can be used to create a corresponding variant with a list of the vari-
ables used as a CSV file. This file is required for creating user dialogues with the HiCAD Dialogue Editor, which can
be started directly from the dialogue of the function.
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Variables for catalogue entries assigned to a railing component and not defined as list variables are now auto-
matically converted to list variables when the variant is saved. The text object CatalogEntry is then automatically
used for these variables when inserting them into a user dialogue.

Semi-finished products as sub-items for series beams
Semi-finished products can be automatically transferred to HELiOS as a structural sub-item of an individual part.
This is set in the Configuration Editor (ISDConfigEditor), at PDM > HiCAD- HELiOS interface > Semi- finished
product article as sub-item.

From HiCAD 2020 on, series beams are also taken into account.
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Steel Engineering - Management + BIM

Service Pack 2 2020 (V 2502)

Total quantity of a part in an assembly (COMPONENT_REFASSEMBLY)
In the Configuration Editor, at PDM > Management+BIM, you can define whether the associated assemblies, e.g.
welded assemblies, are to be determined for individual parts (beams, profiles, plates, sheets, general parts). The
parameter Output associated assemblies is available for this purpose.

If this parameter is set to Yes, the system determines the associated assembly as well as how often the part occurs
in this assembly. This data is assigned to the HELiOS article attribute COMPONENT_REFASSEMLY. This can be use-
ful for the BOM output, for example. The ISD default setting is No.

How exactly the attribute is assigned can be defined using the template file BIM_PDM_ReferenceAssembly.ftd.

This file is copied into the HiCAD sys directory during the installation of HiCAD for Management+BIM - provided
that the parameter configuration is suitable!

In this file, the attribute COMPONENT_REFASSEMBLY is preset as follows:

(1) The superordinate assembly is searched for.

(2) HELiOS article attribute COMPONENT_ITEMNR_TEXT

This attribute is determined by the template file BIM_PDM_ItemnumberGeneration.ftd.

(3) Space and (

(4) HiCAD part attribute Qty. in assembly (%13)

(5) x and )

For example, if the assembly with item number 1 contains the part with item number 102 three times, the value of
the COMPONENT_REFASSEMBLY attribute is

1 (3x)

If a part exists in several assemblies, the attributes are separated by semicolons, e.g.

1 (3x); 3 (1x); 6 (4x)

This display can also be customized. To do this, you can open the file BIM_PDM_ReferenceAssembly.ftd, for
example, with the Annotation Editor, change it as desired, and then save it again under the same name.
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If you also want to display the associated assembly and total quantity of a part in the title block of the single part
drawings, use the _ SZNATTRRIQ attribute in the title block of the drawing frames. For this purpose, enter
@*@65,S._SZNATTRRIQ@*@ as placeholder text in the title block (with a maximum text length of 65 characters).
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Output construction section lists in drawing
If you work with different construction sections, this function allows you to insert a construction section list into the
drawings of the individual parts. This construction section list shows how often a part is present in the different con-

struction sections. For this purpose the new function Output construction section lists in drawing is avail-
able at Management + BIM > Workshop > Drawing.The function can be used in the 3-D model as well as in the
detail drawings.

To use the function, the following requirements must be met:

n In the Configuration Editor at PDM > Management + BIM, the parameter Output associated assembly(-ies)
must be set to Yes.

n The model drawing must be divided into construction sections.

n The itemisation must be carried out in the overall model, i.e. the Itemisation checkbox must be active in the
document master of the model drawing.
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n The construction sections must be saved as externally referenced detail drawings. For each construction sec-
tion in the article and document master the attribute Construction section must be assigned and the checkbox
Itemisation must be deactivated.

n The production drawings must be created in the overall model.

Once the production drawings have been created, a construction section list can be generated using the Output
construction section list in drawing function.

n If you have called the function in the complete model, then first select the construction sections in which the
part is to be searched for and the desired individual parts.

n If you have called the function in the detail drawing, then select the construction sections.

When updating the drawings, the list will be deleted again!

240 / 362 What's new?

Steel Engineering - Management + BIM



In this context, please also note the information on the _SZNATTRRIQ attribute. The use of this attribute
in the title block of the drawing frames causes the system to display the assembly assignment and total
number of a part in the title block of the detail drawings.

Management of template drawings
Starting with SP2, template drawings for Element installation can also be managed with BIM.

If a BIM-managed model drawing installation contains elements that have a corresponding template file assigned
to them, the corresponding template drawings are automatically created and managed in HELiOS when the draw-
ing is derived. The document type of these drawings is Template drawing. Like other drawings, template drawings
can be automatically updated, checked and released when changes are made. Furthermore, the same links are
used as for production drawings.
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Rework of template/profiles installation drawings via script
When saving drawings created with the functions of the Management + BIM module, a custom script can be
executed to automatically rework the drawings. From SP2 on, this is also possible for template and profile install-
ation drawings. For this purpose, the settings in Configuration Editor at PDM > Management + BIM > Production
drawings > Rework of drawing have been extended.

The correcponding script files are

n UpdatePl.cs (Profile installation) and

n UpdateTD.cs (Template drawings).
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Service Pack 1 2020 (V 2501)

Type of part referencing
In the Configuration Editor at PDM > Management+BIM, the Type of part referencing parameter does no longer
exist. This means that the parts of the automatically generated drawing are referenced unilaterally with the initial

model drawing and are marked accordingly in the ICN with the symbol. If changes are made to the model, the
drawing can be updated automatically. This does, however, not apply vice versa.

Script for rework of model drawings
Similar to the manufacturing documents created with the Management+BIM module, a script for rework can now
be automatically executed when saving model drawings controlled with Management+BIM. For this purpose, the
Rework of drawing selection box in the Configuration Editor at PDM > Management+BIM > Production drawings
has been expanded.

"Others" are all HiCAD model drawings that do not comply with other classifications, such as 3-D models, files cre-
ated with the Reference part, Save, Detail drawing function etc.
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Drawing number generation
If you have selected the generation of n-digit drawing numbers in Configuration Editor at PDM > Management+BIM
> Production drawings, you can use the parameter Drawing number generation from HiCAD 2020 SP1 onwards
to specify how the numbering is to take place:

n By production sections (consecutively within one production section),

n By projects (consecutively within one project), or

n Project-comprehensive (spanning several projects).

Select None to deactivate numbering completely.

The default setting is By projects.

Output associated assemblies
In the Configuration Editor at PDM > Management+BIM, you can now define whether the associated assemblies,
e.g. welded assemblies, should be determined for individual parts (beams, profiles, plates, sheets and general
parts). The parameter Output associated assemblies is available for this purpose. If this parameter is set to Yes,
the association is determined and assigned to the HELiOS article attribute COMPONENT_REFASSEBMLY. This can
be useful for the BOM output, for example.

The default setting is No.

The COMPONENT_REFASSEMBLY attribute is assigned the item number of the first parent assembly of the part. If
a part exists in several assemblies, the item numbers of the parts are separated by semicolons.
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AutoCreate General Production Documents
In practice, it often happens that overview drawings of a model drawing are created manually in a separate sheet
area. These drawings contain, for example, sectional views, cut-outs, shortened views, detail views, etc., and are
intended to illustrate how the model is realized. These sheet areas are not taken into account when creating
external production documents.

Drawing by Metallbau Wilhelmer Projekt GmbH, Kolbnitz, Austria
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In order to be able to manage these documents together with the corresponding model in HELiOS, HiCAD offers the
possibility to automatically create a PDF, DXF and/or DWG file of the respectively active model or sheet area dir-
ectly when saving a model drawing.

Whether and which formats are generated is determined via the Configuration Editor at PDM > Management + BIM
> External production documents, where you will find the required parameters.

User defined objects (UTO)
The user-defined object type (UTO) Location UTO is no longer used by HiCAD in drawing derivations. This means
that when the database is configured with the HicadBIMConfig.exe tool, the attributes belonging to this object type
are no longer transferred.

Customer-specific and usage-dependent title blocks
In the Configuration Editor, you can now use the settings at PDM > Management + BIM > Production drawings >
Title blocks to specify that customer-specific and/or usage-dependent title blocks are to be used in production
drawings.
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HiCAD's scope of delivery includes corresponding title block templates and the corresponding drawing frames.
These templates and frames can be found in the HiCAD subdirectory templates\Module_ 3DSteel\BIM\szen-
en\BIM:

Drawing frame Title block templates for detail drawings Used for

ST_DINA0.FGA ST_TB_DEFAULT_ASSEMBLY.FGA Assembly

ST_DINA1.FGA ST_ TB_ DEFAULT_
BOLTEDASSEMBLY.FGA

Mounting assembly

ST_DINA2.FGA ST_TB_DEFAULT_GRATING.FGA Grating

ST_DINA3.FGA ST_TB_DEFAULT_MAINASSEMBLY.FGA Main assembly

ST_ DINA3_
KANTBLECHE.FGA

ST_TB_DEFAULT_PANE.FGA Glass

ST_DINA4H.FGA ST_TB_DEFAULT_PLATE.FGA Steel Engineering plate

ST_DINA4H_BLECHE.FGA ST_TB_DEFAULT_PROFILE.FGA Beam, Profile

ST_DINA4H_PROFILE.FGA ST_TB_DEFAULT_PURCHASEDPART.FGA Purchased part

ST_DINA4Q.FGA ST_TB_DEFAULT_SHEET.FGA Sheet Metal part

ST_ TB_ DEFAULT_
WELDEDASSEMBLY.FGA

Welded assembly

ST_TB_DEFAULT.FGA Others

Based on these templates, you can create additional title blocks, for example for certain types of parts. In this way,
you can use different title blocks for different profile types, for example.
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Major Release 2020 (V 2500)

Neuer Maskeneditor in HELiOS 2020

Due to the complete revision of the Mask Editor in HELiOS 2020, the previous mask format has been changed
from .MSK to .XML. In addition, mask files are now managed outside the installation directory, resulting in
some changes in the system architecture that Administrators must consider:

n The masks of older versions (before V 2500.0) that were previously stored in the SYS directory of the install-
ation are automatically converted to the new XML format in case of an update installation and stored at
%Programdata%.

n The new masks at %Programdata% should not be overwritten under any circumstances, as these rep-
resent the "delivery status", which will be updated by later update installations. If masks are edited and
changed with the Mask Editor, you must store and call them at %Appdata%.

Before updating to HiCAD / HELiOS 2020, it is important that you read the Installation Notes !

Withdraw releases
The release of drawings, e.g. in case of a premature release, can now also be revoked by the administrator. To do
this, two new functions have been added to the Release function menu.

Withdraw release of active assembly(-ies), with sub-parts

This function can be used to undo already released drawings of the active part-/assembly including
all sub-parts. Multiple selection is also possible.

Only the administrator can withdraw releases. HELiOS therefore displays the HELiOS Login dialogue
window. After the administrator has logged in, the release is executed. The HELiOS Login dialogue
window is then displayed again. Then log in again with your user data.

Withdraw release of active assembly(-ies), without sub-parts

As with the previous function, this function can be used to withdraw already released drawings of
the active part-/assembly. However, the drawings of sub-parts are not considered here. Multiple
selection is also possible here.
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Delete unused Sheet areas
The detail drawings created with the Management+BIM module are always stored on Sheet 2 of the drawing. When
printing via the HELiOS/HiCAD Spooler, all sheets are printed - depending on the setting - i.e. also sheet areas
without production drawings such as Sheet 1.

By setting the Delete unused sheet areas parameter to Yes you can now specify that sheet areas without pro-
duction drawings are deleted. The default setting is No.
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Automatic export of CAM and drawing data to the Windows file system
When creating/updating external CAM data in the formats DSTV-NC, DXF, DWG, NCW/NCX and STEP and drawing
data in the formats DXF, DWG and PDF, the corresponding files can also be automatically exported to the Windows
file system if required. The Configuration Editor provides the appropriate parameters for this purpose at PDM > Man-
agement+BIM > External production documents:

External part data

Automatic CAM
data export

If this parameter is set to Yes, the CAM data are automatically exported from HELiOS to
the Windows file system to the folder specified at Windows export path when cre-
ating/updating the CAM data.

Depending on the file type, the files are stored in a separate sub-folder, e.g:

The files are automatically named according to the configuration file BIM_PDM_CAMEx-
port.ftd (in the HiCAD sys directory). Default setting is the part attribute Item number.

The default setting for automatic CAM data export is No.

Windows export
path

Here you specify the path for automatic CAM data export.

Drawing data export

Automatic drawing
data export

If this parameter is set to Yes, the drawing data are automatically exported from HELiOS
to the Windows file system to the folder specified at Windows export path when cre-
ating/updating the drawing data.

Depending on the file type, the files are stored in a separate sub-folder, e.g:

The files are automatically named according to the configuration file BIM_PDM_
WSDExport.ftd (im HiCAD sys-Verzeichnis). The default setting for the designation is:

Article master attribute COMPONENT_DRAWINGNUMBERTEXT- Part attribute Item
number.

The default setting for automatic drawing data export is No.

Windows export
path

Here you specify the path for automatic drawing data export.

Important: The files imported to the Windows file system will not be managed in HELiOS.
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Working across projects
By default, Management+BIM works project-related, i.e. the managed parts are usually clearly assigned to one pro-
ject. When installing parts with reuse in other projects, such as purchased parts, you must assign the article master
manually, as these parts are ignored by the BIM automatisms.

As of HiCAD 2020, this behaviour can be changed in the Configuration Editor at PDM > Management+BIM by set-
ting the Main and sub-projects parameter to Yes.

This enables a working across several projects. This means that when you work with main and sub-projects, the art-
icle masters of the main project are retained when you switch to a sub-project and vice versa. This also applies
when you copy parts from a sub-project to the main project via the clipboard and vice versa.

The following prerequisites must be met for working across projects:

n The Main and sub-projects parameter must be set to Yes.

n The project masks must contain the Boolean attribute ROOTPROJECT. To do this, you must extend the masks
manually using the HELiOS Mask Editor.

n The ROOTPROJECT attribute must be set to Yes for the main project and to No for the sub-projects.

For an example, see the Working with Main and Sub-projects topic.

Please note that working across projects is only possible within the 1st level beneath the main pro-
ject!
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Metal Engineering

Service Pack 2 2020 (V 2502)

Sketch selection in the Laminated glass dialogue window

The Process sketch and New sketch in plane buttons are now available directly in the Lam-
inated glass dialogue window, and no longer in a pull-down menu.
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Revised Foil function
The function Foil, available in the Civil Engineering functions docking window at Civil Engineering, general > Civil
Engineering - Sectional view (3-D) > Foil, has been revised. It is now possible to select or create a sketch directly
from the dialogue. Foils can be taken as semi-finished products from the catalogue and the effects of the individual
settings are visualized as a real-time preview directly in the model drawing.
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Service Pack 1 2020 (V 2501)

Connections - Favourites management
For all connections based on design variants, the settings of the respective dialog window can be saved as favorites

and reused at any time. To do this, click on the symbol at the bottom left of the dialogue window to activate
the context menu. For more information on Favourites management, read the Manage Favorites topic ofm the
HiCAD Basics Help.
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Element Installation

Service Pack 2 2020 (V 2502)

Open template drawing
The new function Open template drawing is now available for working with template drawings. After you have cre-
ated drawings for an element installation using the Template drawing function, you can first select any element in
the model drawing and then call the Open template drawing function. This will open the drawing belonging to the
selected part.

Changed dialogue for sketch selection

Dialogues requiring the selection of a sketch have been slightly changed. The functions Process sketch and

New sketch in plane can now be activated directly in the dialogue.
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ALUCOBOND® SZ 20 tray panels - Window connection
When installing ALUCOBOND SZ-20 tray panels with window connection, the "L-bracket" was previously part of the
panel. From SP2 onwards, it is only created by the connection with the sub-structure. It is designed as a "short
piece" on each sub-structure and is not continuous.

Top: Part structure of the tray panel before HiCAD 2020 SP2, Bottom: Part structure as of HiCAD 2020 SP2
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Design Variant - Flange for SZ20
When using ALUCOBOND SZ-20 tray panels, there is sometimes the desire to create a connection with a flange for
the lateral connection, so that a "U" is created. This cannot be realized directly via the Element installation dialogue
window, but via the Design Variant Flange for SZ20 in the Civil Engineering functions docking window, beneath
Sheet Metal. Until now, this variant could only be applied to SZ-20 tray panels with the setting Vertical section:
Standard. As of SP2, it is now possible for all connection types, e.g. for Attic, short.

(1) Element installation: Attic, short, without flanges; (2) Attaching of flange and calling of design variant with selection of the

marked edge; (3) Result
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Transfer parameterisation
New in the Civil Engineering functions docking window at Element installation is the function Transfer para-
meterization. With this function, the parameters of an installation element can be transferred to other installation
elements. However, this is only possible if the installation elements are based on the same variant. This means, for
example, that the parameters of an ALUCOBOND SZ-20 tray panel cannot be transferred to a suspended
ALUCOBOND panel.

When you call the function the following dialogue window is displayed:

First select the installation element whose parameters are to be transferred. Click on the icon to change the
selection.

Then select the installation element to which the parameters are to be transferred. Multiple selection is also pos-
sible.

Click on OK or Apply to transfer the parameters. When using Apply, the dialogue window remains open.
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Service Pack 1 2020 (V 2501)

Template drawings
If you have applied changes to elements in an element installation, such as additional bores or subtractions, it may
be necessary to create individual drawings of these elements for the production department. For large element
installations, many elements can be affected, which would require a lot of time to create and adapt the individual
drawings.

This is where the new Template drawings function can help. It is now possible to create drawing templates
for the different sub-types of self-generated variants and then automatically generate drawings for the individual ele-
ments of an element installation.

Here you have the choice under Part selection whether you want to create drawings for all elements of the active
element installation or only for certain parts.

To use this function, it is first necessary to create and configure the templates to be used. For a description of the
necessary steps, please refer to the Setting Up Template Drawings topic. There is also an Example available.
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ALUCOBOND® SZ-20 panels and sub-structures

Window connection with base profile and additional sheet

SZ-20 panels can now obtain a window connection with a base profile and additional sheet at the base point. The
length of the additional sheet can be chosen freely.
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Length of S- and Z-profiles

The length of S- and Z-profiles (suspension profiles) can now be influenced by specifying a clearance between pro-
file and sheet.
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Attics - Stiffener outside

For attic connections, it is now possible to lengthen the Stiffener outside to the attic and rivet it to the flanges. To
do this, select the setting Stiffener of attic: Side stiffener.

(1) Stiffener, lengthened up to the attic; (2) Stiffeners on attic = Corner sheet
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Attic connections with and without lug

Attic connections can be created with or without lug. For this purpose the tab Extensions for SZ-20 standard has
been extended accordingly.

(1) With lug; (2) Without lug

Window connection without side flanges

As with attic connections, it is now also possible to insert the window connection without flanges.
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Configurable rivet distances on attic stiffeners

When installing an SZ-20 attic with reinforcement bracket, the rivet distance can now be configured in the sub-struc-
ture settings.

(1) Rivet distance: 20mm, (2) Rivet distance: 25mm
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ALUCOBOND® riveted - Individual edge distances
For riveted ALUCOBOND® panels, the top, bottom, left and right edge distance can now be specified on the Exten-
ded settings tab.
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ALUCOBOND® suspended - Window connection without side flanges
As with attic connections, it is now possible to insert the window connection without flanges when using the sus-
pended ALUCOBOND® panels.

Window connection with (1) and without ohne (2) side flange
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Optional insertion of standard parts
In the element installation it is now possible to choose whether standard parts (rivets, bolts etc.) should be installed
or not. For this purpose the Create standard parts checkbox has been added to the corresponding dialogue win-
dows. The default setting is that standard parts are created, i.e. the checkbox is active.

If the checkbox is inactive, the standard parts are not listed in the bill of materials.
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Leg position for GIP L-profiles
When creating a sub-structure consisting of GIP L-profiles, it is now possible to choose whether the legs of the pro-
files should be on the left or right:

Front view: (1) Leg on the left; (2) Leg on the right
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HILTI profiles for ALUCOBOND facades
The HILTI profiles MFT-L, MFT-T and MFT-H SZ-20 are now available for the sub-structure of ALUCOBOND riveted
and ALUCOBOND SZ-20 facades. Using the Connection function, the element installation and the sub-structure
can be connected to each other, creating the necessary processing and fastenings.

ALUCOBOND SZ-20 facade on a HIILTI MFT-H SZ-20 sub-structure

ALUCOBOND suspended facade on a HILTI MFT-L-sub-structure
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CS 20 Window end profile
In the Catalogue Editor at Series > Roof wall facade > Special profiles > Systea > CS 20 you can now find the CS
20 Window end profile.
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Major Release 2020 (V 2500)

Element installation - Create new
The Create new button which was previously available in the Element installations dialog when editing element
installations has been removed from the dialog window. This special function is now available in the context menu
of the Element installation feature.

Before you start please read the notes in the Edit Element Installation topic.
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Working with selection groups
When installing elements - especially for complex facades - it is often the case in practice that certain installation
elements have the same options. To make it easier to select the areas to be occupied (rectangular or polygonal
sketch areas) and to edit installation elements with the same parameters, HiCAD offers the possibility to work with
so-called selection groups. The advantage is that you can group installation elements with the same parameters
and then select or deselect all elements of this group with one click. The Selection groups area is available in the
Installation elements dialogue window.

In the image above, 3 selection groups have been defined - one for the red areas, one for the green areas and one
for the yellow areas.

Detailed information on working with selection groups can be found here.

Selection groups can also be applied to Sub-structures.
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ALUCOBOND® panels - General

Bend zone end suitable for milling

As with the ALUCOBOND SZ-20 tray panels, bend zone ends suitable for milling are now also created for the other
ALUCOBOND panels - according the Sheet Metal function Trim corner.

Example of a bonded ALUCOBOND tray panel with development - (1) HiCAD 2019, (2) HiCAD 2020
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ALUCOBOND® panels - Processing direction and symbol

For all ALUCOBOND panels you can now select the symbol for the processing direction, determine its position, and
its distance to the outer edges of the panels. The Extended settings tab has been expanded accordingly for this pur-
pose.
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Attic connection without last flange

With all ALUCOBOND panels, the parapet connection can also be installed without the last flange. To do this,
simply enter the value 0 in the field Length of folded sheet.

SZ-20 with attic connection - Left: with last flange; Right: without last flange
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All bend edges as milling edges

From HiCAD 2020 onwards, the bend edges of all ALUCOBOND panels are implemented as milling edges.

Example of a suspended ALUCOBOND panel - (1) HiCAD 2020, (2) before HiCAD 2020

Mitre cut with milling edge

For all ALUCOBOND panels you can now specify that the mitre cut in the sheet development is displayed with a
milling edge. To do this, the checkbox Mitre cut with milling edge has been added to the Extended Settings tab.
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ALUCOBOND® panels, suspended

Window connection without flanges

From HiCAD 2020 onwards, it is possible for suspended ALUCOBOND panels to create the window connection
even without a rear flange. To do this, simply enter the value 0 in the Length of folded sheet field.

Window connection with flange (left) and without flange (right)
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Sub-structure - Rivet distances on attic reinforcing bracket

When creating an ALUCOBOND sub-structure of the the type suspended, with reinforcing bracket on the attic, the
Rivet distance for mounting the reinforcing bracket to the sub-structure can now be adjusted.

Left: Rivet distance 40mm (default value); Right: Rivet distance 15 mm
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ALUCOBOND® SZ-20 tray panels

Installation on triangular areas

In the case of ALUCOBOND SZ 20 tray panels laid on a triangular area, the material is removed in the acute corner.
In order to prepare this area for machine processing, the corresponding location in the DXF file must be defined as
a layer.

HiCAD 2020 automatically recognizes this area for subtraction during sheet metal development by searching for all
facets that are not cover facets, are parallel to the cover surface and are not standard machining surfaces. These
facets form the area for subtraction. The edges surrounding the area are entered in the development The edges are
sorted and oriented as specified for internal cycles.

The display parameters for the subtraction area in the development can be defined in the parameters for Sheet
Metal development at Milling edges.

Optional insertion of bolts for the sub-structure

The insertion of the screws for the sub-structure is now optional. For this purpose, a corresponding checkbox has
been added to the Extended Settings tab.

Lateral connection with additional flange

When using ALUCOBOND SDZ 20 tray panels, there is sometimes the desire to create a connection with a flange
there as well when connecting from the side, thus creating a "U".
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This use case cannot be realized directly via the Element installation dialogue window!

n To create such a connection, proceed as follows instead:

n Construct the SZ-20 panels using the Element installation function. However, select the setting Without flanges
for the left and/or right connection.

n Attach the new flange on the open side of the panel (optionally with 35 mm lateral flange or lateral flange with
the selected panel depth).

n In the Civil Engineering functions docking window at Sheet Metal, choose the Design Variant Flange for SZ-
20.

n Then select the upper or lower longitudinal edge of the previously attached new flange

Example:

(1) Element installation without flanges, (2) Attaching of the flanges with 35mm lateral flange, (3) Calling the Design Variant

and selection of the marked edge, (4) Result

Please observe the following rules:

n The macro is only valid for ALUCOBOND SZ-20 panels where the standard connection is selected for the ver-
tical section.

n The side connection is installed without a stiffener.

n No automatic connection to the sub-structure is possible, therefore the checkbox Create screws for sub-struc-
tures on the Extended settings tab of the Element installation dialogue window should be inactive.
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Save variants for Element installation /Sub-structure
For the saving of variants for element installations and sub-structures, you will find the following functions in the
Civil Engineering functions docking window at Element installation:

Save variant for element installation

Save variant for sub-structure

This function automatically creates the corresponding catalogue entries and the CSV files with the variables used in
a variant. These CSV files are required if you want to individually design the dialogue windows for installing cus-
tomer-specific variants using the HiCAD Dialogue Editor (HiCAD GUI Creator). The Editor can be started auto-
matically after saving a variant.
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User-specific dialogue windows
n Variables for catalogue entries assigned to a relocation element and not defined as list variables are now auto-

matically converted to list variables when the variant is saved. The text object CatalogEntry is then auto-
matically used for these variables when they are inserted into a user dialogue.

n If you have subsequently changed the user dialogue of an already installed variant, the dialogue of this variant
can be updated accordingly. To do this, right-click the Element installation or Sub-structure feature in the fea-
ture log of the corresponding element installation or sub-structure. The context menu provides the function
Renew dialogues. Use this function to update the user dialogue displayed when editing the feature.

Reset wall brackets and sub-structures
If you have made manual changes to a sub-structure or to wall brackets (for example, by drilling holes in a sub-struc-
ture or by moving or deleting individual wall brackets), these changes are retained even if these parts are recal-
culated.

However, if you want to discard the changes you have made manually and restore the sub-structure or the wall
brackets to their original state, you can now use the appropriate functions:

n For Sub-structures you will find the menu item Create new in the context menu of the Sub-structure feature
entry . This function deletes all existing parts of a substructure and then inserts them again. This has the advant-
age that variants that have been changed in the catalogue in the meantime are then also used in the current ver-
sion in the drawing. However, during this step, further editing and dimensioning of the parts of the sub-structure
is lost.

n For Wall brackets, the Restore function is available in the context menu of the Wall bracket entry in the feature
log. This retains the installed parts and only moves them back to the correct position if necessary. Deleted wall
brackets are also created again.
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Profile Installation

Service Pack 2 2020 (V 2502)

New view option: Contour, combined
The Profile installation tab now offers the new Contour, combined mode in addition to the previous view modes.
This mode is a combination of the modes Contour, cut and Contour, uncut. Cut contours are represented by con-
tinuous lines, uncut contours by dashed lines.
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Selecting and creating sketches in the "Profile installation" dialogue
The Process sketch and New sketch in plane functions of the Profile installation dialogue window can now no
longer be found in a context menu, but are displayed directly in the dialogue window:
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Roof inclinations: Definition via inclination angle
When creating roof inclinations, it is now possible to specify the inclination angle as well as the inclination in % and
the height difference. The other values are then calculated automatically.
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Service Pack 1 2020 (V 2501)

Creation of inclined roof sections
When creating a profile installation on roof surfaces, it is now possible to conveniently define the inclinations of the
individual roof sections in the Profile installation dialogue window, thus creating a continuous profile installation on
a single sketch instead of having to create several inclined sketches.

Top: Drawing consisting of several three-dimensional sketches for planning a flat roof with inclined sections before HiCAD

2020 SP1. Bottom: Sketch for the same project, with HiCAD 2020 SP1.
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For this purpose, the new Define inclined roof sections function is available, with which, as with the Define trans-
verse joint edges function , edges of a sketch can be defined as inclined roof sections. The sections can then be
selected from the Roof inclination tab of the Profile installation dialogue window and applying slopes to them.

What's new? 287 / 362

News Overview



Usage for edge profiles
When installing edge profiles you can now define a Usage for those edge profiles in the Profile installation dialogue
window.

Attributes for the installed width of the room closing profiles
The installed width of room closing profiles is now written to the DWF_COVER_WIDTH attribute. This can then be
output in workshop drawings or BOMs, for example.
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Major Release 2020 (V 2500)

Edge profiles from multiple sketches
Self-created Edge profiles may now consist of several sketches, similar to Surface profiles. In this case, they must
be placed in a dummy part. During installation, the individual sketches are then turned into separate parts.

Freely selectable fitting point for surface profiles
By default, the first surface profile is created flush with the start point. In some cases, however, it may be neces-
sary to cut away part of the first profile and only install part of the profile. An example of this would be tongue and
groove systems on sandwich profiles.

Therefore it is now possible to select a Fitting point for profile installations where the first profile will be cut off.

Deactivate preview
In the Profile Installation dialogue window, you can now control the generation of the preview. On the one hand,
you now have the option of switching between exact and simplified profiles for the preview as well. On the other
hand, you can now deactivate the automatic generation of a preview and only display a preview on demand.
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Plant Engineering

Service Pack 2 2020 (V 2502)

Classify pipeline article
If you select the creation of an article master when generating isometrics or piping plans, the article master in
HELiOS is assigned the new classification Pipeline as of HiCAD 2020 SP2. However, this only applies to articles
that you generate as of HiCAD 2020 SP2.

For the classification Pipeline, a corresponding input mask and the new HELiOS attribute PIPE_CLASS_NAME for
the pipe class name are available in HELiOS.

To use the new mask and the new attribute you must first update HELiOS using the tool DbplantDataImport.exe
and then restart HiCAD.
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Automatic transfer of the pipeline attributes

The attributes of a pipeline can also be automatically transferred from HiCAD to HELiOS when saving. To do this,
proceed as follows:

1. On the HELiOS PDM Ribbon tab at Others > Link > ..., select the function Article master sync when sav-

ing . Specify the assignments shown there.

(1) Attribute, (2) Target attribute, (3) Creation scheme
End the function with OK.

2. Since the assignments only become effective after a restart, close HiCAD.

3. In the Configuration Editor at System settings > HELiOS, activate the Transfer part attributes to HELiOS
checkbox.

4. The next time you start HiCAD, the settings you made previously will apply.

Please note:
If you want to subsequently assign the classification Pipeline to existing articles, you must change this

manually. To do this, click on the Classification symbol in the dialogue window for the respective art-
icle and then activate the Pipeline checkbox at Plant engineering in the Classification dialogue window.
You can then assign/change the attributes Nominal diameter, Weight and Pipe class name.
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Move pipe parts

At Plant Engineering > Part Tools > Copy > ... you can find the new Move pipe parts function.

This function works similar to copying of parts. The difference is that here straight pipes are not moved and the
parts to be moved must form a straight string. In addition, after moving parts, an attempt is made here to fill the gap
with straight pipes.

Before you call the function, you must first select the parts to be moved. This can be done either manually or with
the Select part chain function. The selection of the parts to be moved may contain straight pipes, but they are not
moved with them.

After calling the function, HiCAD prompts you to select a so-called handle for moving the part. This is the point over
which the move is placed in the drawing. The allowed attachment points are highlighted in colour in the drawing.

If you have selected the handle, all parts lying on a dashed line running through this point will be attached to the
cursor. Then, determine the target point of the move. If necessary, a dynamic route change is automatically carried
out at the target point to make room for the moved parts.

An example:

Let's take a look at the drawing shown below. The two valves are to be moved to the upper pipeline.

Select the desired part chain. Alternatively one could also select the two valves manually, which, however, would
take more mouse clicks.
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The possible handles of the part are highlighted. Select a handle and specify the target point for the displacement.

Result:
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Combined BOM / length list
When generating bills of materials, the lengths of similar straight pipes can be combined. The Combine pipe length
lists in BOMs checkbox is available in the Configuration Editor at Plant Engineering > Bills of materials.

If the checkbox is active, similar pipes are combined to a single pipe when generating bills of materials. The length
of this pipe is equal to the sum of the individual pipe lengths. By default, the checkbox is inactive.

The following figure shows a construction with three pipelines - one main pipe (red) and two secondary pipes
(green).
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The BOM has been created for this model drawing - with and without a summary of the pipe lengths.

BOM without summary of pipe lengths

BOM with summary of pipe lengths
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Please note:

n Except for the length and weight of the pipe, the remaining pipe attributes of a single pipe in the summary are
used. These are usually the attributes of the first pipe (in the part structure) of the combination.

n Pipes are combined according to their structure in the structure list. This may differ from the pipeline structure,
for example, if pipelines are not marked as BOM-relevant.

Calculate weight of pipeline
Weights of pipe parts of a pipeline are summed up from SP2 and transferred to the corresponding pipeline. For the
calculation of the weights, pipelines are treated in the same way as assemblies. This means in particular

n Only weights of parts that are BOM-relevant are totalled.

n The weight of a pipe part is multiplied by the entry in field Qty. per part. An empty field is equivalent to the value
0.

n The pipeline must also be BOM-relevant for the weight to be entered.

n The weight of accessory sets is not taken into account.

When the weight calculation of assemblies and thus also of pipelines is performed can be changed in the Con-
figuration Editor under Modelling > Part properties > Weight calculation. The ISD default setting is Only when
itemising.
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The attribute mask for pipelines has also been extended by the Weight fixed checkbox. If this is active, the entered
weight is not overwritten during a weight calculation. The checkbox is inactive by default.

298 / 362 What's new?

Plant Engineering



Dynamic route change

Create straight sections

Previously, it was only possible to change the lengths of existing pipes with the dynamic route change. In many
cases, however, it is desirable to be able to create additional straight sections by changing the route. This is pos-
sible from HiCAD 2502 on. For this purpose the dialogue of the function has been extended by the checkbox Create
straight sections.

A typical use case is the increase of the distance between two parts, such as the illustrated elbow and the flange.
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At this point you can reach your target as follows:

Simply pull the elbow away from the flange. A piece of straight pipe appears between the elbow and the flange.
Please note that it is important to know on which side of a connection the cursor is located when selecting the con-
nection.

We select the connection at the elbow once more. Note the different results depending on which side the con-
nection is selected from.
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Elbow side

Pipe side

If you pull the elbow again, the previously created straight pipe will be extended. If, on the other hand, you drag the
straight pipe, a new straight section is created between the straight pipe and the elbow.

In general, dragging on a connection causes a new straight section to be created. Unless a straight pipe follows
which may be changed in its length. Then its length is increased until its maximum length is reached. From then on
a new straight section is created. If you had fixed the length of this straight pipe, the behaviour would be the same
as that of a straight pipe whose maximum length has been reached, i.e:
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If you push a connection, no new straight sections are created there. However, a new straight section can be cre-
ated at another location if the target position would otherwise not be reachable, which was forced by the length-
fixed section in the following:

The newly created straight pipe is created as a modified copy of an already existing straight pipe. The existing
straight pipes within the same pipeline are used to determine the straight pipe to be copied. If one is found that
matches the connection conditions, a length-adjusted copy of this pipe is installed. If such a pipe is not found, a
leading edge pull section is inserted instead. In the following example a straight pipe with a nominal diameter of 50
is required, but after the reduction only pipes with a nominal diameter of 32 follow:
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Limitations:

n Straight sections can only be generated at welded connections. Plugged, screwed, socket-welded and
flanged connections are not supported. Mitred welds and component connections are also not supported.
The former can be found on segment bends, the latter on inserted pipes.

n Straight sections are created within a pipeline, not at the transition to components.

n A newly created straight section is only assigned a straight pipe if a suitable cylindrical pipe exists within
the same part chain without further processing, which is then used as a copy template. Pipes with mitre
cuts and inserted tubes are not valid copy templates.
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Select target point

Until now, there were two methods of target point selection in the route change:

n Plant Engineering point selection
Automatic recognition of the connecting points and adoption of the connection direction for directional adjust-
ments

n Standard point selection
Common HiCAD point selection with all available point options - but without automatic recognition of the con-
nection directions.

From SP2 on, there is only one point selection, which basically corresponds to the usual HiCAD point selection.
However, points named here will also be checked to see if they are Plant Engineering connection points. For such
points, the connection direction is still determined and the option Snap own points in the dialogue window of the
route change is effective.

Another new feature is that the target point can always be selected with the left mouse button.

Select fixed point

The pre-selection of fixed points in the route change has been revised. It now depends on the side of the con-
nection where the cursor is located when selecting the point to be moved.

A common application of the route change is to move the end of a pipeline without directly grabbing the end point.
Until now, in such a case the free ends of the pipeline were provided with fixed points, which had to be removed
manually:

From SP2 on, no more fixed points are set at those free ends of the pipeline that follow on the side of the cursor.

Case 1: Selection of the start point on the pipe side.

A fixed point is displayed.
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Case 2: Selection of the start point on the sheet side

No fixed point is displayed (if there is a connected component at the end of the pipeline, a fixed point is of route cre-
ated there).

Minimum pressure of pipe parts
Since HiCAD 2020 SP1, the pressure range has been a search criterion for all component types (except weld seam
gaps). In this context, the HELiOS attributes and masks for the classification of components in Plant Engineering
have now been adapted in such a way that a pressure range can be defined.

n The previous attribute DRUCK (Pressure) describes the maximum nominal pressure.

n The DRUCK_MIN (Min. pressure) attribute for the minimum pressure is new.
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Service Pack 1 2020 (V 2501)

Part Tools

Modified Ribbons and Pull-down menus

The Part Tools function group now contains two new functions:

Copy pipe parts and

Select part chain .

In this context the functions

n Rotate part,

n Move part and

n Invert fastener or bolted flange connection

have been moved to the PullDown menu of the Copy parts function,; also the former Move+Rotate part func-
tion has been renamed to Move part.

306 / 362 What's new?

Plant Engineering



Select part chain

The new Select part chain function allows you to select complete part chains. To do this, you first select
two pipe parts which serve as start and/or end points of the part chain. HiCAD then selects all parts which are loc-
ated on a connection between the start and end of the chain.

A preview is displayed while selecting a chain. Start and end of the chain are displayed magenta (Special colour:
Marking 1) and the additional parts of the chain are displayed blue (Special colour: Marking 3).
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Copy parts

With the new Copy parts function you can copy a selection of pipe parts into a pipeline. Parts from several
pipelines can be copied into a single target pipeline. Source and target pipeline can also be identical.

Before you call the function, you must select the parts to be copied - either in the ICN or in the model drawing. The
part to be copied will then either be the active part or the active part list. You can also use the Select part chain

function to select the parts.

The copying of parts is done in several steps:

1. Select handle
First you define the handle, i.e. the point via which the copy will be placed in the model drawing. You can select
all free connecting points of the part list.

2. Select target point
Here the position is selected where the parts to be copied are to be insterted. A preview of the parts to be
copied is displayed at the current cursor position. Three different types of target points are possible.

l Copy onto a connection point

l Copy onto a guideline

l Copy onto a free point

After determining the target point, it may be necessary to perform a dynamic route change - for example, if a
connection between two parts has been selected. HiCAD attempts to determine the target of the route change
itself.

3. Select target pipeline
From the selection in the second step, it is not always clear to which pipeline the parts are to be copied (e.g.
when connecting to a component or copying between two pipelines). In this case the target pipeline must be
selected.
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In the example below, the highlighted blue parts (1) have been copied into the yellow pipeline.

(1) Part selection, (2) Selected connecting point, (3) Target point determination, (4) Result

What's new? 309 / 362

News Overview



Plant Engineering Settings

Part search

Previously, a pressure range was only used as a search criterion when searching for seals. As of HiCAD 2020 SP1,
the Pressure range is a search criterion for all part types (except for weld seam gaps). On the Part search tab in the
Plant Engineering Settings dialogue window the checkbox Use Pressure as search criterion for flange con-
nections has therefore been renamed to When inserting on connection, use Pressure as search criterion.

If a part is to be connected to another part, then - if this option has been set and a value for the Pressure attribute
has been assigned to the other part - this pressure is used as search criterion when searching for the part to be con-
nected.
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Isometry and Pipe plan

Multiple selection when starting the isometry

If you have selected several pipe parts or pipelines in the model drawing, then the isometry can also be started from
HiCAD 2020 SP1 via the Multiple selection context menu. To do this, right-click after your multiple selection and
choose Isometry - From current part selection in the context menu.

In the Plant Engineering Isometry dialogue window, the checkboxes of all pipelines belonging to the selection will
then be active or all pipelines to which the parts of the multiple selection belong.
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Parts

Insert loose flange as regular flange

Loose flanges can be inserted as regular flanges from SP1 onwards. The loose flange is pushed down from the
straight pipe by a fixed excess length. This value can be set in the Configuration Editor at Plant Engineering > Lay-
out plan > Insert loose flange as with excess length.

If you enter a value of 0 or a negative value, loose flanges will be installed as usual. If a positive value is entered,
then each loose flange is installed like a regular flange.

In particular, when connecting to a straight pipe, it is not necessary to connect with the first point as usual for loose
flanges, but with the second point.

The default setting is 0.
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Insert placeholder

As of HiCAD 2020 SP1 it is possible to insert placeholder valves in a pipeline. The new function

Insert placeholder

has been made available for this purpose.

is available for this purpose.

In this way, useful valves can be inserted in the planning process even if the actual valve has not yet been determ-
ined or is not yet available. The placeholders ensure that meaningful BOMs and isometries can also be created in
the planning phase.

The insertion of a placeholder valve is identical to the insertion of a regular Valve. The only difference is that the part
is not selected via HELiOS or the HiCAD catalogue. Instead, a dialogue window is displayed in which various nom-
inal diameters can be selected under Sub-types.
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After calling the function, the nominal diameter that best matches the nominal diameter of the selected pipeline is
automatically selected here.

For each nominal diameter, the values for the length and height of the valve are preset in the Parameters area.
These values can be adjusted individually.

Placeholder valves automatically receive the article number Placeholder valve and the corresponding names.

To make it clear in BOMs which valves are only placeholders, the BOM attribute Placeholder part is available for
Plant Engineering BOMs. If this attribute has the value 1, then the part is a placeholder.
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In the example shown below, the Quantity List in the Report Manager has been extended by the column Place-
holder part.
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In the isometry, placeholder valves are shown as red dashed lines and have a designation tag with the text Place-
holder.
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The designation tag can be customized in the isometric settings on the Text objects tab if desired.
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Directly insert classified .KRA files

When components are installed, KRA files that are classified as components in HELiOS can now also be installed
directly.

An example:

The displayed component is to be classified as a component of type Vessel. For this purpose, an article master is
first assigned and then - before leaving the dialogue window - the button Classification is clicked.

.
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After selecting the component type, the vessel data can be specified.
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If the entry Vessel is now selected when installing a component, the KRA file saved above is available.
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Pipeline Tools

Calculate transition: Improved dialogue

The dialogue of the Calculate transition function has been improved:

n Additional information about the selected elbows is now displayed: Nominal diameter, Outer diameter and Wall
thickness. Furthermore, the Designation field has been enlarged.

n If the part search fails, a corresponding message is displayed. The part search uses as search parameters val-
ues from the selected connections, namely those that you have defined for Elbows on the Part search tab of
the Plant Engineering Settings dialogue window. The pipe class is also taken into account. If no suitable part is
found, a corresponding message is displayed:
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Major Release 2020 (V 2500)

Restructured Ribbon and context menus

n The AutoRoute guideline and AutoPlace parts function can now be found in the pull-down menu of the

AutoPlace parts on guidelines function.

n The Set Plant Engineering ID function has been moved to the pull-down menu of the Plant Engineering
Settings.

n The previous functions for the editing of pipelines have been divided into 2 groups:

l Functions that change the structure of pipelines can be found at Plant Engineering > Pipeline Tools >
Change > ... .

l Functions that change the properties of pipelines can be found at Plant Engineering > Pipeline Tools >
Assign >....

n The functions of the Check menu can now be found in the pull-down menu of the Collision check function at
Plant Engineering > Pipeline Tools > Coll.. >....

322 / 362 What's new?

Plant Engineering



Pipelines

Activate pipeline

As of HiCAD 2020, the active pipeline is determined via the active part. This means: If the active part belongs to a
pipeline, then this pipeline is considered the active pipeline. Otherwise, no pipeline is active. The previous functions
for activating pipelines are therefore no longer available from HiCAD 2020 onwards.

Change pipeline route

Previously, only Plant Engineering connecting points were permitted as start points for route changes. As of HiCAD
2020, any points can be selected, i.e. also points that were determined via point options.
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n In the Plant Engineering point selection mode, the route change behaves as before.

n In the Standard point selection mode, you can select any point as the start point. In order to be able to clearly
define the sections of the pipeline to be changed, the route change must nevertheless refer to a Plant Engin-
eering connecting point. Therefore, HiCAD automatically suggests a Plant Engineering connecting near the
selected point after the selection of the start point. This is indicated by with a MMB note.

l If you want to use the suggested point, just click the middle mouse button.

l Otherwise, simply select another Plant Engineering connecting point with a left-click.

During the route change, an auxiliary line is drawn between the selected start point and the Plant Engineering
connecting point. This auxiliary line is displayed in red (Special colour X-axis) if the starting point cannot reach
the target point.
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Settings

Set Local CS

The setting of a local coordinate system has been simplified in HiCAD 2020. The selection of the direction of the
coordinate system no longer takes place when starting the function, but can be set, after a right-click, via the
respective context menu. In addition, HiCAD now displays a preview of the coordinate system.

Left: Up to HiCAD 2019 Right: As of HiCAD 2020

Preview and context menus
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Guidelines

Pipeline selection for automatic placing of parts

The selection of the active pipeline for the automatic placing of parts on guidelines has been revised. New here is
the Active part option. Here the pipeline to be assigned is determined via the active part. If the active part is a
guideline, parts will be placed only on this guideline. Otherwise the parts will be placed on the superordinate
pipeline. If the active part has no superordinate pipeline, the dialogue behaves as with the Place parts on pipeline
option.

In addition, the automatic part placing also supports multiple selections from HiCAD 2020 onwards. If several parts
are selected, of which at least one is a sub-part of a pipeline, the options are greyed out and the elements to be
assigned are determined via the multiple selection. Analogous to the selection via the active part, parts will be
placed on individual guidelines. For each other selected part, parts will be placed on the respective superordinate
pipeline.
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Mitre cuts during automatic placing of parts

If you select neither elbows nor knees, but straight pipes, mitre cuts will be applied to the straight pipes:
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Parts - New automatisms for parts
From HiCAD 2020 onwards, two new functions for part automatisms are available in the pull-down menu of the
Change function (Plant Engineering > Pipeline Tools > Change > ...):

Calculate transitions and

Edit arcs

Calculate transitions

Until now, HiCAD did not provide a simple way to calculate and place arcs for offset transitions. The problem here
consists in connecting two pipelines using suitably cut bends, as in the following example:
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From HiCAD 2020 onwards, this problem can be solved with the new Calculate transition function:
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Edit arcs for bent pipes

With this Editor you can modify arcs in Plant Engineering. You can change arcs for bent pipes, insert segment arcs
and perform mitre cuts. The Editor requires a working with guidelines and can also modify unoccupied guideline
edges.

Three modes are supported:

Transition by bending

Transition by segments

Transition by mitre cut

Delete counter-flanges

When deleting valves, counter-flanges in the same pipeline are now also deleted.
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P+ID

Service Pack 1 2020 (V 2501)

Take over P+ID symbol code change to 3-D layout plan
From HiCAD 2020 SP1 onwards, symbol code changes in the P+ID are taken over to the assigned 3-D layout plan.

If the Edit symbol function in P+ID is used to change the Code of a symbol, the change is visible when switch-

ing to the Assigned 3-D layout plan if the Part information of the corresponding 3-D part is displayed

Changes made with the Edit symbol function are transferred to the 3-D layout plan.
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Choose the Part information function (click with the right mouse button on the part) to display the changed Code in the 3-D lay-

out plan in Plant Engineering.

332 / 362 What's new?

P+ID



Major Release 2020 (V 2500)

Indicated connecting direction when creating own symbols
Setting new connections is now supported by graphic plug-ins. After selecting a specific connection direction, an
arrow is generated in the corresponding direction which can only be placed at grid points. Connections that have
already been placed are highlighted with an arrow. This new feature is available with the P+ID Symbol Editor as well
as when editing a P+ID.

Note in the image above that the cursor does not coincide with the start point of the arrow because the arrow
"jumps" to grid points.
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Support of nominal diameters in millimetres and inches
From now on there are two different nominal diameter attributes in the P+ID, one in millimetres and one in inches.
The two attributes are linked to each other according to the assignment list in the file ANINCHTABLEW.DAT
(HiCAD EXE directory / SYSTEM). By default, the nominal diameter attribute in inches has been added to the
delivered libraries. In older libraries it should be added. Simply open a library, add an additional inch attribute to all
symbols with a nominal diameter attribute and save the library. An addition of the nominal diameter attribute in
inches is also done in older projects. In this case it is also sufficient to open and save the project. An addition to the
line:

4310       82       0       Nominal diameter (inch)

(tabulator characters between blocks) in the FLDLGCODE.dat files in the ISDAttDef folders is necessary if the cor-
responding files provided by the ISD are not used. An addition to the nominal diameter attribute in inches is also
used in older projects. Here too, it is sufficient to open and save the project. Depending on the size of the project,
this process can take a few minutes.

Before creating a new project, all libraries should be updated.

When entering a value into one of the two Edit boxes for the nominal diameter of a symbol, an automatic conversion
takes place in the nominal diameter for the unprocessed Edit box, provided the entry is in the above mentioned
assignment list. When you right-click on an Edit box for a nominal diameter attribute a selection list according to the
assignment list will be displayed.

When a specific entry is selected, the corresponding entry in inches is automatically entered in the provided Edit
box .
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For symbols with several nominal diameters, a corresponding automatic conversion will be made, too.
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Viewer

Major Relase 2020 (V 2500)

Visibility of textures
The settings of the HiCAD functions

Settings for shaded representation, Active view und

Settings for shaded representation, All views

for the representation of textures (at Views > Representation > Shaded > Shaded representation) will now be
considered for the representation of textures. This means that whether and in which view the textures will be shown
in the Viewer will depend on the above settings.
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Notes on HELiOS Updates

Major Release 2020 (V 2500)

Important Notes on Updates for Administrators
For updates to HELiOS 2020 (Version 2500 or higher) a central update of the supplied HELiOS database is required.

Since conflict may occur during the update process in case of inconsistent data stocks, you should do the fol-
lowing:

n Data backup before updating

Make sure that a data backup was made before carrying out the update of your HELiOS database.
For the backup, either use the HELiOS Database Creator (further information can be found in the Installation
Notes) or your SQL Server Application.
In case of any questions, or if you need any help with regard to your customized system architecture , contact
the ISD Hotline.

n Log file for update

If any conflicts occur during the update, these will be recorded in the log file HeliosDbUpdate.txt (in the system
path %appdata%\ISD Software und Systeme\HeliosDbUpdate\).
Have this file ready when contacting the ISD Hotline in case of an unsuccessful update, so that they can help
you solve the problem and make a successful update.

n New mask format

Please read all notes with regard to the new mask format in HELiOS 2020 !

n MultiCAD interfaces

If you are working with an Inventor or SOLIDWORKS interface and HELiOS, please note that before installing an
update of an older version to HELiOS 2020 (Version 2500) or higher, some adjustments may have to be made
before the update.
In this case, please contact the Consulting department of the ISD Group.
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HELiOS Desktop

Service Pack 2 2020 (V 2502)

Enhanced Mask Editor
The new Mask Editor introduced with HELiOS 2020 has been further revised and enhanced with new features.

The Transfer formatting function allows you to transfer the formatting of a specific element to a selection of
other mask elements.

The also new Exchange function can be used to change the attribute stored in a data field via a selection dia-
logue.

The range of functions for opening, closing and saving mask files has also been extended, including a display of
last used files.
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If new user-defined object types have been created in the Attribute Editor, you will be asked to create new mask
files for them after calling or restarting the Mask Editor. Confirm the query with YES to execute the automatic pro-
cess.
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Intelligent "Delete" behaviour of objects
If HELiOS objects (Articles, Documents, Projects, Folders, ...) cannot be deleted - e.g. because the user does not
have the right to delete them, or the corresponding edited objects are reserved for export, or are built into the
product structure and/or model structure - then these objects are displayed in a corresponding result list after the
deletion process, which shows the reason why the deletion process cannot be carried out for each object.

The deletion processes are executed in an optimal sequence, i.e. taking into account any existing references in the
model or product structure.

Please note:

Under Error, only the first error that HELiOS encountered during the deletion process is displayed. That is, there
may be other reasons why the object cannot be deleted immediately after the error has been corrected.

Furthermore, even if the Workspace is closed, you will be informed if objects to be deleted are currently in the Work-
space.
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Settings for the Workspace
On the General tab of the HELiOS Options you can now find the new Settings for the Workspace area.

As with the known setting options in the area of MultiCAD interfaces you can also change the local session dir-
ectory for the Workspace of the HELiOS Desktop, if desired.

You can also specify whether documents that are not currently being edited, or whether locally changed documents
are to be removed from the work area when the program is closed.
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Marking "empty" archive documents when loading, viewing and exporting
When sending print or conversion jobs via KST, which subsequently update an existing document master in HELiOS,
the corresponding document in HELiOS can be marked as "obsolete".

A common example of this is the updating of neutral formats via the spooler. Another example is customer-specific
adaptations that automatically generate archive documents upon release. Here it can happen that these archive
documents are displayed as "empty" due to errors, outdated document statuses or a release or conversion by the
HELiOS Spooler still running in the system.

Such documents are appropriately indicated when the HELiOS document master data function is called:

Also when exporting such documents, as well as when calling actions such as Create notes document, Create
mark-up or Open with ( ...) you will receive a corresponding warning message:

After the document is updated by the Spooler, the corresponding identifier will be removed again.
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Major Release 2020 (V 2500)

New mask format and central mask configuration

In HELiOS 2020, the previous mask format has been changed from .msk to .xml, in addition to the revision
of the Mask Editor.

In addition, mask files are now managed outside the installation directory, resulting in some changes in the system
architecture that administrators should urgently consider:

The masks of older versions that were previously stored in the \sys\ directory of the installation are automatically
converted to the new XML format by an update installation of an older HELiOS version to HELiOS 2020 (V 2500) or
higher and stored at%Programdata%.

At %Programdata%, the masks are stored in a version-specific path, i.e. for HELiOS 2020 this path could look like
this: "C:\ProgramData\ISD Software und Systeme\HELiOS 2020\GUI\Masks". In a later version, the version identifier
in the path will be correspondingly higher.

This conversion or directory is not dependent on whether the local or central directory was selected for the interface
configuration (see below).
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The old configuration file can then be found in a Backup directory that was created below the installation folder.

The new masks at %Programdata% should not be overwritten in any case, because these are the "delivery status",
which may be updated by later update installations. If masks are edited and changed with the mask editor, they are
stored at %Appdata% and are called up by HELiOS when working in corresponding masks from this directory.

This means: If masks are to be distributed uniformly to different workstations, they must be saved under
%Appdata% and not (!) under %Programdata%.

The optional query for UI configuration during a new, update or change installation has also been extended to dis-
tinguish between a local and a central directory (across computers). This means that you can also store the inter-
face configuration for several work centers in a central directory instead of having to "distribute" it to the individual
local directories.

If you select the option Use central directory for configuration data in the new or update installation, you must
select a Directory, e.g. network drive, via Windows Explorer instead of the localConfiguration file in .zip format

after clicking on the symbol in the selection dialogue.
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Please also note the following:

n A Change installation of HELiOS or HiCAD with HELIOS offers the possibility to change to a central con-
figuration directory later. However, the subsequent selection of a local configuration file is not provided at this
point. If you want to change the local configuration afterwards, you should use the tool HELiOSCon-
figImport.exe.

n Settings files that are provided by the administrator in a central directory must be selectively copied to this dir-
ectory. Due to the dependency on files, the directory structure provided by HELiOS must be observed. This
must correspond to the structure under %APPDATA%\ISD Software und Systeme\HELiOS 2020. If you have
any further questions, please contact the Consulting department of the ISD Group.

n If the set configuration directory is not accessible at runtime, HELiOS behaves as if the directory is empty. This
means that the program starts without updating the UI configuration.

n When updating HELiOS for an older HiCAD version, the option to set the configuration directory is missing. This
can only be adjusted via the registry. If you have any further questions, please contact the Consulting depart-
ment of the ISD Group.

If problems occur during the conversion to the new mask format in the course of an update installation, the mask
converter MskToXmlUpdate can be used.
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New Mask Editor
With HELiOS 2020 (version 2500) you will find a new Mask Editor on the Admin Tools tab of the HELiOS Desktop,
which has been adapted to the latest state of the art with a modern Look & Feel and thus offers some innovations
and advantages compared to the previous version.

In addition to a modern Ribbon design, which also supports operation at high resolutions, this has laid the found-
ation for further expansion of the masks and the Editor in 2020.

The revision of the Mask Editor has also led to a conversion of the mask format to XML. Mask files are now man-
aged outside the installation directory.

Start search with F3
To avoid having to switch between keyboard (entering the search criteria) and mouse (initiating the search) when
searching for a specific object in the HELiOS Database (Document, Article, Project, Folder, ...), you can also use
the F3 key to perform the search.

You must therefore click on Find with the mouse in the corresponding, active search mask, but you can also
execute the search using the keyboard with F3 for manually entered criteria.
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ReleaseNext: Distinguishing between all objects and Admin objects
In the Admin tool ReleaseNext for unlocking HELiOS objects that are being edited by other instances, you can now
distinguish between two options:

n Show all locked objects: In the corresponding object tab (Articles, Documents, Projects or Folders), all entries
that were locked in HELiOS are listed (user-independent).

n Show only my locked objects: Only the objects that were locked by the logged on Administrator are listed.
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HELiOS in HiCAD

Major Release 2020 (V 2500)

Open, with options: Reduced loading

In the context menu and in the detail window ribbon of a HELiOS document, you will find the new function
Open, with options at General, in addition to the familiar functions Open + Edit and Open, read-only.
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If the document is an HiCAD drawing file (SZA format), an extended dialogue with additional options for reduced
loading appears. This means that you can optionally select how to proceed when loading with isolated points:

You can leave the Open, reduced option Switched off at this point or Delete all isolated points or Delete isolated
points except for:

n named points

n symbol / fitting points

n fitting points

You can also activate the Open, read-only checkbox in this dialogue if the document should only be loaded for
viewing and not for editing.

Please note:

n The Open, with options function does not work for multiple selections, but only for single SZA documents.

n If the document opened with options is not an SZA file but, for example, an Office document, it is opened
without another intermediate dialogue.

n If the file type of a document is not known or cannot be assigned to an application for opening, a Windows
query may appear asking in which application the document should be opened.

What's new? 349 / 362

News Overview



HELiOS Spooler

Service Pack 2 2020 (V 2502)

Print Client: Bundling of jobs by document number
The option to bundle jobs in the PrintPlot menu part of the HELiOS Print Client has been extended:

In addition to the default setting where print jobs are not processed in bundles (Bundle: Off), you can now choose
between Bundle: All jobs and Bundle: By document no.

If the Bundle: By document no. option is active, documents (e.g. SZA files with several sheet areas each) can be
converted into separate PDF documents, where a PDF document contains a separate sheet for each HELiOS sheet
area.
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HELiOS Options: Include model area
In the HELiOS Options for printing documents you find the new sub-menu item Include model area under Print all
views.

This option is relevant if you work with a CAD system (such as HiCAD or AutoCAD) that makes a distinction between
model and drawing area.

If the option is not activated, all sheet areas of the drawing are transferred when the print jobs are transferred to the
Report Manager. If this option is activated, the model area is also transferred.
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AutoCAD plot area definition
When printing files from AutoCAD, the user can also select the plot area.

With Service Pack 2 (Version 2502) the configuration options of MultiCAD formats of the HELiOS Spooler have
been extended in such a way that the AutoCAD plot area, which distinguishes between model and layout, can be
taken into account accordingly when printing AutoCAD files.
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Installation
When installing the HELiOS Spooler, please note that the database connection specification, which was optional in
earlier versions or only required for certain interfaces, will be mandatory starting with HELiOS 2020 Service Pack 2
(Version 2502).
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Service Pack 1 2020 (V 2501)

Extension of the installation
When working with MultiCAD interfaces please note the following extension to the installation: By setting up the
database connection at this point, an even more stable operation of the HELiOS-MultiCAD coupling is guaranteed.
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Major Release 2020 (V 2500)

Notes on Update installations/ New postprocessing
The Spooler will be extended in such a way that the following information for bundled PDF export will be available
for postprocessing:

<MultiSheetCurIdx> (%HEL_MULTISHEETCURIDX%) - Current sheet index for multiple sheets within one job (if
applicable, otherwise always 0).
<MultiSheetEndIdx> (%HEL_MULTISHEETENDIDX%) - Last sheet index for multiple sheets within one job (if
applicable, otherwise always 0).
<MultiSheetOutputName> (%HEL_MULTISHEETOUTPUTNAME%) - Output file name without file extension;
for multi-sheet printouts identical with <FileName>, but without attached sheet index.

In case of an update installation, you have to copy some system files to the right places, which will not be over-
written by it.

These are the files

n ISD FilePrinter? PS.BatchPDF.bat (executes the postprocessing) 

n ISD FilePrinter? PS.BatchPDF.PostProcess (contains the calling of the postprocessing)

which you have to transfer from the installation directory of the Spooler (by default: C:\Program Files\ISD Software
und Systeme\HELiOS Spooler\Defaults\FilePrintPostprocess\) to the target directory

C:\ProgramData\ISD Software und Systeme\HELiOS Spooler 2019 SP2\FilePrintPostprocess\.

A new installation of the HELiOS Spooler in Version 2500 (HELiOS 2002) is not affected by this.
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"Change" option for MultiCAD settings
Not only can you configure the database and Vault Server connection for a CAD application (HiCAD, AutoCAD,
Inventor, SOLIDWORKS) linked to HELiOS during a new or update installation of the HELiOS Spooler, but also via a
Change installation.
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HELiOS MS Office Interface

Service Pack 2 2020 (V 2502)

Add attachments to E-mails
When you write, forward or reply to an E-mail in Outlook, the HELiOS Ribbon of the E-mail window also provides the

Attach document function for attaching files via the HELiOS document search.

Please note:

If you are currently using Office 2010, the HELiOS interface will only work in separately opened E-mail windows, but
not when the E-mail is docked in Outlook.
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HELiOS options with automatic login
With the update to HELiOS 2020 Service Pack 2, an Options dialogue is available in the Office interface, as is
already known from the HELiOS-MultiCAD interfaces.

In addition to settings for the Workspace and for the import of attribute mappings, you can activate the option Auto-
matic HELiOS login when starting the Office application under Settings for document to prevent the HELiOS
login dialogue from preceding each start of an Office application.
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Service Pack 1 2020 (V 2501)

Transfer of forwarded E-mails as separate documents
When transferring forwarded E-mails to HELiOS, you can decide whether the forwarded E-mail should be transferred
as a new HELiOS document (e.g. because the content has changed) or whether the original e-mail already stored in
the HELiOS database is sufficient and the transfer of the forwarded E-mail is therefore not necessary.
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Legal notes

© 2020 ISD ® Software und Systeme GmbH. All rights reserved.

This User Guide and the software described herein are provided in conjunction with a license and may only be used or copied in accordance with the
terms of the license. The contents of this User Guide solely serve the purpose of information; it may be modified without prior notice and may not be
regarded as binding for the ISD Software und Systeme GmbH. The ISD Software und Systeme GmbH does not assume any responsibility for the cor-
rectness or accuracy of the information provided in this document. No part of this document may be reproduced, saved to databases or transferred
in any other form without prior written permission by the ISD Software und Systeme GmbH, unless expressly allowed by virtue of the license agree-
ment.

All mentioned products are trademarks or registered trademarks of their respective manufacturers and producers.

News Overview

What's new? 361 / 362



ISD Software und Systeme GmbH
Hauert 4
44227 Dortmund
Germany
Tel. +49 (0)231 9793-0
Fax +49 (0)231 9793-101
info@isdgroup.de

ISD Austria GmbH
Hafenstraße 47-51
4020 Linz
Austria
Tel. +43 (0)732 21 04 22-0
Fax +43 (0)732 21 04 22-29
info@isdgroup.at

ISD Berlin
Paradiesstraße 208a
12526 Berlin
Germany
Tel. +49 (0)30 634178-0
Fax +49 (0)30 634178-10
berlin@isdgroup.de

ISD Benelux b.v.
Het Zuiderkruis 33
5215 MV ‘s-Hertogenbosch
The Netherlands
Tel. +31 (0)73 6153-888
Fax +31 (0)73 6153-899
info@isdgroup.nl

ISD Hamburg
Strawinskystraße 2
25337 Elmshorn
Germany
Tel. +49 (0)4121 740980
Fax +49 (0)4121 4613261
hamburg@isdgroup.de

ISD Benelux b.v.
Grote Voort 293A
8041 BL Zwolle
The Netherlands
Tel. +31 (0)73 6153-888
Fax +31 (0)73 6153-899
info@isdgroup.nl

ISD Hannover
Hamburger Allee 24
30161 Hanover
Germany
Tel. +49 (0)511 616803-40
Fax +49 (0)511 616803-41
hannover@isdgroup.de

ISD Schweiz AG
Rosenweg 2
4500 Solothurn
Switzerland
Tel. +41 (0)32 624 13-40
Fax +41 (0)32 624 13-42
info@isdgroup.ch

ISD Nürnberg
Nordostpark 7
90411 Nuremberg
Germany
Tel. +49 (0)911 95173-0
Fax +49 (0)911 95173-10
nuernberg@isdgroup.de

ISD Group USA Inc.
721 Jetton Street Two Harbour Place
NC 28036 Davidson
USA
Tel. +1 (0)770 349 6321
usa@isdgroup.com

ISD Ulm
Wilhelmstraße 25
89073 Ulm
Germany
Tel. +49 (0)731 96855-0
Fax +49 (0)731 96855-10
ulm@isdgroup.de

www.isdgroup.com

ISD Group USA Inc.
5126 South Royal Atlanta Drive
GA 30084 Tucker
USA
Tel. +1 (0)770 349 6321
usa@isdgroup.com

HiCAD_2502

This document is generated automatically.

© 2020 ISD Software und Systeme GmbH


	Basics
	Service Pack 2 2020 (V 2502)
	The new Renderer - Update to OpenGL Version 4.3
	GUI and operation
	New Autopilot Settings toolbar
	New Visualisation toolbar
	CS display - Fitting CS
	New symbol for part with free edges
	New pocket calculator
	Docking windows - Zooming of contents
	Easier element snap

	North American scale
	Enhanced HiCAD VI / AV module
	Novice configuration - - Settings for sketches
	Track catalogue changes
	Drawing derivation
	Update derived drawings - active sheet
	Change settings - Rearrange views
	Sectional views of sheet metal parts
	Dimensioning of sheet metal parts
	Optimisation of base points
	Tangential transitions when dimensioning contours

	Bills of materials - All visible parts on active sheet
	Insert part, via standard part catalogue
	Design Checker - New check for sheet metal parts
	Nested variables and formulas

	Service Pack 1 2020 (V 2501)
	Restore HiCAD GUI to default
	Itemisation
	Switch to new standard itemisation

	Sheet Metal parts with visible side
	Enhanced ICN
	New ICN window for views
	Marking of sheet developments
	Marking of imported parts in the ICN

	Part filters - Imported parts
	Repeated paste from clipboard
	Derived drawings
	Readability of running dimension chains

	AutoSave - Time interval per model drawing
	Others
	Delete parts

	Coordinate System display

	Major Release 2020 (V 2500)
	Licensing
	Performance
	AutoSave
	ISOCPEUR font
	Enhanced ICN features
	Switch on/off representation of Coordinate Systems
	Point options
	Absolute Z-position (AZ)
	Point from Point Cloud (PW)

	Directories
	Quick Access for directory selection
	Improved designations of directories in HiCAD Settings

	Update catalogues
	Drawing derivation
	Dimensioning rules

	Import of foreign formats
	Insert 3-D foreign formats as parts in current model drawing
	Import model drawings

	HCM models in the Design Checker


	2-D
	Service Pack 2 2020 (V 2502)
	New Visualisation toolbar
	New Autopilot settings toolbar
	North American scale
	New pocket calculator

	Service Pack 1 2020 (V 2501)
	Point from point cloud
	Mark attributes in annotations as Favourites
	Further point options of the Autopilot during sketching
	Standard-compliant information on surface finish
	Insert pixel graphics

	Major Release 2020 (V 2500)
	Import drawings
	Changed dialogue for attribute selection
	2-D text settings


	3-D
	Service Pack 2 2020 (V 2502)
	Model and process parts
	Internal/external thread with runout
	Changed dialogue for Clone parts (parametric) function
	Divide along direction

	Views
	Detail view Cuboid/Sphere - New dialogue window and change options
	New dialogue window for hatching selection
	New dialogue window when creating views
	View properties of assemblies in context menu
	Change representation in multiple views
	Hide parts in multiple views

	Standard parts / Standard processings
	Grip lengths for rivet insertion
	Change standard processings

	Sketches
	Enhanced HiCAD VI / AV module
	Highlighting isolated points
	Parameterized sketches in sectional views
	Size of sketch plane
	3-D sketching tool - Changed arc creation
	Extended point options of the Autopilot


	Service Pack 1 2020 (V 2501)
	Sketches
	Enhanced 3-D sketching tool
	More point options of the Autopilot during sketching
	Others

	Dimensionings and Annotations
	Automatic dimensioning - Base point optimisation
	Standard compliant information on surface finish
	Mark attributes in annotations as favourites

	Views
	Automatic QuickView
	Representation of shaded views with shortening
	Determine the section direction for views containing shortenings

	Part properties
	Alignment of flanges and bend zones
	Non-dimension relevant assemblies and parts

	Standard processings
	Selectable border mode for hole patterns
	Extended Thread dialogue window


	Major Release 2020 (V 2500)
	Create parts
	Dependent parts
	Part CS of assemblies

	Views
	Exploded view with AutoDirection
	New icons for Show/Hide parts
	Visibility of textures in the HiCAD Viewer
	Settings for shaded representation
	Shortened views

	Simulation
	Discontinuation of old assembling simulation

	Dimensioning
	Dimension assignment

	Texts+ Annotations
	Part annotation settings
	Delete part annotations
	Changed attribute selection dialogue
	Revised 3-D text

	Standard parts/processings
	Revised Threads function
	Processing direction
	Standard processings / Slots

	Sketches
	Spirals
	Element selection in Sketch functions
	Preview of processing planes when creating sketches
	New Sketching Tool for 3-D sketches

	Model and process parts
	Hide points/crosshairs
	Wrap function moved

	Automatic calculation of assembly dimensions


	Catalogue Editor
	Service Pack 2 2020 (V 2502)
	Derive new standard parts from existing standard parts
	Track catalogue changes
	Change order of catalogues
	HILTI HSA-Segment anchor
	ALUCOBOND® semi-finished products
	Fasteners USA
	SYSTEA and BWM profiles

	Service Pack 1 2020 (V 2501)
	Thread-cutting screws
	HILTI anchors
	HILTI plastic dowels
	WELKO fasteners
	Fabco and HFT fasteners

	Major Release 2020 (V 2500)
	HILTI anchors
	BRUCHA folded profiles
	JIS Beams - Standard G 3192
	Additional direction arrows
	Multi-language entries in BZ column


	Point clouds
	Service Pack 2 2020 (V 2502)
	Create / edit clipping boxes
	Part attributes of point clouds
	Align point clouds

	Service Pack 1 2020 (V 2501)
	Update point cloud references
	Improved updating of point clouds
	Point from point cloud
	Point Cloud Converter
	Improved clipping
	Fitting direction determination for import
	Plane from point cloud


	Feature Technology
	Service Pack 2 2020 (V 2501)
	Updating dependent parts in locked assemblies upon loading
	Nested variables and formulas
	Delete feature log of part with sub-parts
	Redesigned display of feature log

	Service Pack 1 2020 (V 2501)
	Improvements for dependent assemblies
	Weld seam tags for automatically derived drawings without feature log

	Major Release 2020 (V 2500)
	Further improved Use of variables dialogue window
	Access to variables of other parts
	Display of sketches with external references
	Merging of Dependent part and Dependent assembly function
	New API functions
	Weld seam tags without Feature log


	Parametrics (HCM)
	Service Pack 2 2020 (V 2502)
	More meaningful error messages for inconsistent HCM models
	New Visualisation toolbar
	Visualization of the sketch plane
	Coordinate system elements in the ICN
	Stable area distance
	Show/hide parts in the ICN

	Service Pack 1 2020 (V 2501)
	Part HCM
	Improved placing of HCM dimensions
	Creation of Equal distance and Equal angle constraints via dialogue window
	Changing constraints
	Part HCM: Display and change of orientation of a constraint via dialogue window
	Error messages for problematic constraints

	HCM entries in the ICN
	ICN: Expanded and collapsed entries are kept
	References to deleted parts
	Change order of constraints in ICN
	Tooltips for error and warning icons

	3-D sketching tool: Automatically generated HCM constraints
	Display of points in sketches and 3-D sketches
	Sketch HCM
	Point option M
	Error messages for problematic constraints

	Lock rotation for Concentricity constraints in Assembly HCM
	Influence of positive/negative sign on dimensional constraints in Assembly HCM

	Major Release 2020 (V 2500)
	Automatic assignment of HCM constraints in the new 3-D sketching tool
	Error messages in the Part HCM
	Revised assigning of positional and dimensional constraints for assemblies
	HCM tests in the Design Checker
	Performance
	Further improved HCM constraint display in the ICN
	Equal distance constraint applied to surfaces
	Example:

	Show constraints with errors in structure
	Delete and deactivate the HCM constraints of a part
	Tooltips for HCM constraints


	Configuration Management
	Service Pack 2 2020 (V 2502)
	Track catalogue changes

	Service Pack 1 2020 (V 2501)
	Switch to new standard itemisation

	Major Release 2020 (V 2500)
	ABWPOL.DAT settings moved to Configuration Editor
	Assigning of views for model drawings without Sheet and Model area


	Bill of Materials / Report Manager
	Service Pack 2 2020 (V. 2502)
	BOMs - All visible parts on active sheet

	Service Pack 1 2020 (V 2501)
	Steel Engineering BOMs - handling of structure assemblies

	Major Release 2020 (V 2500)
	Steel Engineering BOMs - Selectable length attribute for bar optimization
	Steel Engineering BOMs - New parameter for Sheet Metal parts with image


	HiCAD GUI Creator
	Major Release 2020 (V 2500)
	Default values for Toolbox objects
	CatalogEntry


	Interfaces
	Service Pack 2 2020 (V 2502)
	Favourites for 3-D import
	3-D export by views
	2-D import
	AutoCAD DXF/DWG
	2-D import via the HiCAD Start Centre

	IFC import
	IFC export - Part filter for geometry merging

	Service Pack 1 2020 (V 2501)
	Marking of imported 3-D parts in the ICN
	Save as DXF/DWG
	BOM-relevance for IFC import
	Changed menu for 2-D import

	Major Release 2020 (V 2500)
	Update to CADfix 12 SP1
	Import files via interfaces
	Insert 3-D foreign formats as parts in current drawing
	IFC import - Filter option and multiple selection with CTRL or SHIFT key
	3DPDF - Enhancements
	SDK Update to 2.18.1
	Taking into account of free edges and sketches



	Sheet Metal
	Service Pack 2 2020 (V 2502)
	New bend zone, with shortening
	Sheet metal development with die and punch
	Changed dialogue for functions with sketch selection
	Design Checker - New check for Sheet Metal parts
	Steel Engineering plates can be coated like Sheet Metal parts

	Service Pack 1 2020 (V 2501)
	Sheet development
	Add and subtract in context menu for sheet development
	Mark sheet developments with suppressed updates in ICN
	Automatic dimensioning - Optimised base points
	Development considers definition of outer sheet side
	Lengthening of milling edges in developments

	New visible side of Sheet Metal part
	Sheet Metal parts with visible side

	Coat Sheet Metal parts with multiple selection
	Sheet from solid
	Favourites in dialogue windows for Design Variants
	Optional standard part insertion
	No view-defining coordinate system on flanges and bend zones
	Hole patterns on sheet developments

	Major Release 2020 (V 2500)
	Sheet Metal cassette with milling edge zone
	Sheet developments
	Process sheet developments
	Developments in the ICN
	Show milled area
	Moveable bend line text

	Export of sheet developments
	Optional taking into account of processings for ToPs GEO export
	Determine polyline orientation for DXF export of Sheet Metal parts

	Sheet from solid
	ALUCOBOND®SZ-20 tray panels: Lateral connection with additional flange
	Favourites in Design Variant dialogue windows
	Improved info bar texts
	Quick Access for directory selection
	ABWPOL.DAT settings moved to Configuration Editor
	Processing direction
	Discontinuation of old base sheet macro


	Steel Engineering
	Service Pack 2 2020 (V 2502)
	Railings
	- Posts from double profiles

	Connections
	Cross-bracing between two perpendicular beam (2602)
	Cross-bracing Besista with cross anchor (2603)
	Stabilizing pipe connection (2702)

	Macro-based connections
	Steel Engineering plates - Visible side and coating
	Sketch selection in the Laminated glass dialogue window
	Divide along direction
	More convenient creation of sketch-based series beams and profiles

	Service Pack 1 2020 (V 2501)
	Connections
	Favourites management
	Strap joint (2310)
	Cross-bracing (2603)

	BOM templates for Steel Engineering
	Others
	Steel Engineering BOMs - handling of structure assemblies
	Changed default settings for Notches


	Major Release 2020 (V 2500)
	Indication of beam orientation
	Connections
	Strap joint (2310)
	Cross-bracing (2602)
	Galvanisation
	Weld seam insertion
	Usage of assemblies
	DAST connections

	Stairs and Railings
	Railing Configurator
	Variant Editor for Railings

	Semi-finished products as sub-items for series beams


	Steel Engineering - Management + BIM
	Service Pack 2 2020 (V 2502)
	Total quantity of a part in an assembly (COMPONENT_REFASSEMBLY)
	Output construction section lists in drawing
	Management of template drawings
	Rework of template/profiles installation drawings via script

	Service Pack 1 2020 (V 2501)
	Type of part referencing
	Script for rework of model drawings
	Drawing number generation
	Output associated assemblies
	AutoCreate General Production Documents
	User defined objects (UTO)
	Customer-specific and usage-dependent title blocks

	Major Release 2020 (V 2500)
	Withdraw releases
	Delete unused Sheet areas
	Automatic export of CAM and drawing data to the Windows file system
	Working across projects


	Metal Engineering
	Service Pack 2 2020 (V 2502)
	Sketch selection in the Laminated glass dialogue window
	Revised Foil function

	Service Pack 1 2020 (V 2501)
	Connections - Favourites management


	Element Installation
	Service Pack 2 2020 (V 2502)
	Open template drawing
	Changed dialogue for sketch selection
	ALUCOBOND® SZ 20 tray panels - Window connection
	Design Variant - Flange for SZ20
	Transfer parameterisation

	Service Pack 1 2020 (V 2501)
	Template drawings
	ALUCOBOND® SZ-20 panels and sub-structures
	Window connection with base profile and additional sheet
	Length of S- and Z-profiles
	Attics - Stiffener outside
	Attic connections with and without lug
	Window connection without side flanges
	Configurable rivet distances on attic stiffeners

	ALUCOBOND® riveted - Individual edge distances
	ALUCOBOND® suspended - Window connection without side flanges
	Optional insertion of standard parts
	Leg position for GIP L-profiles
	HILTI profiles for ALUCOBOND facades
	CS 20 Window end profile

	Major Release 2020 (V 2500)
	Element installation - Create new
	Working with selection groups
	ALUCOBOND® panels - General
	Bend zone end suitable for milling
	ALUCOBOND® panels - Processing direction and symbol
	Attic connection without last flange
	All bend edges as milling edges
	Mitre cut with milling edge

	ALUCOBOND® panels, suspended
	Window connection without flanges
	Sub-structure - Rivet distances on attic reinforcing bracket

	ALUCOBOND® SZ-20 tray panels
	Installation on triangular areas
	Optional insertion of bolts for the sub-structure
	Lateral connection with additional flange

	Save variants for Element installation /Sub-structure
	User-specific dialogue windows
	Reset wall brackets and sub-structures


	Profile Installation
	Service Pack 2 2020 (V 2502)
	New view option: Contour, combined
	Selecting and creating sketches in the Profile installation dialogue
	Roof inclinations: Definition via inclination angle

	Service Pack 1 2020 (V 2501)
	Creation of inclined roof sections
	Usage for edge profiles
	Attributes for the installed width of the room closing profiles

	Major Release 2020 (V 2500)
	Edge profiles from multiple sketches
	Freely selectable fitting point for surface profiles
	Deactivate preview


	Plant Engineering
	Service Pack 2 2020 (V 2502)
	Classify pipeline article
	Move pipe parts
	Combined BOM / length list
	Calculate weight of pipeline
	Dynamic route change
	Create straight sections
	Select target point
	Select fixed point

	Minimum pressure of pipe parts

	Service Pack 1 2020 (V 2501)
	Part Tools
	Modified Ribbons and Pull-down menus
	Select part chain
	Copy parts

	Plant Engineering Settings
	Part search

	Isometry and Pipe plan
	Multiple selection when starting the isometry

	Parts
	Insert loose flange as regular flange
	Insert placeholder
	Directly insert classified .KRA files

	Pipeline Tools
	Calculate transition: Improved dialogue


	Major Release 2020 (V 2500)
	Restructured Ribbon and context menus
	Pipelines
	Activate pipeline
	Change pipeline route

	Settings
	Set Local CS

	Guidelines
	Pipeline selection for automatic placing of parts
	Mitre cuts during automatic placing of parts

	Parts - New automatisms for parts
	Calculate transitions
	Edit arcs for bent pipes
	Delete counter-flanges



	P+ID
	Service Pack 1 2020 (V 2501)
	Take over P+ID symbol code change to 3-D layout plan

	Major Release 2020 (V 2500)
	Indicated connecting direction when creating own symbols
	Support of nominal diameters in millimetres and inches


	Viewer
	Major Relase 2020 (V 2500)
	Visibility of textures


	Notes on HELiOS Updates
	Major Release 2020 (V 2500)
	Important Notes on Updates for Administrators


	HELiOS Desktop
	Service Pack 2 2020 (V 2502)
	Enhanced Mask Editor
	Intelligent Delete behaviour of objects
	Settings for the Workspace
	Marking empty archive documents when loading, viewing and exporting

	Major Release 2020 (V 2500)
	New mask format and central mask configuration
	New Mask Editor
	Start search with F3
	ReleaseNext: Distinguishing between all objects and Admin objects


	HELiOS in HiCAD
	Major Release 2020 (V 2500)
	Open, with options: Reduced loading


	HELiOS Spooler
	Service Pack 2 2020 (V 2502)
	Print Client: Bundling of jobs by document number
	HELiOS Options: Include model area
	AutoCAD plot area definition
	Installation

	Service Pack 1 2020 (V 2501)
	Extension of the installation

	Major Release 2020 (V 2500)
	Notes on Update installations/ New postprocessing
	Change option for MultiCAD settings


	HELiOS MS Office Interface
	Service Pack 2 2020 (V 2502)
	Add attachments to E-mails
	HELiOS options with automatic login

	Service Pack 1 2020 (V 2501)
	Transfer of forwarded E-mails as separate documents



